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Copyright 1992, 1993, 1994 SunRize Industries. All rights reserved.

Reproduction or publication of this document in any manner, without the express
written consent of the publisher, is prohibited. No lability 15 assumed with respect to
the use of the information herein.

The Studio 16 software is copyrighted 1991-1994 SunRize Industries. Studio 16 may
be copied for archival purposes only.

Studio 16 15 a trademark of SunRize Industries.

Your AD516 or ADI012 hardware 15 warranted to the onginal purchaser for a period
of one (1) year from the original purchase date--under normal use and service--
against defective materials or workmanship. ANY IMPLIED WARRANTIES ARE
ALSO LIMITED TO THE ONE YEAR PERIOD FROM THE ORIGINAL
PURCHASE DATE. This warranty is void if the AD516 or AD1012 has been
damaged by accident or unreasonable use, neglect, improper service or other causes
not arising out of defects in matenal or workmanship.

SUNRIZE INDUSTRIES SHALL NOT BE LIABLE FOR LOSS OF USE OF
STUDIO 16/ ADSI6 OR STUDIO 16/ ADI0I2Z OR OTHER INCIDENTAL OR
CONSEQUENTIAL COSTS, EXPENSE OR DAMAGES INCURRED BY THE
PURCHASER.

During the above one-year period, defective parts will be repaired, adjusted andfor
replaced (at Manufacturer's option) without charge to the purchaser when the AD516
or AD1012 is returned, prepaid and insured, with proof-of-purchase date, to SunRize
Industries customer service listed below. UNITS RETURNED WITHOUT PROOF-
OF-PURCHASE DATE OR REPAIR FEE WILL NOT BE REPAIRED,

Before returning your AD516 or AD1012 for service, please review the service
instructions in this manual.

SunRize Industries

2959 Winchester Blvd., 2nd Floor
Campbell, CA 95008 USA

Tel: (408) 374-4962

Fax: (408) 374-4963
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FCC Regulations

This equipment has been fested and found to comply with the limits for a Class B digital device,
pursuant (o part 15 of the FCC Rules, These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses and can
radiate radio frequency energy and, if not installed and vsed in accordance with the instructions, may
cause harmful interference to radio communications, However, there is no guarantee that interference
will not occur in a particular installation. 1f this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user 15

encouraged to try to cormect the interference by one or more of the following measures:

& Reorient or relocate the receiving antenma,

®  Increase the separation between the equipment and receiver

u  Connect the equipment into an outlet on a circuit different from that to which the receiver is
connecied

u  Consult the dealer or an experienced radio TV technician for help,

Note: Use of shielded aoudio cables is required to comply with the class B limits in Part 15 of FCC

Rules
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Introduction

Introduction

Studio 16 software, when combined with either the AD316 or AD1012 audio card,
becomes an advanced hard disk recording system. Both the AD516 and the AD1012
audio cards plug into your Amiga 2000/3000 and add audio in, audio out, and
SMPTE in to your computer. They both include a sound coprocessor (a DSP) as
well as high fidelity recording and playback circuitry. The AD516 and AD1012 will
record direct to disk and play back multiple channels direct from disk.

The AD516 is a 16 bit stereo card that is suitable for professional video and CD
mastering. Its advanced circuitry enables it to playback up to eight channels
simultaneously. And the internal SMPTE time code reader allows it to create
extensive Cue Lists of samples to trigger to a video tape. The more economical
AD1012 is a 12 bit mono board that includes the same SMPTE support as the 16 bit
card and is ideal for video applications. See Appendix B for complete specifications
for the AD516 and AD1012,

Included with both the AD516 and AD1012 is the Studio 16 recording and editing
software. When combined with an audio card, Studio 16 allows you to record very
long sounds directly to your hard disk. Studio 16 allows you to edit and mix sounds.

About This Manual

This manual provides information for installing and using Studio 16. This manual is
divided into nine Chapters and a detailed Reference Section. Appendices and an
Index are also included.

Chapter 1 ..oociiniviinrenans Introduction to Digital Audio describes the digital
sampling process and explains the difference between 8,
12, and 16 bit audio.

[ 04111, 1 AR Installation explains how 1o install an AD516 and
ADI012 in a computer and install Studio 16 on a hard
drive.

Chapter 3 .....cooeesmsmarminrions Getting Started includes a brief introduction to sampling,
playing, editing, and an overview of common screen
elements.

Chapter 4 ....ciiinisiniiin Hard Disk Drives provides information on required hard
disk specifications, and optional storage devices.
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Ehapter 5 :qiiniimii

Chapter 6

Chapter 7

Chapter B ..o inimian
Appendix A v
Appendix B

Appendix C

Index

Wi

SMPTE includes an introduction to the SMPTE time
code standard and suggestions for SMPTE applications.

Cue List Tutorial provides siep by step instructions to set
up and trigger a collection of samples with SMPTE time
code.

Trouble Shooting lists common problems that may be
encountered while working with Studio 16 and their
solutions.

Module Reference Provides detailed explanation and
instructions for all Studio 16 Modules.

Technical Support instructs users on obtaining technical
support 1f it 1s required.

Hardware Specifications details the AD516 and
ADI1012,

Third Party Sources includes a list of suppliers for

SMPTE converters, Sound Effect Libraries and similar
products that enhance the Studio 16 system.
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Chapter 1

Introduction to Digital Audio

In recent years, digital audio has become increasingly popular. The most common
uses of digital audio are currently Compact Discs and Digital Audio Tapes. DATS are
replacing analog tapes for professional audio use, just like CDs have replaced LPs for
personal use.

Digital vs. Analog

Both CDs and DATS record numbers instead of analog signals, For example, a
standard cassette tape records sound by magnetizing a tape. When the sound being
recorded gets louder, the tape recorder writes a stronger magnetic field to the tape.
When the sound gets softer, the tape player writes a softer magnetic field onto the
tape. A DAT recorder, on the other hand, records numbers. For loud sounds, it writes
a large number; for soft sounds, it writes a smaller number.

There are several reasons why numbers are better to record than analog signals (such
as the magnetic signal on cassette tapes), For starters, it is much simpler to edit
digital sound. Using a computer program like Studio 16, it is easy to move parts of
sound around or insert one sound into the middle of another. In the analog world this
is accomplished by cutting and splicing tape. Another advantage, and the reason the
music industry is concerned about DAT, is that when you copy digital audio you
always get a perfect copy. Remember that digital sound is just numbers and is
manipulated like any other data in your computer. When you copy a disk with your
computer, you get an exact copy of the data. On the other hand, every time you copy
a magnetic tape, you add a little distortion or "tape hiss".

Converting Analog to Digital

So how do you turn natural analog sound into numbers? You need a sound digitizer
like the AD516 or AD1012, The AD516 and AD1012 measure and record the
amplitude of a sound. Amplitude 15 the loudness of a sound signal at an exact
moment in time. The process of measuring and recording is referred to as "taking a
sample”. To digitize a sound, the AD516 (or AD1012) takes a series of samples. It
takes a sample, allows a certain amount of time pass, takes another sample, allows the
same amount of time pass, takes a sample, etc. As the samples are taken, loud sounds
are recorded as larger numbers and quiet sounds are represented by smaller numbers.
The amount of time that passes between samples is referred to as the period. Assume
the period is 1/44,100 of a second. By inverting the period you can calculate the
resulting sampling rate. The inverse of 1/44,100 is 44_100. The sampling rate is
44,100Hz.
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AMPLITUDE

| 4 =+ Sampling Period

Figure 1-1. Digital Audio Diagram

There is a direct relationship between sampling rate and the maximum frequency you
can record. This relationship, called the "Nyquist theorem", states that the maximum
frequency you can record is equal to half the sampling rate. So, if you sample at
10,000Hz, all frequencies up to 5,000Hz are recorded accurately. Frequencies over
5,000Hz will introduce distortion into the sound. This distortion is called "aliasing".

Compact Discs always play back at 44, 100Hz. This gives CDs a maximum frequency
range of 22,000Hz which is outside or on the limits of most people's hearing ability.

The second parameter that determines digital sound quality is the maximum sample
value. If we let silence be recorded as zero, what value does the loudest possible
sound have? This value is the maximum sample value. Sound will oscillate above and
below zero by this amount. Using the Amiga’s internal 8 bit sound, the maximum
sample value is 127, Thus all sounds are recorded as numbers between 127 and -127,
with zero being silence. For comparison, the AD1012 has a range of +2,048 to -
2,048, Obviously this gives the AD1012 much better sound quality than the Amiga's
internal sound. Note that the sixteen bit AD516 has an even larger range of +32,767
o -32,767.

The final thing to notice about digital sound is that it uses quite a bit of memory.
Since each AD516 and AD1012 sample takes two bytes, a sampling rate of 44,100
samples per second means that every second of sound is going to take exactly 88,200
bytes. This works out to 5.05 megabytes per minute or 12 seconds per megabyte.

Differences Between 8,12 and 16 Bit Audio

Digital sound systems generally fall into three different categories: 8, 12, and 16 bit.
A small discussion of each class follows. A common reference is given (i.e., "8 bit
sounds like an AM radio”) as well as the theoretical Signal-to-Noise Ratio (SNR).
Keep in mind that the SNR given is the theoretical maximum for a pure sine wave.
Practical systems never match this number. However, one aspect of the quality of a
real world system is how closely its SNR comes to the theoretical maximum,
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B Bit

The Amiga’s internal sound format and SunRize's Perfect Sound' are 8 bit, A
common use for 8 bit digital audio is long distance phone calls, Phone calls are often
digitized with 8 bits of resolution at the switching station for broadcast via satellite or
fiber optic cable. Eight bit audio has a theoretical maximum SNR of -48dBs and its
sound quality i1s often compared to AM Radio.

12 Bit

The AD1012 card is 12 bit. Twelve bit audio is also used in many popular music
synthesizers. It has a theoretical maximum SNR of -72dBs. Its quality is comparable
to a high quality reel-to-reel tape deck or FM radio.

16 Bit

The AD516 card from SunRize is 16 bit. Compact Disk players and DATS are also
16 bits. Sixteen bit digital audio has a theoretical maximum SNR of -96dBs. Its
quality is equivalent to a CD player.

Decibels

In audio systems the common measurement of volume is the Decibel (dB). Studio 16
volumes are also specified in dBs. Decibels are a logarithmic scale used to more
accurately represent how the ear hears volume changes. Zero dB means no gain.
Altenuation are negative, and amplifications are positive.

For example:

-12dB s equivalent to 25% volume
-6dB s equivalent to 50% volume
0dB is equivalent to 100% volume

+6dB  is equivalent to 200% volume

These ratios are determined by the following equation:
dB = -20log (gain)
example: -6 = -20log(0.5)



chapter 1 Introduction to Digital Audio

4 Studio 16



Chapter 2

Installation

Hardware Installation

The following installation instructions are the same for the AD516 and the AD1012,
Both audio cards plug into a free Zorro slot in an Amiga 2000, 3000 or 4000,
Installing the card is relatively easy. However, if you prefer, your local Amiga dealer
can install it for you,

Install the Card

1. Turn off your computer,
2. Unplug the mouse, keyboard, monitor and power cables.
3. Remove the screws securing the case. On the A4000 there are 2 screws in the

back, top-left and top-right corners. For the A2000 and A3000, look for 2 screws
on each side and | in the back, top-center,

4. Carefully slide the case off the computer. For more information on removing
your Amiga's case, see your Amiga's Manual.

5. Identify the Zorro slots in your computer by referring to your Amiga'’s Manual.
Zorro slots are also referred to as "Amiga 100 pin expansion slots”. (Note that
any slot in the computer that the ADS16 or AD1012 will fit into is a Zorro slot.)

6. Choose a Zorro slot to receive the card and remove its cover plate (back
bracket).

7. Ground yourself by touching your Amiga's metal power supply case. This will
remove any static charge built up on vour body.

8. Remove the AD516 or AD1012 card from its anti-static bag and plug it into the
free Zorro slot.

NOTE When the card is installed properly, only a small amount of the gold connector will
show. If the slot has never been used, it may take a lot of effort to push the card in. A
gentle rocking motion is usually best.

9. Screw the card's brackel into the Amiga with the screw you removed from the
cover plate.

10, Replace the case and secure it with the screws removed earlier.

User's Manual 5
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Setting Jumpers

AD516 has one jumper. It is indicated by JP1 on the pe board. The AD1012 has two
Jumpers - indicated by JP1 and JP2. All jumpers are set at the factory and shouldn't
need changing.

AD516 JP] should be set 1o 6. It selects interrupt 2 or 8,
ADIDIZ IP1 should be set to 6. It selects interrupt 2 or 6.
JP2 should be in place for normal operation,

Connecting Audio and SMPTE

All five jacks are "consumer line level” unbalanced connections. They should be
connected to an appropriate source using standard RCA patch cables. For example,
connect the left and right "Line Out" on your CD player to the "L - IN" and "R- [N"
on the AD516.

Many professional Video Tape Recorders (VTRs) use "balanced” type connections.
These will typically have the three pin XLR connectors. If your equipment uses these
connectors, you will need to use XLR-t0o-RCA adapters. These are available at
electronics stores.

The notations on the AD516% and AD1012's brackets follow:

Left In —-I~®
Right In —-@)

Laft Out _'“@j
i
Right Cut ""@
L=
=

AD516 AD1012  lmmf

Figure 2-1, Bracket Labels
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AD516

The AD516 card has five RCA jacks: SMPTE (LTC) In, Left and Right Audio In,
and Left and Right Audio Out,

AD1012

The AD1012, a monophonic card, has the same SMPTE LTC input as the AD516. lis
Audio In and Out are standard unbalanced RCA connectors.,

SMPTE Sources

Although Studio 16 doesn't require an external SMPTE source to run, it is enhanced
by its addition. If your deck has a dedicated LTC SMPTE track, simply connect it to
the AD516's or AD1012's SMPTE In. If your VTR does not have a dedicated
SMPTE track, you should record LTC time code to an unused audio track on video
tape. This process is referred to as "striping a tape”. This will allow you to use one of
the Audio output jacks on your deck as a source for SMPTE time code. For more
information on tme code and striping tapes, see Chapter 5 -SMPTE.

If your deck uses VITC SMPTE, the SMPTE out on your deck may require a VITC-
to-LTC translator. The AD516 and AD1012 do not read "vertical interval time code”

(VITC) directly. See Appendix C - Third Party Sources for a supplier of VITC-to-
LTC translators. For information on ime code see Chapter 5 - SMPTE.

The AD516 and AD1012 SMPTE reader is designed to handle normal speed
variations due to tape motor variance. It 1s not designed to read time code in fast
forward modes.

Software Installation
Install Studio 16 On a Hard Drive

. Turn on your computer and wait for WorkBench to finish loading.
2. Insert the Studio 16 Disk 1 into a floppy drive

3. Double click the Studiol6_1 disk icon.

4

Double click the Read_Me icon. The Read_Me file contains updated
information that is not included in this manual. It may contain information
related to installation. You can close the Read_Me file after reading it. The
Installation Utility will copy it onto your hard disk for future reference.
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-y |

o
Jus e
o

i)

-1y

0| Studiol6 1 90% full, 63K free, 754K in use |PI|iy|

Figure 2-2. Studio 16 Disk 1

5. Double click the Studiol6. Install icon.

6. The installation utility will run.

NOTE The installation utility is equipped with on line help for vour convenience.

7. Before the installation begins, it requests your level of Amiga knowledge. Select
your level of knowledge, then click Proceed.

Novice Users are only required to select a directory on which to install Studio
16, all other actions are automatic. Intermediate Users have the added option of
selecting that a log file be sent to a printer, or file, Experienced Users must
indicate the preceding as well as having to confirm an assign statement.

8. A notice will appear with the following statement "I have found 1 ADS186, is this
correct?” Click Yes to proceed. However, if the system does not locate your
AD516 or AD1012, exit the install utility by clicking No. Then, turn off your
computer and re-seat the audio card in its slot or in a different slot, before trying
the installation utility again. Refer to the preceding Hardware Installation section
for more information on installing the hardware.

8 Studio 16
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Studiolf, Install (0% done) =1

Welcoms to the Studiclé installation utility., Pleass |

indicate how the instsllation should proceed (based
upon your knowledge of the amiga).

Set Installation Mode

= Nowice User — All Actions Autcmatic
—) Intermediate User — Limited Manual Control
—) Expert User - Must Confirm all actions

Proceed With Install Abort Install
Abouti. .. | HelE i
Figure 2-3. Studio 16's Installation Litility

9. Select the hard drive or partition to put the Studio 16 program on. Your avalable
Amiga DOS devices will appear in the upper window. Click one of the names to
select the device, then click Proceed. (You do not have to use the same path that
you intend to use for your audio files.) For more information on the file requester
click the Help... button.

10. The installation utility will create a directory called 'Studio [6_3' and copy the
appropriate files into it. In addition, your s: and libs: directories will be altered.
And a log file will be created unless you have indicated otherwise. The log file
contains all the actions that the installation wtility completed during installation.

11. Insert the Studio 16 Disk 2 when indicated,

12. When the installation is complete a Installation Complete notice will appear,
click Proceed to close the installation window,

13. Now is a good ume too fill out and mail your registration card, The card must be
returned to SunRize in order to receive technical support, and software update
notices,

Load Studio 16

Studio 16 will run under WorkBench 2.0 and greater. You can load Studio 16 from
WorkBench or the Shell.

From WorkBench  Double click the Studiol 6_3 directory icon.
Double click the Studiol6 program icon.

From the Shell Change the current directory to Studiol6_3.
Type Studiol6.
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Running Studio 16 Before Partitioning Your Hard Drive
Because Studio 16 is very hard disk read/write intensive, it is very important to create
a partition on your hard drive dedicated to your working audio files. If you've just
received your AD516 or AD1012, and would like to try it out before you backup and
partition your hard drive, you can safely run Studio 16 by recording into memory.
When Studio 16 was first installed it set your record path to RAM:. This means that
all recordings will be made directly to your memory - not to your hard drive, Check
the Sample List for your record path. It is indicated by a & next to a path name.
Make sure RAM: is the selected record path if you have not partitioned your hard
drive,

Partitioning Your Hard Disk

Studio 16 can use any Amiga DOS device to record and plavback from, (i.e. DFO:,
DHO:, RAM:, etc.). And, unless you are recording to RAM:, Studio 16 is very hard
disk read/write intensive. Therefore, it is very strongly recommended that you create
a separate partition on your hard disk for your audio files you are recording, editing,
and playing. If your Amiga crashes while a write is in progress, you may have to
reformat your hard disk. If you have partitioned your hard disk and a crash occurs,
you will only lose your "working” audio partition. You will not lose anything
valuable, i.e. programs and archived samples.

When naming your Audio partition, do not name it Studio 16 or Studiol16_3. This will
confuse the system since there is a Studio 16 assign. Tutorials in this manual refer to
the partition as if it were named "Audio”. You may want to name your partition
"Audio” as well.

NOTE SunRize is not responsible for lost data. Partition vour hard drive!

Reselection

If you are working with a single hard disk, turn "Reselection” OFF. If you are using
more than one Hard Disk, you should have "Reselection” ON. Your version of
WorkBench, the controller your using will determine how to turn Reselection OFF.,

Commodore Controller - WBE 2.0

. Insert the WorkBench 2.0 Install disk into your floppy drive.
2. Select the Tools drawer

3. Select Turn Reselection OFF if you have just one hard disk.
Commodore Controller - WB 3.0

I, Insert the WorkBench 3.0 Install disk into your floppy drive.
2. Select the Tools drawer.

Select English,

Select Turn Reselection OFF if you have just one hard disk.

10 Studio 16
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Third Party Hard Disk Controller

1. Refer to vour hard disk controller manual for instructions.

Set Your Record Path

A Record Path is the assigned location for your new audio recordings. The default
path is RAM:. Once vou have partitioned your hard disk, you will want to change the
record path to a directory on the hard disk. Your record path should be located on
your Audio partition,

The following changes the record path from RAM: to a directory on the hard disk.

1. Select Sample List from the Applications Menu (*0).

ed

The Sample List appears with RAM selected as the record path, note the
selection box next to the path name.

3. To add another path to Sample List, select Add New Path from the Sample List
menu. Select yvour new path from the requester and click OK.

4. Sample List will update and display the two directories. You can continue
adding paths {up to eight) to suit your setup. Remove the RAM: path by
selecting Remove Path from the Sample List menu and selecting it in the
requester,

L

Once you have all your paths listed, choose one for the record path by clicking
the active box next to its name. You can change this selection at any time.

6. To save the Sample List setup, select SaveSetup  from Project menu. This will
also save the positions of the windows on the screen. If you don't want Sample
List showing every time you run Studio 16, close Sample List before you
SaveSetup.

il Sanple Lizt |
I~ AUDIO: _IRAMH:

arsStart TrackZ_ L
Crunch TrackZ2_R

SourceSanple
VoiceDver ﬁ ﬁL

Figure 2-4. Sample List
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Studio 16 File Structure

Studio 16 requires the following directories of files to operate. They are
automatically copied by the installation utility into a Studiol6 directory,

Apps
Drivers
Utilities
ProjectMenu
Fonts

Libs

Studio 16 should have an assign called "Studio16_3:" that points to the created
Studio 16 directory. The installation utility will add this assignment to your User-
Startup. If you move the Studio 16 directory later, be sure to update the assignment in
your User-Startup file.

12 Studio 16
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Chapter 3

Getting Started

This chapter is a brief tutorial on using basic Studio 16 options. Included is a
description of common screen elements and short tutorials on recording, editing and
playing a sample. Detailed information on all modules is provided in Chapter 8, the
Reference Section of this manual.

It is recommend that vou open and read the Read_Me file in the Studio 16 directory
before loading Studio 16. This file includes updated information not found in this
manual.

Load Studio 16

.  Double click the Studiolé icon in the Studiol6 drawer. For more detailed
instructions see Chapter 2 - Installation.

2. An About window appears listing the amount of disk space available in your
default record path. It also displays the amount of chip and fast RAM installed in
your system. Click OK to close it

Menus and Keyboard Shortcuts

Studio 16 Modules can be launched from the Applications Menu or from the
keyboard. To select a moedule from a menu, click the right mouse button and hold it
down. Move the mouse pointer over a menu option and release the mouse button to
select it

Keyboard shortcuts are identified in the menu to the right of the option name.
Module shortcuts use the control (Curl) key, indicated by( * ). All other keyboard
shortcuts will use the Right Amiga Key( A- ). To use a keyboard shortcut, hold down
either the Control key or the Right Amiga key, and type the letter indicated.

The key to using software efficiently 15 to memorize the keyboard shortcuts for your
most common applications.

Once a Module is launched it may add more menus to the menu bar. For a module's
menu options to be available and to use its keyboard shorteuts, you must first make
the window active by clicking on it. The title bar of a window will be highlighted
when it is active.

NOTE

OK requesters can generally be accepted or rejected with the standard keyboard
shortcuts. For OK, Left A-V. For Cancel, Left A-B.

13
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Common Screen Elements

Most screen elements are common to the Amiga Intuition standard: however, there
are a few gadgets that you may not be familiar with.

Drop List

Indicated by a ¥ , allows you access to available choices for an option. Click the J
button for a list to appear below the current selection. Use the familiar scroll bar and
arrow buttons to locate a new selection. Click on an item to select it.

Active Boxes

Many options can be turned on by activating them. Click the active box next to the
option’s label. Deactivate it by clicking the button a second time or by selecting
another option,

Window Zoom

The Window Zoom gadget provides a quick way to switch between two different
window size/position settings It is a toggle that ,when selected, makes a large
window small and a small window large.

Depth

Located in the top right corner of all windows, the Depth button allows you to bring a
window to the front or move it to the back. Click the button once to move it to the
front. If the window is already in front, the single click will move it to the back or
underneath all other windows. Also selecting a module from the Applications Menu
will bring it to the front, If ClicktoFraont is selected in Preferences, this button will not
appear, Windows are brought to the front by clicking anywhere on them when the
ClicktoFront option is selected,

Resize

In the lower right side of most windows is a small triangle. Click and drag this
triangle to resize a window. As windows are reduced in size, text in the window and
title bar will truncate.

Record and Play

Once you have installed and loaded Studio 16 you are almost ready to record.

Before you can record, you need to connect your audio source. Any audio source
with a "Line Dut" may be used, preferably a CD player. Use a short RCA patch cable
to hook up the CD's Line Out to the AD516's or the AD1012's Audio IN jack(s). If
your audio input is from a microphone, you will need an external device, like a
mixer, to convert the mic output into an RCA Line Out. The card's Audio OUT
jack(s) can be hooked up to a receiver or an amplifier system's CD/AUX Line In, If
you have a LTC SMPTE time code source, plug it into the top jack: SMPTE IN.
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Now that yvou are ready to record, there are two methods of recording. One uses the
Recorder module and the other records from the Cue List. For this brief
demonstration of recording, the Recorder module 15 used.

Record with Recorder

1. Load Recorder, Sample List and Meters from the Applications Menu. Close any
other modules that are open.

J

Check your record path in Sample List. If you have not partitioned your hard
drive, it should be set to RAM:, (The record path is identified by a x.)

3. Turn on your audio source.

=

Click Monitor in the Recorder window. You should hear the audio playing
through your output device.

5. ADS16 ONLY - To make a stereo recording, select the L and R channel from
the Recorder Menu so that both channels have a check next to them. To make
selections from the Recorder Menu, make sure the Recorder window is
highlighted. You should have audio connected to bath of the ADS16' audio
inputs when recording in stereo.

6. Activate Meters by clicking on the window. From the Meter's Channels Menu,
select Input, Output and Play 1. These are easily selecting by holding down the
right mouse button, and clicking the channels with the left mouse button. You
will now see activity on the input and output meters,

sl | Meter Hindouw
0315 fuput Sl s #tay |

Mame |

Figure 3-1. Meters and Recorder

7. Set the praper Gain in the Recorder setting by watching the meters for clipping.
Clipping results from the gain being set too high. It is indicated on the meters by
the VU meter going into the (+) section, the LED meter flashing on the far right
side, and the scrolling graph meter peaking off the top and bottom. Adjust the
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Gain so that clipping rarely, if ever, occurs. See the Meter Reference Section for
more information,

8. ADS516 ONLY - Stereo samples will be shown in the scrolling meter by channel,
The input from the left channel will be graphed on the top of the graph, and the
input from the right channel will be graphed on the bottom of the graph.
Disconnect one of the inputs to see the effect on the scrolling graph.

9. ADI1012 ONLY - ADI012 owners have the option of setting a variable lowpass
filter. Activate Auto Filter to set an appropriate cutoff filter for your sampling
rate. (The AD516 has a digital filter. It's automatically activated whenever you
record.)

10. Select a sampling Rate. Keep in mind that 44.1KHz is the CD standard and
48KHz is the standard rate for DAT players, Anything more than that does not
have an audible effect. For video purposes you may want to record at about
32KHz. This gives a 16KHz frequency response, more than adequate for
narration and sound effects. (The nearest available sampling rate for the AD1012
is 30,120Hz.)

11. Click the Name button and type in a name for your sample. The default is
Untitled.,

NOTE You can name the sound before you start recording, or you can rename the sample in
the Sample List later.

12. To begin recording, click Record. A window will appear in the middle of the
screen indicating that recording is in progress. Also displayed is the name(s), the
size of the sample recorded so far, and the remaining disk space, These numbers
will change as the record proceeds. And, unless you're recording to RAM, your
hard disk light will flash.

Figure 3-2. Recorder's Progress Indicator

If you have SMPTE time code plugged into the AD516 or AD1012, the recorder
will show the time your recording began. Later, if this sample is loaded into the
Editor or the Cue List, this SMPTE time code will enter itself with the sample.

13. To stop recording, click the Stop button. If you continue to hear sound, it is the
monitoring of the audio source. Click the Menitor button to stop monitoring.
The "monitor” and "record” functions are independent. Also, your hard disk light
may continue to flash for a few seconds after selecting stop. This is normal.
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Play from Sample List

There are a few ways 1o play back a sample. To play back from Sample List:

. Launch Sample List from the Applications Menu, (* Q). (You can close any
other modules that are open.)

2. Select the sample you recorded earlier by clicking on its name. It will be in the
active directory. The active directory, or record path, 1s indicated by .

3. AD516 ONLY - To playback a stereo sample, you need to select both the
samples that were recorded, (e.g. Untitled_L and Untitled_R). Select both
samples by shift-clicking. (Holding down the shift key while clicking on multiple
sample names.)

4. Play the sample(s) by selecting Play Sample from the Sample List menu or by
typing A-P.

5. Tostop the playback early, select Stop Playback, A-5S.

NOTE When playing back multiple samples, all samples must have the same sampling rate.

=i Sample List e
I~ AUDIO0: A RAM:

CarStart rack?_

Crunch TrackZ_R

Dest inations
Intro_L

R
Hus lcHix_L
MusicHix_R

Hta_?rl
Rif
SourceSanple

VolceDver f‘{_l ﬂc

Figure 3-3. Sample List

Edit a Sample

To make changes to a sample, it must be loaded into an editor. This part of the
tutorial covers basic navigation within the editor and use of the non-destructive cut,
copy and paste.

Load a Sample Editor

1. Load Sample List from the Applications Menu (* ).

2. Select the sample you want to edit and select Edit Sample from the Sample List
Menu or type A-E.

3. ADS516 ONLY - To edit a stereo sample, select two samples in the Sample List
(ending in _L and _R ) by shift-clicking and then select Edit Sample (A-E)

4. An Edit window will appear with your sample(s) graphed.
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5. Select Play All from the Editor Menu to hear the sample (A-P). The keyboard
shortcut A-F is one the most useful short cuts, it causes samples to play in many
of the modules.

Copy a Range and Duplicate It Within the Sample

1. Mark a range over the area of the graph you want to duplicate. To mark a range,
click on the graph and drag the pointer to the left or right. To alter the size of an
existing range, click on one edge of the range and drag it to a new location.

2. Select Play Range from the Editor Menu (A-L) to hear the marked range.

i | Husic L .Music B || =

o | e e
Pilay Bn|__Stop | Show AL| Range A Show Ral|_ Zn In | _Zn Out | |

Figure 3-4. Edit Window

3. Select Non-Destructive Copy from the Edit Menu.
4. Click on the graph to select an insertion point for the copied range.

Select Non-Destructive Paste, and Insert at Start, (A-V). (Start refers the
beginning of the marked range. When vou just click on the graph, you create a
very small range.)

6. Click Play All to hear the new version of the sample. Undo Last will return the
sample to its previous state.

NOTE Because the previous copy and paste were Non-Destructive edits, Undo Last is able
to cancel the change. Destructive edits are pot reversible. Having a choice between
destructive and non-destructive editing allows you to have more control over your
samples. Destructive editing actually changes the data on your hard drive as vou alter
a sample in the editor. However, Non-destructive edits do not destroy data on your
hard drive. It just remembers which edits you want to perform on the sample. Non-
destructive edits can be made permanent and free hard disk space by selecting Make
Permanent. See the Reference Section on the Editor for more information
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Delete a Range

1. Mark a range 1o delete using the previous technique,

2. Select Non Destructive Delete from the Edit Menu, (A-D). Since the delete is
non-destructive, it will not erase data from your hard disk. To free hard disk
space, use the destructive delete or select Make Permanent after doing the non-
destructive delete,

Create a Region
Regions are named ranges within samples. Once created in the Editor, they can be
dragged and dropped into the Cue List for playback.

1. In the Editor, select a range to be named as a region. For details on marking
ranges refer to the technigque mentioned previously in this section.

| g ]

From the Editor’s Options Menu, activate Show Regions. An Editor Regions
List will appear.
3. With Editor Regions List active, a Region Menu is available in the Menu bar.

4. Select Add Region from the Region Menu to create a region from the marked
range in the Editor.

| Editor Realons |||
HusicHix
chorus
Tultarsulu
ntro
versei

verse2 .
verse3 Ei
e

r

Figure 3-5. Editor Regions List

5. When prompted, enter a name for the region.

6. You can now drag this region into Cue List for playback. (Regions can also be
dragged from the Sample List. Show Regions must be activated from the Sample
List menu for regions to be displayed there.)

Convert a Sample

When a sample is recorded it is usually stored in the Studio16_2.0 file format. This
default format is selected in Preferences from the Project Menu. Studiol6_2.0, like
AIFF, is a 16 bit format, It includes special data that keeps track of non-destructive
edits and marked regions. To export a sample to another audio program you will
probably have to convert to another file format. Studio 16 will convert to:
Studiolf_1.0. AIFF 16bit, IFF_85VX, AIFF Bbit, and RAW. Below are the steps to
convert a sample to an IFF_8SVX format,

1. Load Sample List from the Applications Menu (*0).
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2. Select a Sample to Convert.

3. Select Convert from the Sample List Menu (A-C).
4. Select IFF_8SVX for the file format.

5. Click OK.

6. A Save File Requester will appear. Enter a directory and file name for the new 8
bit sample.

7. Click OK.

Figure 3-5. Convert Sample

The original 16 bit sample remains on disk. To delete it, use Sample List.

9. You can now load the new 8 bit file into other programs. You can even load in
back into Studio 16, but because converting a 16 bit sample to an 8 bit format
drops bits, the sample won't sound as good as it did before the conversion,

NOTE Sece the Reference Section on Sample List for a description of the available file
formats and more detailed instructions on converting.

Converting files to IFF 85VX can be useful if you need to conserve disk space and
you're working with samples that don't require a high SNR (Signal-to-Noise Ratio).
Sound effects like explosions will likely sound the same whether they're 8 bit or 16
bit files. Both 8 and 16 bit files can play simultaneously, if they have the same
sampling rate. Plus, the 8 bit file will only take up half of the disk space it did when it
was a 16 bat file. (MNote that this is true for both the ADS516 and the AD1012, because
samples recorded with the 12 bit AD1012 are stored in a 16 bit format.,)

Quit Studio 16

To quit Studio 16, select Quit from the Project Menu. Before clicking OK, you
should check the Sample List for any samples in the RAM: directory. These samples
should be moved to a directory on your hard disk before turning off your Amiga;
otherwise, they will be lost,

To save the position of all the open windows and their settings select SaveSetup from
the Project Menu before selecting Quit.
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Studio 16 usually uses a hard disk to store audio files. Although it is possible to use
RAM for sample storage (add RAM: path to Sample List), this is not common. Hard
disks are preferred because they can store large amounts of data relatively cheaply.

About Hard Drive Specifications

Hard disks are primarily rated by their "average seek time". This is the average time
it takes the read/write head to move between two random tracks. For example, the
hard drive in an Amiga 3000 is often an "11 ms, 105 MB SCSI Quantum.” This
translates to a drive that holds 105 megabytes of data. is manufactured by Quantum,
and has an average seek time on reads of 11 milliseconds. This is a little deceiving
because the Quantum drive has a track buffer that makes reads appear faster than
writes. The average write seek time on the same drive is 19 ms,

A second parameter of drives is the "data transfer rate” from the drive once the seek
is completed. The hard disk controller you use can affect this as much as the drive
itself. In general, slow data transfer rates are only important on optical drives. For
example, a fast drive with an A3000 hard disk controller may run at 1.9 MB per
second. However, a typical Magneto-optical drive runs at 100K per second for
writes, and 300K per second for reads.

How Fast Does My Hard Drive Need To Be?

Studio 16 will work with almost any drive you can buy these days. However, the
faster the better. For example, the A3000 105 MB Quantum with an average seek
time on reads of 1 1ms and [9ms on writes is fast enough for about 6 tracks at a
44.1KHz sampling rate using the AD516.

But even slower drives will work. For example, the "SyQuest” removable media
drive has an average seek ume of 26ms. It is possible to do multiple tracks with this
drive. However, you may have to reduce your sampling rate or the number of tracks
you are playing back. Note that the AD516 is much more efficient than the AD1012,
As a rule you can play more tracks at faster rates with the ADS 16,

Removable Media Drives

SyQuest and Bernoulli make popular removable media disk drives. In testing, we
tfound that vou can play multiple tracks off these drives, although you may have o
reduce the sampling rate or the number of simultaneous tracks. You may also need to
increase the "Channel Buffer" in Preferences.
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Optical Drives

Although we haven't tested it in house, we have reports from AD 1012 owners
recording and playing one channel of audio with a Ricoh 600MB magneto-optical
drive. This drive has an average seek time of 33.7ms with read and write rates of
J00K/second and 100K/second respectively. In order to work, the "Channel Buffers"”
in Preferences were increased to IMB. Note that performance will be improved with
the AD516.

Other users report to playback 2 tracks with a Maxtor Tahiti 11- | GB magneto-
optical drive using the AD1012 in an A3000. Access time for this drive is 90-120 ms.

For more information on the above drives, contact the manufacturers, listed in
Appendix C.

Hard Drive Space Requirements

Memory usage is entirely based on the sampling rate of a sample. The following
chart provides a Meg per Minute guide for common sampling rates when recording
16 bits, The formula used to derive the chart is; MB = Sampling Rate x 2 x 60
sec/min + 1024byte/k + 1024k/MB. Or, more simply, 1 second of sound =2 x
Sampling Rate.

When recording in stereo, double the space requirements listed below.

Sampling Rate Space for 1 minute Space for 30 minutes
{1 track - 60 seconds) (I rack - 1800 seconds)

11,000 .3 MB 378 MB

22,000 25MB 75.5MB

32,000 37MB 10%.8 MB

44,100 50MB 151.4 MB

50,000 57MB 171.6 MB

Fragmented Hard Drives

As drives are used, they tend to become cluttered. The operating system starts to
spread files out across tracks that are not close to each other. As a result, it takes
longer to read the files because the hard drive must seek farther between tracks. This
15 called "fragmentation” and becomes a particular problem as the hard disk becomes
full, If your hard disk or audio partition is fragmented, you may have trouble playing
sounds. You can purchase programs that will "optimize” or "de-fragment” your hard
disk. They scan your hard disk and rearrange the data so that all the data for a
particular file is near each other.
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Disk Errors

Hard drives aren’t fool proof, and it is almost inevitable that you will at some point
encounter a disk error. This can manifest itself as a "Read” or "Write" error. Or,
occasionally as a "Can't Validate Drive” error. Sometimes clicking "retry” or
"cancel” on the DOS requester presenting the errar will cause the error to disappear.
However, if this happens you should start to worry because the error will probably
reappear later, and can mean a farling hard drive.

Of course your best advice 15 to backup your hard drives, They can be backed up toa
SCS1 tape drive or a SCSI optical drive. However, due to the time and expense
involved, many people don't bother. Just be warned that a hard disk "crash” is more
than a possibility, it is very likely that it will happen to you eventually. For more

N information on preventing disk errors, and recovering data after a disk error, refer to
Chapter 7 - Troubleshooting.

If your hard drive crashes, and you're not sure what to do, take your Amiga to your
Amiga dealer. Their service department should be experienced in attempting to
restore data from corrupt hard drives.
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Introduction to SMPTE Time Code

SMPTE (Society of Motion Pictures Television Engineers) time code 15 a standard
way to keep track of time or position on tape. SMPTE (pronounced "simp-tee”) time
code is most common in video production, but is also used in film and music
production. In general, SMPTE time code specifies position and timing information
in terms of frames. The format is:

HH:MM:SS:FF (HOURS:MINUTES:SECONDS:FRAMES)
(01:12:06:02 refers to 1 hour, 12 minutes, 6 seconds, and 2 frames)

Time code is used to synchronize events. With Studio 16 you can specify a sound to
trigger at a specific time code. For example, you may find that a door begins to open
at exactly 1 minute, 2 seconds, and 13 frames into your tape. You can set up Studio

16 to trigger an opening door sound effect at 00:01:02:15 with the Cue List.

In Studio 16 you have the added benefit of working with what we call SMPTE Plus.
If activated in the Cue List, a fraction of a frame can be used, as in (0:01:02:15.50.
This would be 1 minute, 2 seconds, and 15% frames.

SMPTE time code is used to synchronize events in music and video production. For
example, a musician with a multi-track tape recorder may want to synchronize it with
a MIDI sequencer. This can be accomplished by "striping” time code onto the multi-
track, and then running the time code out of the multi-track, and into the computer.
The computer can then run a MIDI sequencer capable of "slaving” to the tape by
following the time code. Studio 16 and the Bars&Pipes sequencer allow you to
accomplish this without an external multi-track. Studio 16 can act as a digital multi-
track tape deck, and it will sync to Bars&Pipes through "internal” time code.

VITC or LTC SMPTE

There are two types of SMPTE time code: LTC (Longitudinal Time Code) and VITC
{Vertical Interval Time Code, pronounced "vit-see”). LTC is written on the audio
track of the tape deck, and VITC is embedded into the video signal. VITC has the
advantage of being available constantly, even when the video deck is paused.
Whereas, LTC requires that the deck be playing for time code to be available.
However, LTC time code is less expensive, and works on any audio tape recorder--
not just video decks. Both LTC and VITC store the same basic information--the
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frame number that specifies where the tape decks record/play heads are currently
located,

Both the AD516 and AD1012 include a LTC SMPTE reader. If your deck outputs
VITC, there are translators available that will convert the time to LTC which is read
by the AD516 or AD1012. See Appendix C for a supplier.

Frame Rate
One final aspect that needs to be specified when selecting a time code format is the
frame rate, or number of frames per second. SMPTE supports the following:

24 fps Motion Pictures

25 fps European Video

29.97 fps, non-drop frame USA color video

30 fps, non-drop frame USA B&W video or music
30 fps, drop frame USA calor video

When SMPTE was first introduced in 1967, it was at 30 frames per second and used
for black and white TV. However, when NTSC color TV was introduced, it used the
slightly slower rate of 29.97 frames per second. This is approximated in "drop frame"
SMPTE by dropping 108 frames every hour. Drop frame is used so "real time” or
"clock time” will match the time code marked on the tape. But because drop frame
can cause problems because of the missing frames 29.97 non-drop is often used.

Striping Time Code

In order to use time code, you must first “stripe” your tape, That is, you record time
code onto the entire tape area you are planning to use. Depending on the camera or

video deck you use, this may be automatic or manual, Or, you may have a dedicated
"Time Code Out” jack on vour deck.

Studio 16's internal SMPTE generator does not output time code for striping.

To stripe LTC onto your tape, you will need an LTC generator. Time code generators
can be part of a video cameras or a video deck. Or, they can be dedicated generating
boxes, or software programs, namely the SunRize SMPTE Output module, Appendix
C lists manufacturers of LTC generators.

Contact your dealer or SunRize for more information on SunRize's SMPTE Output
module that outputs LTC time code for striping tapes.

SMPTE for Video Applications

Time code is essential in any kind of professional video production. It allows precise
specification of video and audio edits, With Studio 16, you use SMPTE time code in
conjunction with the Cue List to synchronize audio effects, music, and narration with
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the video tape. These audio clips reside on your hard disk until vou create the final
master tape. During your edit sessions, the Cue List will track your tape's time code
and trigger sound effects as specified. You will be able to listen to the audio coming
off the computer as you watch the video.

SMPTE for Music Applications

SMPTE time code was originally designed for video applications but with the
success of MIDI (Musical Instrument Digital Interface) it became apparent that it
would be useful o use SMPTE time code to time MIDI sequencers and to
communicate with other MIDI devices. MIDI quickly adopted a MIDI Time Code
format. MIDI Time Code is easily converted to SMPTE Time Code and vice versa.
To drive external MIDI equipment you may need a SMPTE to MIDI time code
converter. Appendix C lists a source for such a device. MIDI time code is used as a
timing source for sequencers, to sync two tape decks together or to sync a tape deck
with a MIDI sequencer among other things. When Studio 16 15 used along with
Bars&Pipes Professional, you get complete sequencing capabilities as well as hard
disk recording. Your MIDI sequences can have vocal tracks and guitar solos without
having to use an expensive multi-track tape deck that tracks MIDI time code.
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Cue List Tutorial

The Time Line Cue List is a fast, flexible tool you can use to arrange sounds for a
variety of projects. To introduce you to some of the Time Line Cue List's
capabilities, we'll walk through two different projects:

®  Adding sound effects to a cartoon

®  Recording a multitrack session

As you work through the tutorials just relax, have fun, and experiment.

Cartoon Soundirack

For our first wtorial we'll be doing the soundtrack for the last scene of an imaginary
cartoon, In this scene there are three characters: a bird, a cat and a dog, They are
performing a play in front of an audience.

In the play, the cat has been chasing the bird. The bird is now inside the house where
the dog lives. This is where our tutorial soundirack begins.

®  Inan attempt to get the bird, the cat has disguised himself as a traveling
salesman and he knocks on the door. (DoorKnock)

The dog growls at the sound of the knocking. (Dog)

The cat opens the door. (OpenDoor)

The bird, seeing his chance to expose the cat while the dog 1s right there, flies
past the cat, (FlyBy) knocking off part of the disguise (Ricochet),

The dog, now recognizing the cat, punches the cat (Punch).

The cat's tongue goes in and out like a cuckoo clock as he recoils from the blow
{Cuckoo).

Silly music kicks in {CartoonMusic).

The curtain falls with a crash (Crash).

The audience applauds (Applause).

The bird pops his head through the curtain and smiles (SqueakPop). The picture
freezes and fades to black.

OK, that's the scene. It actually goes by pretty quickly. Keep in mind that the samples
included for the tutorial were sampled at a sampling frequency of 9600Hz in 3 bits.
This is very low quality but it lets us fit more samples on the distribution floppy disk,
and it gets the idea across.
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In a typical soundtrack project you will either log the sound effects and music times
yourself or get a list from a producer. Here are the times our imaginary producer has
given us for the start of each sound element used in our cartoon scene:

Sample Name Start Time
DoorKnock 01:00:06:07
Dog 01:00:07:03
OpenDoor 01:00:08:21
FlyBy 01:00:09:10
Ricochet 01:00:10:02
Punch O1:00:10:25
Cuckoo O1:00:11:07
CartoonMusic 01:00:13:28
Crash 01:00:16:16
Applause O1:00:18:07
SqueakPop 01:00:24:26

NOTE For cartoons it's also common to produce a sound track first and then create the
animation to match. Even if you don't work that way, using the Time Line Cue List is
a great idea. The Time Line Cue List makes it easy to make changes in your sound
track at any point in the production, including after the animation is finished.

Record the Samples

The first thing you would do for a project like this is create sounds, record sounds on
location, or find suitable sounds 1n a sound effects library. Then you would record the
sounds to your hard drive with Studio 16's Recorder, and clean them up with the
Editor. For more on using the Recorder and Editor, see their respective reference
sections in Chapter 8.

For expediency's sake, we've already recorded the sounds for this project. Some of
them came from the Hollywood Edge sound effects library demo CD. The sounds are

in the Samples drawer, which 1s inside your Studiol6 drawer. To save disk space
they were sampled as low quality 8 bit samples, but they’ll work for this exercise.

Prepare the Cue List
Open the Cue List and Set Fade and Drag Options

I. Use the Cue List menu item in the Applications menu to open the Time Line Cue
List, if it's not already open.

e

If an existing Cue List loads in the Time Line, select New from the Cue List
menu to load the default Cue List. The default Cue List contains four empty
audio tracks.

3. Turn Any Direction drag mode on, if it's not already on. This will allow you to
drag flags and Audio entries freely later on. (Figure 6-1.)
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Turn Unlimited Cross Fade mode on, if it's not already on. To do this click the
Unlimited Cross Fade button on the top of the Time Line Cue List window. This
will allow you to create real time cross fades of any duration. (Figure 6-1.)

Turn the Cue List ON. Click the ON/OFF button on the left side of the Time
Line Cue List window. The Cue List will not play if this button is OFF,

Figure 6-1, An Empty Time Line Cue List

Set Cue List Preferences and SMPTE Rate

Use the Cue List Preferences menu item in the Options menu to open the Cue
List Preferences requester and set the following parameters.

For this project we'll want the Time Line Cue List to display all times using
SMPTE time, so click the SMPTE button in the Time Options area of the
requester. This way the times we use will match the times used by our imaginary
producer, and if this was a real cartoon, the Time Line Cue List would
synchronize to it

Type a time in the Start Time field that's 15 seconds or so before the beginning
of the scene. The Start Time field is at the bottom of the Cue List Preferences
Requester, Simply type in the preferred start time. In this case we want to be
ahead of the start time of the first sound effect, the Door Knock, which starts at
01:00:06:07. So enter a time that's roughly 15 seconds ahead of that, like
0:59:50:00.

There's nothing sacred about starting the Time Line Cue List's view 15 seconds
before the scene starts; you could start 5 seconds ahead or 30 seconds ahead or
whatever works for you. You will want to start far enough ahead so that your
systemn has time to preload samples before they have to play. Fifteen seconds
gives you some room to work with, but you may be able to start playback within
5 seconds of the start of the scene and still have the first samples loaded in time
to play.

Type a time in the End Time field that's 15 seconds or so after the end of the
scene. The End Time field is at the bottom of the Cue List Preferences
Requester. Simply type in the preferred end time. In this case we want to be after
of the end time of the last sound effect, the SqueakPop, which starts at
01:00:24:26. So we want to allow for the sample to play and enter a time that's
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about |5 seconds past when it ends. SqueakPop lasts about | second, so enter
01:00:41:00.

The range of time you choose to view in the Time Line Cue List does not affect
when playback will start and end. Playback starts wherever the Position flag
happens to be and ends when you click the Stop button. There is a special flag
that makes it easy to set a start time for playback, called the Start flag (see the
following sections).

5. When you're done entering the start and end times for the Display Boundaries,
close the Cue List Preferences requester by clicking the close gadget in the upper
left corner of the requester. Keep all Display Options and Undo Levels at their
defaults.

Figure &-2. Cue List Preferences

6. Use the Preferences command in the Project menu to open the Preferences
requester. In the upper right corner of the requester is a section labeled
"SMPTE". Click the one labeled 29.97, if it's not already selected.

Since we're using SMPTE time code in this tutorial project, we'll want to make

sure that we are using the same SMPTE time code type as our imaginary

producer.

There are 4 commonly used SMPTE time code types:

® 2997 frames/second for NTSC video

m 30 frame drop frame for NTSC, which keeps more accurate real time by
skipping frame numbers periodically

® 25 frames/second for PAL video

® 24 frames/second for film.

For this Tutorial we've assumed our producer is using 29.97 frames/second
SMPTE time code.
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7. In Preferences you select the Studiol6 Interface Colors, To follow along with
this tutorial you select the Default color option. Close Preferences after you
make the selection.

Figure &-3. Studio 16 Preferences

Set the Start Flag

1. Set the start time for the cartoon's Cue List by dragging the Blue Start flag about
5 seconds before the start of the first entry. Since the first entry begins at
01:00:06:07, lets put the blue start flag at 00:59:57:00. To move the Blue Start
flag, just grab its banner and drag it left or right in time. If you drag past the left
or right edge of the Time Line Cue List, the Time Line Cue List will scroll. As
you move it, you'll see its start time displayed in the upper right area of the Time
Line Cue List window, called the Text area.

Flags are handy visual markers that you can move with the mouse. You can use
the flags to see where you are in the Time Line Cue List, to mark places in the
Time Line Cue List, and to define the start and end times for recording. The
Blue Start flag is a special flag you can use to mark the beginning of your Cue
List. The "banner” part of the Start flag looks like an arrow pointing to the right:

The "banners” of the flags float just above the Time Line Cue List and just
below the transport buttons, drag buttons, edit buttons, and the text area. The
"flag poles” of the flags are vertical lines drawn over the Time Line Cue List to
show the exact location of each flag in time.

2. Another way to move the Blue Start flag is by entering a time in the Flag
Parameters requester. Double click the Blue Start flag to open the Flag
Parameters requester, In the requester’s time field you can type the time where
you want the flag to be. To get a feel for moving the flag, try both methods. Drag
the flag left and right, and then double click the flag and try typing the start time
into the requester.

Add and Name the Audio Tracks

1. With our Time Line Cue List boundaries set and our start flag set, the next step
is to name our Audio tracks. Knowing that we have three characters, plus some
music, lets create four trucks.
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NOTE The fact that the Time Line Cue List allows up to 100 tracks means you can create
plenty of tracks to keep your sound track organized. The amount of samples that you
can actually play at one time depends on the SunRize cards you have in your Amiga.

2

Use the Add Audio Track in the Track menu to add audio tracks if you don't see
four audio tracks, Tracks are horizontal strips on the Time Line Cue List. They
begin with a series of buttons. The first button in each track, when selected,
looks like a speaker.

If you can't see all four tracks, drag the resize gadget down. The resize gadget is
in the lower left corner of the Time Line Cue List window.,

The third button from the left on each track shows the track’s name. Right now

all your tracks say "Audic”. Let's change them so that one says "Bird", one says
"Cat", one says "Dog" and one says "Music”. Click on the Name button for the
top track. This will open the Audio Track Parameters requester,

Audio - Track Parameters

At the top of the requester is a Name field. Click in the Name field and delete the
word "Audio”. You can use the delete key, the backspace key, or just type A-X
to clear the field.

Now type the word "Bird” and hit return. The track’s Name button should now
say "Bird".

Below the Name field is the Sampling Rate slider. The sampling rate on all the
tracks playing on a single SunRize card must be the same. The cartoon tutorial
samples were sampled at 9600Hz, so set the sampling rate by dragging the
Sampling Rate slider until it says "Rate 9600",

Now do the same for the other three tracks, except type "Cat” for track 2, "Dog",
for track 3, and "Music” for track 4. Each time vou click a different track’s Name
button, the requester will change to show information for that track.

Change the sampling rate for each track to "9600". Leave all other Track
Parameters at their defaults,

When you're done, close the Audio Track Parameters requester by clicking the
close gadget in the upper left corner of the requester.
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Your Time Line Cue List window should now look something like the following:

Figure 6-5. Four Tracks Named for Tutorial

Save the Cue List

1. The work you do on your Cue List in the Time Line Cue List is kept in your
Amiga's volatile memory. If you turn off your Amiga your Cue List will vanish
forever unless you have saved it to a hard disk or floppy disk.

NOTE It's extremely important to save your Cue List often. That way if you have a power
interruption, a system failure, or turn off your computer, you won't lose hours of
work.

2. Save your Cue List now by using the Save As command in the Cue List menu.
When you use the Save As command it will bring up the Cue List Save File
requester. Unless you change the default directory, it will be looking in the
Swdio16_3:CueLists/ drawer.

3. Type "Cartoon” in the File field and click the OK button. The Cue List will be
saved as "Cartoon.cue”.

4. So far our Cartoon Cue List just contains information about the four tracks, the
Start flag, and the start and end time boundaries for the Time Line Cue List.
Mow comes the fun part -- adding Audio Entries!

Add Audio Entries

It's important to know that Cue Lists do not contain any sound samples. While
finished Cue Lists do contain information about when to play samples, the sample
data is stored separately on your hard drive. The Time Line Cue List represents
samples with rectangular Audio entries. Audio entries store:

m  Location of the samples on your hard drive
®  Time to trigger samples
m  Instructions to non-destructively crop or fade samples

Adding Audio entries is a breeze. All you have to do is drag samples from Sample
List onto Audio tracks,
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Dragging and Dropping Entries

1. Open Sample List by choosing the SampleList command in the Applications
menu, Sample List shows multiple directories from which you can drag sounds.
For this tutorial we'll access the Samples directory as shown.

Figure 6-6. Sample List

2, If the Samples directory is not showing in Sample List, make Sample List the
active window by clicking its title bar. Then choose the Add New Path command
from the Sample List menu to open the Select New Path requester.

3. Select the Samples directory, located in the Studio 16 drawer, and then click the
OK button. Now Sample List should show the Samples directory, as shown
above.

4. Lets start by dragging the Applause sample from the Samples directory in the
Sample List, Click Applause (in Sample List) with the left mouse button. Keep
the left mouse button down and move the mouse. The sample name will attach
itself to your mouse pointer. Move the mouse pointer to the right of the Blue
Start Flag anywhere over the Bird track and release the mouse button. Applause
will appear on the track.

= E w

Figure 6-7. Time Line Cue List with Applause Entry On Bird Track

5. MNow drag the rest of the samples from Sample List onto the Time Line Cue List
as follows, Drop them anywhere on the track to the right of the Blue Start Flag,
but try not to overlap them. If they overlap, just click and drag them down the
time line, or delete them and drag and drop them in again.
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Track 1 Bird  Applause, FlyBy, SqueakPop
Track 2 Cat DoorKnock, OpenDoor, Cuckoo
Track 3 Dog Dog, Punch

Track 4 Music  Ricochet, CartoonMusic, Crash

SRR e S
~_ Applause  ||F LyBp Sa3

=

Figure 6-8. Time Line Cue List with All Entries Added

6.
T.

Just to demonstrate something, we have a minor problem. The Applause entry is
on the wrong track. 1t should really be on track 4. Not to worry. Not only can
you drag samples from Sample List onto Audio tracks in the Time Line Cue List,
but you can also drag Audio entries between Audio tracks on the Time Line Cue
List.

Drag the Applause Audio entry from track | to track 4 with the mouse.

Use the A-W shortcut to save the Cue List. It's a good idea to save often.

Listen to the Cue List
Let's see what all these Audio Entries sound like.

Z

Click the Play-From-Start button. It's the second transport from the left in the
upper left corner, You should hear some Kind of cacophony. A glorious racket.
Don't worry, we're not done yet.

Click the Stop buttan. It's the fourth from the left in the upper left corner.

NOTE If you do not hear the samples play, drag the samples along the time line, to the right
of the Blue Start Flag by 8 seconds.

3.

If you can't see any of the Audio entries any more, scroll or zoom the Time Line
Cue List. There's a horizontal slider at the bottom of the Time Line Cue List
window. Slide it to the left or right until you can see all the entries.

You can also click the Zoom buttons to zoom in and out on the Time Line Cue
List view, The Zoom buttons are just lefi of the horizonial scroll bar,
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Move the Entries

Now that you have all of your audio entries in the Cue List you need to move them to
the start times our imaginary producer gave us. Here are those times again:

Sample Name Start Time
DoorKnock 01:00:06:07
Dog 01:00:07:03
OpenDoor O1:00:08:21
FlyBy 01:00:09:10
Ricochet O1:00:10:02
Punch O1:00:10:25
Cuckoo 01:00:11:07
CartoonMusic O1:00:13:28
Crash O1:M:16:16
Applause 01:00:18:07
SqueakPop 01:00:24:26

To move an Audio entry in time, Just drag it left or right. If you drag past the left or
right edge of the Time Line Cue List, the Time Line Cue List will scroll. As you
move it, you'll see its start time displayed in the upper right area of the Time Line
Cue List window, called the Text area. Try dragging an Audio Entry left and right
just to get a feel for it.

Another way to move an Audio entry is by entering a time in the Audio Event
Parameters requester, Since we have exact times from our imaginary producer, this is
the method we'll use.

1. Double-click the DoorKnock Audio entry to open its Audio Event Parameters.

2. Enter the time from the Producer's list, 01:00:06:07, into the Start Time field.

Figure 6-9. Doorknock - Audic Event Parameters

3. Hit return on your keyboard, then click OK. The DoorKnock Audio entry now
begins where it should.
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NOTE

An "Overlap Contention Requester” will appear if you cause one sample to be moved
on top of another. If this occurs, click the Undo Last Edit option and then move the
sample out of the way.

4. Now change the start times for each of the other Audio entries in the same way.
Double click each of the other Audio entries and enter their start times from the
list before. When you're done, close the Audio Track Parameters requesters by
clicking OK.

NOTE

You can skip the above step, by opening the Tutorial_A_cue file from the
Studiol6_3:CueLists\ drawer. Tutorial_A includes all the tutorial samples at their
correct start times. You can then continue with the Crops, Fades and Edits section of
this tutorial.

5. Now save the Cue List again. It's a good idea to save every time you make major
changes.

Figure 6-10. Time Line Cue List with Moved Entries

You might notice that some of the Entries overlap. Where CartoonMusic and Crash
overlap you'll see that their color has changed and there is an "X" shape. The "X"
signifies a real time cross fade. A cross fade is where the end of one Audio Entry
fades out while the beginning of the next Audio Entry fades in.

Any time you move one Audio entry over another on the same track, the Time Line
Cue List automatically creates a cross fade between the two Audio entries. Making
cross fades is so easy in the Time Line Cue List that you just made some without
even lrying.

Crops, Fades and Edits

Go ahead and use the Play-From-Start button again to listen to the Cue List. It should
now sound close to the soundirack we want for the cartoon scene.

But there are still a few refinements we need to make. Some of the entries need to be
shortened, some of the cross fades need to be changed, we need to add more Cuckoo
entries, and we need to fade the end of the Applause entry.
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Information contained in this chapter is only an illustration of Cue List features. For
complete documentation on the Cue List including fades and crossfades, please refer
to Cue List Reference Section in Chapter 8,

Crop and Fade Out FlyBy

. Crop and fade the FlyBy entry by clicking the FlyBy entry on track 1 to select iv.
[t should change color and you should see four white squares. These squares are
handles you can drag with the mouse.

2. The middle squares on the ends are the Crop gadgets. They let you crop the
entry. Crop FlyBy to end at 01:00:10:14 by clicking and dragging the gadgets on
the end. Notice that the Text area in the upper right part of the window shows the
start time when you drag the lefi Crop gadget and the end time when you drag
the right Crop gadget.

The squares in the top corners are the Fade gadgets. They let you add real time
fades. Try dragging the Fade gadgets. Notice that the Text area in the upper right
part of the window shows the fade time for the Fade gadget you are dragging.

Adding real ime fades and cropping entries is completely non-destructive. They
do not change the sample on your hard drive. They only affect how the sample
plays back. You can change the fade times and crop amounts whenever you want
without losing any data or affecting other Audio entries that use the same
sample. You can use the Undo command in the Options menu to get back to a
previous crop or fade setting.

3. You can listen to how the Audio entry sounds with your crop and fade changes at
any time by using the Play Selected command in the Entry menu. Try it

4, Now let's set up the fades we need for our cartoon. But instead of dragging, this
is a good opportunity to cheek out another way to crop or fade an entry,

5.  Double-click the FlyBy Audio entry to open the Audio Event Parameters.

Figure B-11. FlyBy Audic Event Parameters

6.  Type (:00:22 in the Fade Out field to create a fade at the end of the entry,

7. When you're done, close the requester by clicking OK.
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Crossfade Ricochet with FlyBy

It turns out the Ricochet entry on track 4 needs to be moved. It really belongs on
track 1. Since you've already moved the entry to where it belongs in time, it
would be nice to be able to move it straight up to track 1 without losing the start
time,

There is a way. There are three buttons on the top of the window that control
how dragging works.

Figure 6-12. Drag Mode Buttons

i

We selected the first button earlier in the Tutorial. It's the Any-Direction button.
When it's selected you can freely drag entries both horizontally and vertically.
The middle button 15 the Lock-To-Grid button that snaps flags and the
beginnings of entries to the nearest grid mark when you move them, The third
button is the Vertical-Only button, and that's what we need here.

Click the Vertical-Only button. Now drag the Ricochet entry from track 4 up to
track 1. Notice that you can’t move it left or right. In Vertical-Only mode you
can only move entries between tracks. This lets you move them from one track 1o
another without losing their start times, (This step overrides the fade placed on
Flyby in the previous section.)

After you move the entry, click the Any-Direction drag mode button again.

MNotice that the Time Line Cue List created a cross fade between the FlyBy entry
and the Ricochet entry. We want the FlyBy entry to fade out, but we want the
Ricochet entry to start with no fade.

Click the cross fade area between the two entries to open the Cross Fade Type
requester.

Figure 6-13. Cross Fade Requester for FlyBy and Ricochet

8

Here you see four curve buttons for Fade Out and Fade In. The Fade Out button
on the left, which selects a linear curve, is already selected and that's what we
want. For the Fade In, click the button on the right. That's the Instant In button,
which will start the Ricochet entry immediately.

When you're done, click the close gadget in the upper left corner of the requester
to close it.
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Fade Between Cartoon Music and Crash
. Click the Cross Fade area between the CartoonMusic entry and the Crash entry
on the Music track. This brings up the Cross Fade Type requester again.

2. This time, click the second buttons for both Fade Out and Fade In. Close the
requester,

Figure 6-14, Cross Fades for CartoonMusic and Crash

Change the Fade Between Crash and Applause

I. Click on the cross fade area between the Crash entry and the Applause entry.
This changes the Cross Fade Type requester so it shows the curve types for that
cross fade area.

Figure 6-15. Cross Fades for Crash and Applause

2.  What we want to do here is a linear fade out of the crash at the very end, and a
linear fade in of the applause at the very beginning, for a basic cross fade effect.

3. To accomplish what we want, select the first Fade Out button and the first Fade
In button. When you're done, click the close gadget in the upper left corner of
the requester to close it.

Fade Out Applause
1. Click on the Applause entry and use the Play Selected command in the Entry
menu to hear it. Notice how it cuts off at the end, Let's fix that.

2. Grab the Fade gadget on the right and drag it to the left to add a real time fade to
the entry. Play it again to hear the change.
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Figure 6-18. Applause - Audio Event Parameters

3. Now double click the Applause entry to open the Audio Event Parameters
requester and lets choose a different fade curve.

4. In the requester you see the same four curve buttons for Fade In and Fade Out. In
the Fade Out area, click the third button from the left. This selects an exponential
curve, which fades fast at first, and slows down the fade as it gets to the end.
This is a nice effect for applause.

5, Click OK and play the entry again to hear how the exponential fade out sounds.

6. Use the Play-From-Start button again to listen to the whole Cue List. We're

zeiting there.

Copy Cuckoo Four Times and Butt Edit Copies

User's Manual

Notice that we have only one Cuckoo sample. We can take that sample and make
the clock strike four without taking up any more hard drive space. We will reuse
the same sample over and over.

Hold down the control key and drag the Cuckoo entry to the right. When you
hold down the control key and drag, instead of moving the entry you will move a
COPY of the entry. The original entry will not move.

Do this two maore times so you have four Cuckoo entries on the Cat track.

Your Time Line Cue List should look something like this:
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Figure §-17. Time Line Cue List with Four Cuckoo Entries

&

Mext we'll ereate perfect butt edits between the four entries. To do this we'll
change the Edit Mode. The Edit Mode buttons are at the top of the Time Line
Cue List window, to the right of the Drag Mode buttons.

So far we've had the first button selected, which puts us in the Unlimited Cross
Fade mode. In this mode we can overlap entries and the Time Line Cue List will
create real time cross fades. The second button 15 the Limited Cross Fade button.
In this mode you can restrict the maximum cross fade time. The third button is
the Butt Edit button, which does not let you overlap entries. That's the one we
want,

Figure 6-18. Edit Mode Buttons

T

Click the Butt Edit button. Now drag the second Cuckoo over uniil it pushes into
the original Cuckoo entry. When vou touch them you should see what looks like
a little piece of colored splicing tape holding them together,

When you see the tape, you've created a perfect butt edit. The entries do not
overlap, nor is there any space between them,

Go ahead and drag the third and fourth Cuckoos into the others,

Figure 6-19. Time Line Cue List with Four Cuckoo Entries Bulted Together
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1. Now play the Time Line Cue List and pay attention as the Cuckoo clock sounds
play. With one sample you've created a four o'clock effect!

NOTE

This technique is also useful for tape loop and ambient sound effects. For those use a
cross fade between copies instead of a butt edit,

11. Now use the A-W shortcul to save the Cue List again. It's a good idea to save
every time you make major changes.

Adjust Volume and Pan

Play back the Time Line Cue List a few more times. What do you think? If there are
any entries that sound too loud or soft, you can change their volumes.

l. Double click on the offending entry to open the Audio Event Parameters
requester.

2. Notice the volume slider on the right. Raise or lower the slider to change the
volume for that entry.

Figure 6-20. FlyBy Audio Event Parameters

3. If you have an AD516 card you can also change the Pan setting for the entry.
Just slide the pan slider (at the bottom of the Audio Event Parameters requester)
to the left, right, or anywhere in between.

4. Now use the Amiga-W keyboard shortcut to save the Cue List again, You should
always save after you finish working on a Cue List! Then, next time you want to
bring the Cue List into the Time Line Cue List, use the Open command in the
Cue List menu and you'll be able to work with the Cue List again.

Congratulations on completing the Cartoon Scene tutorial! Notice how using multiple
tracks helped us keep the project organized. Many of the techniques you vsed in this
tutorial will be useful for other video and film soundtrack work.

If you would like to compare your final Cue List with ours, Load Tutorial_B.cue
using the Open menu item in the Cue List menu. This is the Cue List file we created.
This Cue List should look and sound very much like yours,
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Multitrack Recording

Next up is a tutorial that goes through a typical multitrack recording session. This
tutorial is a typical application for musicians. And although videographers will not
generally use every function discussed here, they will find many useful features
described.

For the purposes of this tutorial, choose four musical parts you want to record. They
can be any combination of vocals and instruments. A few lines in four part harmony
from a barber shop quartet arrangement would do nicely. If you don't sing or play an
instrument, try doing a simple rap or just reading some lines from this manual. Try to
pick a short segment of music or speech to experiment with. Twenty to thirty seconds
will be enough for this tutorial.

NOTE Samples and Cue List files relating to this tutorial are not provided on disk.
Experiment with this tutorial by creating your own.

Preparation
Connect Your Hardware Mixer to Your AD516 (AD1012)

1. If you have an AD516, connect the left and right outputs of your external mixer
to the left and right input jacks on the AD516.

2. If you don't have a mixer, you can plug certain instruments directly into the
audio inputs of your SunRize card, including most synthesizers and samplers.
But you'll need a mixer, or at least a microphone preamp, to connect electric
guitars and microphones. ’

3. If you have an AD1012, connect the monophonic output of your mixer to the
input of the AD1012. If your mixer doesn't have a monophonic output, use the
left channel output and pan all your mixer's input channels to the left.

4. Now connect the instruments or microphones you want to use for recording
directly to your mixer. Consult your mixer's manual for more information.

S.  You can connect the outputs of your SunRize card either directly to an amplifier
driving monitor speakers, or if your mixer has a monitor bus, back to the mixer.

In the latter case, use the mixer's monitor bus to feed a power amplifier driving
monitor speakers so you can listen to your SunRize card. Keep the main faders
for the SunRize channels down or you may run into feedback. Using your

SunRize card for multitrack recording is a lot like using a tape deck, so consult
your mixer's manual for information on connecting and monitoring a tape deck.

Create Four Tracks On the Time Line

I. Just as you did in the first wiorial, create four audio tracks. Name them for the
instruments you want to use. For example, you might call them "Bass”, "Guitar”,
"Wocal" and "Solo”.
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Figure 6-21. Empty Multitrack Cue List

2. Set the Time Line Cue List boundaries and time display type. Since we're just
| going to do 20 or 30 seconds of music, set the Time Line Cue List Boundaries in
i the Cue List Preferences requester so that the Time Line Cue List starts at
| 01:00:00:00 and ends at 01:01:00:00,

{120 N4 €4 |

— Yl Nguala —————

“ pirplny Bounderies
Stant Tine 81:068:88;:680 |
y Endl Time 81:81:88:88 |
Figure 6-22. Cus List Preferences

NOTE It's better to start recording at one hour than at zero hours. That way if you ever need
to add parts before the beginning of your project, you have an hour to work with.

3.  Set the Time Options in the Cue List Preferences requester to SMPTE.

Set the Start Flag and the Punch-In/Punch-Out Flags
1. Move the Blue Start flag to 01:00:00:00.

2. The Punch-In flag leis you specify where recording will begin. The Punch-Out
flag lets you specify where recording will end. The two flags together are like an
under appreciated, under paid, dead accurate, assistant engineer. They will work
long hours for the sheer glory of helping you produce your music. They will be
there for you, take after take, no complaints, no overtime.
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Figure 6-23. Punch-In and Punch-Out Flags

As you learned from moving the Start flag in the first wutorial, there are several
ways to move flags. You can drag them, or you can double click a flag and type
an exact time in the Time field of the Flag requester,

Drag the Punch-In flag 1o 01:00: 10:00. Notice that it turns into the Punch-Out
flag. Don't worry, that's normal. The first of the two will always be the Punch-In
flag and the last will always be the Punch-Out flag.

Mow double click what has now become the Punch-in Hag and type 01:01:00:00
in the Time field of the Flag requester. Notice that the first of the two flags has
now become the Punch-In flag again.

Figure 6-24. Multitrack Cue List with Punch In/Out Flags Sel

5. Move the Time Line Cue List's view to the Punch-Out flag by clicking the Show

button in the Flag requester. Another way to jump to the Punch-Out flag is to
type the ) key on the numeric keypad. Type the ( key on the numeric
keypad to jump to the Punch-in flag.

Turn ON the Activation button. The Time Line Cue List will not play back
unless the Activation button is ON.

Choose the Track Playback and Record Settings

Click on the first rack's Name button to open the Audio Track Parameters
requesier.

Click on the Playback drop list and select "Play 1",

Click on the Record drop list and select "Input” (if you have an AD1012) or
"Input L" (if you have an AD516).
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Figure 6-25. Bass - Audio Track Paramelers

4, Set the sampling rate to 44100 by dragging the sampling rate slider until it says
"Rate 44 100",

5. Click on the second track’s Name button (Guitar) so the Audio Track Parameters
requester reflects the information for track 2. Click on the Playback drop list and
select "Play 2. Click on the Record drop list and select the same input you did
for the first track (Input L).

6. Do the same for the third and fourth tracks (Vocal and Solo), except set them to
play back on "Play 3" and "Play 4" respectively.

7. Choose the record path for your samples by launching Sample List from the
Applications Menu. In Sample List, click on the small button next to the name of
the directory where you want to record your samples. If the directory is not
showing, use the Add New Path command in the Sample List menu, as you did
in the first tutorial.

8. Open SMPTE Monitor from the Application Menu. SMPTE Monitor lets you
see where you are on the Time Line Cue List. Think of it as a very accurate tape
counter. For more on SMPTE Monitor see the SMPTE Monitor Reference
Section in Chapter 8.

Save the Cue List
1. Save the Cue List as "Multitrack.cue”.

It pays to save often. From now on save after every major change you make to the
Cue List. No more reminders...

Now might also be a good time to use the Save Default command in the Cue List.
This will save the current Time Line Cue List setup as the default Time Line Cue
List.

For example, if you use the Save Default command now, the next time you start the
Time Line Cue List or select the New commuand in the Cue List you'll get a blank
Time Line Cue List setup just like this one is now. This can save you time when you
work on your next project.
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If you later change your mind about how you want your default Time Line Cue List
to be set up, just change the Time Line Cue List to what you want and use the Save
Default command again.

Record A Track
Select the Track

. Click the Track Select button on the first track. The Track Select button is to the
right of the track’s Name button, and it looks like an arrow when it's selected. A
track will turn dark blue when it is selected. Only the selected track will be used
for recording.

Figure 6-26. Bass Track Selected

NOTE AD516 Only - Record stereo samples by shift-clicking multiple tracks. Set one track
tos record "Input L" and the other to record "Input R,

Set the Input Levels

1. It's important to set your levels carefully before you record a sample. To monitor
levels, select the Meters command in the Applications menu to open the Meters,

Figure 6-27. Meters

2. Click the Meters to select it, then look at the Channels menu and select "Input”.
Oither selections can also be selected. Then move the Meters window so it
doesn't obstruct the Time Line Cue List.

3. Now in the Cue List, click on the Name button for Track | ta open the Audio
Track Parameters. At the bottom left of the requester is a Gain slider, This slider
lets you increase the input gain into your SunRize card. When you click on the
slider and hold down the left mouse button, you will be able to see your SunRize
card’s input level displayed on the Input meter in Meter.
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4, Click the Gain slider, play or sing your loudest note, and watch the Input meter.

5. If you can't play and click on the Gain slider at the same time, there's another
way 1o see the input level. Open the Mixer and drag the Input level slider up to
+00 dB. Then you don't have to hold down the left mouse button over the Gain
slider.

6. As you watch the Input meter, adjust the gain on your hardware mixer so that the
loudest note is as high as possible without going into the overload area of the
Studio 16 Input meter on your screen.

7. The overload area is above +00 dB. It's marked in a different color than the rest
of the meter. Going into the overload area will cause clipping, which creates an
annoying distortion. On the other hand, recording at a low average level can add
noise to the signal. Also, low average signals don't take full advantage of the
dynamic range of your SunRize card. The key is to record at as high a level as
you can without clipping.

8. Meters lets you watch three types of metering. The LED-style metering is the
maost responsive to watch for setting input gain. Different color "LEDs" on the
right show overload. The scrolling graph shows a history of the last few
momenis of the input and you can see overload when the graph touches the edge
an the top and bottom. The analog-style metering shows overload as a different
colored area of the meter on the right just past 0 dB.

NOTE

Always set your hardware mixer's input gain, channel gains and output gains for best
performance. Any noise or distortion you add with your mixer before the SunRize
card's input will be faithfully recorded by your SunRize card. Consult your hardware
mixer's manual for instructions on setting the levels there,

. If you have your hardware mixer set up correctly and you still can't get enough
level showing on the Studio 16 Meter, adjust the Gain slider in Audio Track
Parameters until you have a good level. With proper input level settings your
SunRize card will make excellent digital recordings.

Record a Take
1. Click the Record button.

2l

Figure 6-28. Record Button

2. ‘Turning on the record button prepares the Time Line Cue List for recording.
Mow when you play the Time Line Cue List, and the Position flag passes the
Punch-In flag you will be recording on the selected track. The selected track is
now red. This indicates where the recording will take place.
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3. Click the Play-From-Start button.

i

Figura 6-29. Play-From-Start Button

ol

You now have 10 seconds to get ready to play, sing or talk your way through
your first take, When the Position flag passes the Punch-In flag, you're
recording,

5. When you're done with your performance, click the Stop button right away to
stop recording.

Figure 6-30. Stop Button

6. If you don't hit the stop button right away, the recording will continue until the
position lines passes the Punch Out flag. You will be recording and eating up
hard drive space even if you've stopped singing or playing.

Listen to the take by clicking the Record button to turn it off,

8. Then click the Play-From-Start button again to hear your performance. When it's

done, hit the Stop button.

Get Rid of a Bad Take, if Necessary

|. If you don't like your performance, click on the new sample to select it, Then
choose the Delete Selected command in the Entry menu. This will delete the
sample from your hard disk forever.

NOTE Delete erases the take from hard disk. There 1s no Undo for Delete.

2. Once the old take is gone, repeat the Record a Take section of this tutorial.

3. Record two more tracks,

4. Onece you have a take you like, repeat the above procedure for the second and
third tracks. Where it says Track 1, use Track 2 and then Track 3. Have fun
recording more parts to your masterpicee of experimentation,

Add a Solo

|, OK, vou now have three tracks recorded, you've saved your Cue List, and you're
ready to add a solo on your fourth track.

2. Move the Punch-1n and Punch-Out flags. Let's not add the solo to the beginning
of the piece. Instead let's add it a few measures in. You decide where the solo
should start, and move the Punch-In flag to that time. If the Punch-In flag is a
few seconds before the actual time you want to start the solo, that's fine.
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3. Then decide where the solo should end and move the Punch-Out flag to that
time. That way recording will stop when the Position flag passes the Punch-Out
flag, and you won't have to jump to hit the Stop button so quickly, You'll still
need to hit the Stop button to stop playback of the other tracks.

4. By the way, the Period key . on the numeric keypad will always stop the
Time Line Cue List. The keypad's Enter key will stop the Time Line Cue List if
it's playing, or start it from where the Position flag is if it's not playing.

Select the fourth track.
Add a Locate flag. There are 10 locate flags, tied to the function keys on your
kevboard. Lets add one now to mark a spot before the Punch-1n flag where we

want to start the Time Line Cue List Playing. That way vou'll have a few
measures to hear the other tracks before you start performing the solo,

7. Move the Red Position flag about five seconds before the Punch-In flag.

Now hold down the shift key and hit the Fl function key at the top of your
keyboard. You've just added a F1 locate flag right where the Red Position flag is.

9, Let's name the locate flag. Double click the F1 flag to open the Flag requester.
Type the word "Solo” in the comment field and hit the return key on your
keyboard. Now the word "Solo" is next to the Fl Locate flag on the Cue List.

Figure 6-31. Multitrack Cue List with F1 Flag Set

10. Typethe ({ key onthe numeric keypad so the Position flag jumps to the
Punch-In flag location. Now type the F1 key. The Position flag jumps back to the
F1 locate flag.

11. With the position flag at F1, record the solo by turning on the Record button, and
clicking the Play button. Do not use the Play-From-Start button this time.

Figure 6-32. Aecord and Play Button Selected
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12. When you click the Play button the Time Line Cue List plays from the Red
Position flag. Since we moved the Red Position flag to the FI Locate flag, the
Time Line Cue List plays from there.

13, When the Position flag passes the Punch-In flag, you're recording.

4. When it passes the Punch-Out flag, you're done, Click the stop button and
playback your performance. Don't forget to turn the Record button off before
you listen,

15. If you don't like your solo, delete it and do another one,

Punch In To Fix a Mistake

I. Lets pretend you made a mistake in the middle of Track 3. What we're going to
do is replace the middle of your take in track 3.

{ o]

Move the Punch-In and Punch-Out Nags. Just pick a short section that you can
replace by punching in and out. Move the Punch-In flag to where you wanl to
start recording, Then move the Punch-Out flag to where you want to stop
recording.

3. Add apother Locate flag. Add the F2 Locate flag about 5 seconds before the
Punch-In flag. Remember how you added the FI flag above? Just move the
Position flag to about 5 seconds before the Punch-In flag. Then hold down the
shift key and type the F2 function key on the top of your keyboard.

4. Just for fun, type Fl. Notice how the Time Line Cue List view and the Position
flag jump to the Fl Locate flag. Now type F2. The Time Line Cue List view and
the Position flag jump to the F2 Locate flag. Locate flags are very useful for
maoving around in a project, and it's much faster than shuttling tape!

5. Name the F2 Locate flag "Punch”. Double click the F2 Locate flag. and type
"Punch” into the Comment field of the Flag requester.

Select track 3 by clicking the Track Select button on the third track.
Turn on the Record button.

THINERT ==

Figure 6-33. Multitrack Cue List Ready for Punch In and Punch Out

8. Type the F2 key to set the Position flag on the F2 "Punch” locate flag.
9. Click the Play button (or hit the Enter key on the numeric keypad).
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10. You now have about 5 seconds to get ready to play, sing or talk your way
through the punch. When the Position flag passes the Punch-In flag, you're
recording.

I1. When it passes the Punch-Out flag, you're done recording.

12. Since you're adding a new Audio entry on top of an existing Audio entry, the
Overlap Contention requester will appear.

Figure 8-34. Overlap Contention

13. Click the stop button to stop the Time Line Cue List. You'll have to use the
mouse since the Cue List is not the active window.

14. Now choose how you want the new Audio entry to integrate with the existing
Audio entry by clicking either of the top buttons on the Overlap Contention
requester. (Left & Right Butt or Left & Right Crossfade)

If you want the punch to start immediately at the punch-in point and end
immediately at the punch-out point, with no overlap between the old Audio entry
and the new one, select Left & Right Butt. This is how punching works on many
tape decks.

If you want to cross fade from the old Audio entry to the new Audio entry at the
start of the punch, and then cross fade back from the new Audio entry to the old
one at the end of the punch, select Left & Right Cross Fade. Some lape decks
automatically create a slight cross fade at the edit points to smooth over the
punch.

15. In either case, no matter which you select, your choice is non-destructive, You
can change the edit type, cross fade length and curve later if you wish,

16. After you click a button on the Overlap Contention requester, you will see the
new Audio entry appear on the track. What has happened is that there are now
two copies of the old Audio entry, one before the punch and one after. Both have
been automatically cropped so that they are still playing your first performance
exactly where they should. The new Audio entry has been inserted between them
for a perfect punch.

17. Turn off the Record button and listen to your punch by typing the F2 key on your
keyboard and hitting the keypad’s Enter key,

18. If you don't like the performance, click the punch entry and use the Delete
Selected command in the Entry menu to delete it forever. Then use the Undo
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command in the Options menu to remove the second copy of the old entry and
stretch the first copy back to its full length. Then you can record the punch again.

Change Volumes and Pans

You can change volumes and pans for your multitrack masterpiece the same way you
did with the Audio entries in the first titorial. Or vou can use the Mixer to use a set
of sliders like a standard mixer.

For instructions on using the Mixer, see the Mixer Reference Section in Chapter 8,
Here are some important guidelines when using the Time Line Cue List and the
Mixer 1ogether;

m Activate Use Mixer Levels in the Options menu. If it is not activated the Cue
List will ignore the Mixer and use the Volumes and Pans set for each entry in
Audio Entry Parameters,

m  Set the output of each track to play on a specific channel like we did in this
tutorial. If each track is set to play on "Any" in the Audio Track Parameters
requester your tracks will jump around from channel to channel, and your Mixer
fader settings will not have an effect.

Slide a Track In Time (Using Group)

Here's a cool technigue. You can select all the Audio entries on a track and slide
them all earlier or later in time together. This can be very useful for moving a rhythm
track’s entries so that they're pushing the beat (slide them earlier) or so they have a
laid back feel (slide them later).

To try this out, and to learn how to select two tracks at once, lets move the entries on
tracks 3 and 4 together, You'll also learn how to group entries in this exercise.

1. Click the Track Selection button for track 3. (It's the one that turns into the
arrow, just right of the Track Name button.)

2. Hold down the shift key on your keyboard and click the Track Selection button
on track 4. The Track Selection buttons for both track 3 and track 4 should now
be selected (they should look like arrows). Let go of the shift key.

3, Click on any track in the Time Line Cue List, in a place where there are no
entries. This deselects all entries. Choose the Select All On Track{s) menu item
in the Entry menu. Now all the entries on tracks 3 and 4 are selected.

4. Choose the Group command in the Entry menu. Now when you move any of the
entries on tracks 3 or 4, all the entries will move together.

5. Move the entries. You guessed it. Drag any entry with the mouse and all the
entries in the group will follow,

If vou move them to the left, you'll cause them to push the beat. If you move
them to the right, you'll cause them to be laid back. Minor moves can make a big
difference. Major moves can really screw things up.
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Don't worry, play around with it, listen to how it sounds each time you drag
them, and then use Undo to get them back to where they were before. If you
move them more times than you have undo steps, just reload the Cue List from
your hard drive. (You have been saving frequently, haven't you?)

NOTE You can set the number of Undo steps in Cue List Preferences.

6. If you decide to move any one of the entries in the group by itself, click any
member of the group. Then use the Ungroup command in the Entry menu. Now
all the entries are individually movable again,

Edit a Sample

Studio 16 has a graphic Editor that gives you a powerful set of tools for editing your
samples. You can access the Editor directly from the Time Line Cue List.

1. Choose an entry in the Cue List by clicking the Audio entry you want to edit.

2. Use the Edit Selected command in the Entry menu to open an Editor. The sample
used by the Audio entry will load into the Editor. For more on using the Editor,
see its Reference Section in Chapter 8.

Keep in mind that if any other Audio entries in this or another Cue List use the same
sample, any changes you make to the sample in the Editor will show up in those
Audio entries also. In the case of this wtorial you don't have to worry about that, so
go ahead and experiment.

Mute and Solo a Track
You can use the Time Line Cue List's muting and soloing abilities to hear only the
tracks you want to hear.

1. Click the Sound buttons on track 1, track 2 and track 3. The Sound buttons are
the first buttons on the left for each track. When they're on they look like
speakers, Turn them off,

Figure 6-35. Multitrack Cue List with Track 4's Sound Button ON

2. Now Play the Time Line Cue List. Only track 4 will sound.

3. Now do the same thing with a Solo button. Tumn on all the Sound buttons again.
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4. Click the Solo button for track 4. When a Solo button is on it looks hike
headphones.

Figure 6-36. Multitrack Cue List with Track 4's Solo Button ON

5. MNow Play the Time Line Cue List. Only track 4 will sound, just like before. But
it's much easier to click a single Solo button than to turn off three Sound buttons,

6. Any time you have one or more Solo buttons on, the Sound buttons are
overridden and make no difference. Put another way, the Sound buttons only
have an effect when all Solo buttons are off.

7. 'This lets you set up the tracks you want to hear by selecting their Sound buttons,
but you can at any time listen to one track alone by clicking its Solo button.
Then, when you turn off the Sola button, you'll again hear just the tracks that
have their Sound buttons on.

8.  Solo buttons work with the shift key to let you solo several tracks at once.
9.  Click the Solo button on track 1.

10, Hold down the shift key on your keyboard and click the Solo button on track 2,
then let go of the shift key.

I1. Now Play the Time Line Cue List. Only track | and 2 will sound,

Ta turn off the Solo buttons on both tracks, turn the Solo button off on either track.

NOTE Muting and soloing are especially useful when you arrange similar entries on the
same tracks. For example, if you're working on a movie, put all the dialog for each
actor on their own tracks. Then you can solo one track to listen to one actor's lines,

Congratulations on completing the Multitrack Recording tutorial. Many of the
technigues you learned here will also apply to other kinds of projects.

Don't forget to save your masterpiece for posterity (or destroy it quickly before it has
a chance to reproduce, depending on how it sounds). Seriously, do keep it around for
further experimentation if you have the hard drive space to store the samples. One of
the best ways to learn the Time Line Cue List and other parts of Studio 16 is to
experiment, and your two tutorial projects are perfect for further experimentation.
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Troubleshooting

The following symptoms and their solutions are covered in this chapter.
Mot being able to hear input

Mot being able to hear playback

Can't select correct sampling rate in Editor

Card communication errors

Cue List won't trigger

Samples loosing sync in Cue List

Flashing screens, “overload errors™, or skipping, missing or repeating sound
Flickering screen on an A4000)

Full hard disk

Gain won't adjust

Graph doesn't match sound

Hard disk read/write errors

Installation problems

Modules don't open when selected

If the following recommendations do not solve your problem, call SunRize technical
support for more information.

Not Being Able to Hear Input

A. Problem Mixer level is set too low,
Solution Open the Mixer from the Applications Menu, and set the Input and
Output Channels' volume level o +00 dB.

B. Problem [Input cables are not connected correctly. (You know this is the problem
if you don't see Meter activity on the Input channels.)

Solution The audio In jack(s) must be connected with an RCA patch cable to the
line out of an audio source. Turn your audio source on.

C. Problem Gain chip is malfunctioning -- only a possibility on the AD1012.

Solution If you do not see activity on the input channel of the Mixer, and you're
sure your audio source is connected properly, the Digital Pot on the
Gain circuit may be bad. Especially if you can barely hear the playback,
or changing the gain level has no effect on the volume. Call SunRize
technical support if you suspect this problem.
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Not Being Able to Hear Playback

A. Problem Mixer level is set oo low,
Solution Open the Mixer from the Applications Menu, and set the Input and
Output Channels’ volume level to +NdB.

B. Problem Cutput cables are not connected commectly. (You know this is the
problem if you can see Meter activity on the Output channel. )

Solution The audio Out jack(s) must be connected with an RCA patch cable toa
mixer or the CD/AUX input of a receiver or amplifier. Set the receiver
to CD input and twrn it on, also check the speaker connections,

Can't Select Correct Sampling Rate in Editor

A. Problem The Set Sample Parms display will not show all the rates available by
dragoing the selector knob.

Solution Use the arrow buttons next to the slider or click in the slider to the left
or right of the knob to see all the available increments.

B. Problem Sample was recorded with a different type card.

Solution If the sample was recorded with the AD 1012 the same sampling rates
will not be available for the AD516, and vice versa, Use the resample
option in the Editor to change sampling rates or re-record the sample.

Card Communication Errors

A. Problem This very rare error usually means a hardware problem-either with yvour
Amiga or the card. Card communication errors include: Comm Error
#2, GetW Error, SendW Error, and DSP Init. Failed.

Solution Try resetting your Amiga, or turning it off and then back on. If this
doesn't help, try re-seating the card in another expansion slot. If this still
doesn't solve the problem, call SunRize techmeal support for more
information.

Cue List Won't Trigger

A. Problem Most often, the Cue List is just turned OFF,

Solution For the Cue List to listen for time code and preload samples, it must be
turned on. Simply click the ON/OFF button at the top left of the
window to turn Cue List ON.
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Solution

C. Problem
Solution

D. Problem

Solution

E. Problem
Solution
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Samples are not where the Cue List thinks they are.

When a sample is entered in the Cue List, a box with the sample's name
inside will be created on one of the Cue List tracks. The Cue List knows
the complete path to the sample: the directory and file name. If you later
delete, move or rename the sample while the Cue List is closed, the Cue
List won't be able to find the sample. It will display an empty box in the
track where the sample used to be.

You need to tell the Cue List where to find the sample. This can be
done as follows: Click on the empty sample box to open the Audio -
Event Parameters. Next select a sample from Sample List, and drag it
aver to the "Sample” field. Drop the sample in to assign the sample to
the Cue List evenL.

The SMPTE source may not be set correctly.

If you are using an external SMPTE source, like a VTR, close the
internal SMPTE generator. Also check the SMPTE source in
Preferences. It should be set to AD516#1 or AD1012#1. If you are
triggering from the internal SMPTE generator, set the source to
Internal.

Too many errors in the incoming SMPTE time code. (Studio 16's
internal generator will not cause this problem.)

Bad time code can be caused by a bad cable, tape drop out, bleed
through from audio tracks, or bad levels on the SMPTE track.

SMPTE errors can be verified by opening SMPTE monitor and
watching for flashing squares in the upper left corner. These may
signify time code errors. If SMPTE errors are causing the Cue List to
intermittently halt audio playback, SMPTE error detection in the Cue
List can be turned off with the "Ignore SMPTE Errors” in the Options
menu. See the Reference Section on Cue List for details.

Not enough preload time for samples.

Move the position flag farther from the first sample to give the sample
time to be preloaded. The flag should be between 5 and 15 seconds
before the first sample.

Samples Loosing Sync In Cue List

A. Problem Samples have different sampling rates.

Solution

Multiple samples that playback simultaneously must have the same
sampling rate. You can alter the sampling rate of a sample in the Editor,
From the Effects Menu select the Resample option.
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B. Problem SMPTE lock is off.
Solution Open Preferences window and activate Lock On in the SMPTE section.

Flashing Screens, Overload Errors, or Skipping,
Missing or Repeating Sound

Playback stutter or skipping occurs when your Amiga can't access the hard disk's data
fast enough, or doesn't have enough CPU time to service the sounds that are currently
being played or recorded. When Studio 16 detects this problem, it will flash your
screen or give an “overload” error message. The following are common causes and
sclutions for “skipping” audio. Although the causes are listed individually,
“skipping” is often caused by multiple problems compounding one another rather
than just one cause.

A. Problem Your DMA mask setting on your hard disk may be incorrect. If your
hard disk is abnormally slow or has an inability to playback at least 3 or
4 tracks, you may need to change the DMA mask for your hard disk.

1. Solution  If you have a CBM controller, use 'HDToolBox' in your Tools' drawer.
Once HDToolBox is running, select "Partition Drive” then "Advanced
Options”. Then select your partition from the "bar”, and select "Change
file system for partition”. Make a note of the original MASK then
change the MASK to: Ox7FFFFFFE. save the changes, select "OK",
"OK", "Save changes to drive”. You will need to re-boot your Amiga
for the changes to take effect.

2. Solution  If you are using a GVP hard disk controller, use "FastPrep” in manual
mode, instead of HDToolBox. See your GVP manual for more
information. The correct DMA MASK for GVP controllers varies--call
GVP. However, on newer contrallers the above mask should work.

B. Problem You are not working with WorkBench version 3.1.

Solution Keep an eve out for WorkBench release 3.1 from Commodore. This
new version of the Amiga operating system supports much faster seeks
than previous versions. This greatly improves the speed of Studio 16
disk operations such as playing ranges in the editor or playing regions
in the cue list. To take advantage of this speed increase, you must install
WorkBench 3.1, then increase the FastFileSystem block size using
HDToolBox/Partition/AdvancedOptions. The larger the block size, the
quicker the seeks.

C. Problem Your Amiga doesn't have enough CPU time to complete all the tasks
required by Studio 16 to play the requested sounds.

I. Solution Turn off CPU intensive Studio 16 modules, such as Meters, and
SMPTE Monitor. Substitte Tiny Mixer instead of Mixer.
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Upgrade your Amiga to a faster processor. If you have an Amiga 2000,
install a 68030 accelerator card with fast RAM, For example, a stock
A2000HD with the AD516 doesn't have enough CPU power to play 8
tracks at a 44K sampling rate. It can handle three or four tracks at 44K
or six tracks at lower rates, such as 15K. (The AD1012 will play 2
tracks without an accelerator.)

Using Cue List, combine samples to be played back simultaneously into
one sample. See Cue List Reference Section on ping-ponging for more
details.

Minimize the length or number of crossfades in your Cue List.

Upgrade your hard disk controller to a mare efficient controller. The
amount of bus resources required to transfer the same data to or from
your hard disk can vary considerably between controller manufacturers.
By switching to a more efficient hard disk controller, you leave more
time for the CPU to work. Probably the most efficient hard disk
controller currently available for Amiga 4000s is the A4091 or the
FastLane. These are Zorro 111 controllers that write data at a high speed
and 32 bits at a time. This results in a significant performance increase.

Upgrade from an AD1012 to an ADS516. SunRize's 16 bit card includes
extra circuitry that makes it more efficient at transferring data than the
AD1012.

The hard disk is too slow for the number of samples playing.

Reduce the number of simultaneously playing samples. If you can
reduce the number of tracks playing simultaneously, you will reduce the
data transfer rate and fix the problem.

Lower the Sampling Rate. If you lower your sampling rate, you will
reduce the amount of data that must be transferred and improve over all
system performance.

Increase the Channel Buffer size in Preferences. By increasing the
playback buffer sizes, you will eliminate skipping in many cases.
However, the improvement will be less as you keep increasing the
huffer sizes. That is, increasing the Channel Buffers from 256K to
512K will have much more of an improvement that increasing the
buffers from 512K to 1024K. Keep in mind that one channel buffer is
allocated for each playing sample, and each track in the Cue List. Make
sure that you have enough system RAM to cover your requested
buffers. For example, if you play four simultaneous tracks with the
channel buffer set to 4096K, you will need 16,384K (or 16 MB) of free
RAM just for buffers. For more about RAM requirements, see the
Preferences Reference Section.
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4. Solution  Buy a faster hard disk, or a better hard disk controller.

E. Problem The hard disk is fragmented.

Solution Fragmented hard disks are discussed in Chapter 4. The solution is to
buy a program that will de-fragment your hard disk. Talk to your Amiga
dealer for a recommendation.

F. Problem The 'Use Extended Memory' option in the Preference Menu is set
incorrectly.

Solution Try the 'Use Extended Memory' option both on and off to determine
which way your system works best. However, in general terms select
this button if your hard disk controller and 030/040 card are on the
same pe board. (e.g. You have a stock A3000, A4000, or you have a
GVP 030 card with built in hard disk controller.)

Do NOT select this button if you have an 030 or 040, but yvour hard
disk 1s on a stand alone Autoconfig card, {e.g. You have a GVP series I1
DMA hard disk controller and a PP&S 040 card with 32 bit RAM.) See
the Preference Reference Section for details,

G. Problem There are too many or too large of a non-destructive edit in a sample.

Solution Select Make Permanent from the Editor Menu. When Studio 16 is
playing a sample and encounters a non-destructive edit, it must seck
over the edit. For large edits, this can take a long time and causes
skipping. This problem can also be largely eliminated by installing
WorkBench 3.1 and increasing the block size on your audio partitions.

Flickering Screen On an A4000

A. Problem WorkBench Preferences are set incorrectly.

Solution Set the 'Avoid Flicker' and 'Mode Promotion' flags in the 'IControl
Preferences’ program. The program is found in the WorkBench
Preferences drawer.

Full Hard Disk

A. Problem Running out of hard disk space is a problem for everyone eventually,
some sooner than others,
1. Solution Delete unnecessary data,

2, Solution  Make non-destructive edits permanent on samples that you have
performed non-destructive cuts, Note that Make Permanent temporarily
requires disk space equal to the file being made permanent. And, do
NOT make permanent samples with non-destructive paste-inserts,
unless you're prepared to tie up more disk space,
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3. Solution  Buy another or a larger hard disk.

4. Solution Reduce your sampling rate or resample your audio with a new rate in
the Editor.

LR

Solution Record or Convert samples that don't require a high SNR, like
explosions, to an 8 bit file ( [FF-85V2X).

6. Solution  Archive your samples on a tape backup or an alternate backup device
and then delete them from the hard disk,

Gain Won't Adjust

A, Problem Gain chip is malfunctioning on AD1012.

Solution ‘The Digital Pot in the input gain circuit may be bad. Suspect this if you
can barely hear the input source or changing the gain level has no effect
on the input volume. Call SunRize technical support if you suspect this
problem.

Graph Does Not Match Sound

A. Problem Graph file has been corrupted.
Solution Delete the sample's .graph file from the audio directory that contains
the problem sample. You can delete files with WorkBench or Shell.

Hard Disk Read/Write Errors

Hard drives aren't fool proof, and it is inevitable that you will at some point
encounter a disk error, This can manifest itself as a "Read" or "Write" error. Or,
occasionally as a "Can't Validate Drive” or "Checksum" error. Sometimes clicking
“retry” or "cancel” on the DOS requester presenting the error will cause the error to
disappear. However, if this happens you should start to worry because the error will
probably reappear later, and can mean a failing hard drive.

Of course your best advice is to backup your hard drives. They can be backed up toa
SCSI tape drive, a SCSI optical drive, or 1o and audio DAT tape drive with SunRize's
DD524 interface. However, due to the time and expense involved, many people don't
bother. Just be warned that a hard disk "crash” 1s not just a possibility, it is very
likely that it will happen to you eventually.

A. Problem The hard disk gets intermittent read/write errors.
|. Solution Upgrade your hard drive controller's ROMs to the latest version--call
your hard drive controller manufacture.

2. Solution  Your hard drive could be failing. Replace it.
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B. Problem The hard disk has crashed,

I. Solution  Take your Amiga to your Amiga dealer. Their service department
should be experienced in attempting to restore data from corrupt hard
drives.

2. Solution  Use a hard disk utility program to try and fix the errors on the hard disk.
This may or may not work, but if you have any amount of time invested
in the data on the bad partition, it's worth a try.

3, Solution  Use a program like "DiskSalv” to recover the files from the corrupt
partition. "DiskSalv" is a public domain program that will copy files off
a partition with errors onto a good partition. Once the operation is
completed, you can re-format the bad partition and copy the files back
over, However, DiskSalv requires a good partition or drive with enough
free space to hold the copied files,

4. Solution Re-format the partition that the error occurred on. This unfortunately
deletes all data on the partition being formatted. You can do this with
the WorkBench "Initialize” option. Hopefully, you have a backup. If
you do, restore the backup afier formatting the partition.

5. Solution  If you don't have a backup, you can attempt to copy the data from the
bad partition to another partition using WorkBench, DiskMaster/Opus,
aor the Shell copy command BEFORE re-formatting the bad partition.
This will probably recover some of the files, if not all. However, it does
require a good partition or drive with enough free space to hold the
copied files.

Installation Problems

A. Problem Does not recognize the AD516 or AD1012 audio card,
Solution Re-seat the audio card in the same slot or a different slot. Refer to
Chapter 2 - Installation for instructions on installing the hardware,

B. Problem Installation utility was aborted
Solution Begin the installation utility again, or inspect the Studio 16 Installation
log file for problems.
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Some Modules Don't Open When Selected

A. Problem This is usually caused by a missing system library in the libs: directory.

Solution

User's Manual

If a Studio 16 library is missing, you will get a warning (e.g. "Can't
Open Studio.library”). However, if certain operating system libraries
are missing (e.g. a math library) programs will simply not run,

Copy the libs directory from your master WorkBench floppy into your
libs: directory on your hard disk. Insert you WorkBench Master disk
into DF0: and from shell, type:

copy DF0:1libs libs:
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Module Reference

Sample List
SMPTE Generator
SMPTE Monitor
Shell Commands
Time

Tiny Mixer

s ADS516Handler

= ADI1012Handler
®  AREXX Commands
m  Cue List

= Ediwor

® Instance

m Message Monitor
m Meters

m Mixer

m  Module List

m Preferences

s (uit

® Recorder

L

]

=

L}

n

L]

[ ]

Utility
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AD516Handler

Class: Device Driver

Description: The ADS516Handler is responsible for handling data transter
to and from the AD3516 card. There should be one
ADS16Handler resident for each card you have installed in
your Amiga. In general, you don't need to access the
AD516Handler.

Procedures
Check Hardware Revision Numbers & Statistics
1. Select Instance from the Applications Menu (* I).

NOTE You will need to move Instance from the Dormant drawer to the Applications drawer
hefore for it to be available in Applications Menu.

3 Select Show Utilities from the Instance Menu. The Instance List will update
showing all the drivers and utility modules.

3. Double click the AD516Handler entry in the Instance List. An ADS16Handler
display window will open with various version numbers and the amount of statie
RAM installed in your AD316 card.

Figure B-1. Typical AD516 Handler
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AD1012Handler

Class: Device Driver

Description: The AD1012Handler is responsible for handling data transfer
to and from the AD1012 card. There should be one
AD1012Handler resident for each card you have installed in
your Amiga. Installing more than one ADI1012 15 not
recommended.

Procedures
Check Hardware Revision Numbers & Statistics
|. Select Instance from the Applications Menu (* I).

NOTE You will need to move Instance from the Dormant drawer to the Applications drawer
before for it to be available in Applications Menu.

7 Select Show Utilities from the Instance Menu. The Instance List will update
showing all the drivers and utility modules.

3. Double click the AD1012Handler entry in the Instance List. An
AD1012Handler display window will open with various version numbers and the
amount of static RAM installed in your AD1012 card.
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AREXX Commands

The following AREXX commands are available in Studio 16, Along with each
command, a description and an example are provided. Parameters and results are also
provided if applicable. In addition, a list of possible error codes and a list of
constants are included. The Studio 16 AREXX message port is called
studiols. 1. For more information, view the file S16Examp.rx for a working
example program.

§16ChanVol - Changing Channel Volume

§16C]ose - Close a Previously Opened Sample

516Exit - Exit Studio 16 Program

516Filter - Changing Filter Cutoff

516Gain - Changing Input Gain

$160pen - Open a Sample File

$160penRecord - Open a Sample for Record
$160penWithAutoClose - Open a Sample With Automated Closing
S16Pan - Changing a Channel Pan

516Play - Play Sample

$16QuerySmpteTime - Current SMPTE Time

§16Rate - Changing Sampling Rate

516SmpteSet - Set internal SM PTE Tme

$16SmpteStart - Start SMPTE Tme

516SmpteStop - Stop SMPTE Time

516StopAllPlayback - Stop All Playback

516ToBack - Studio Screen To Back

S16ToFront - Studio Screen To Front

516Trigger - Begin the IO of a Previously Opened Sample
§16Version - Studio 16/AREXX Version

S16WaitGPI - Studio Wait GPI

§16WaitTimeCode - Wait For Time Code

S16ChanVol

Description: This function alters the volume of a sample that is already
playing back. Notice that (0 = Off, 100 = 0dBs, 106 = 6dBs,
94 = -6dBs, and param - 100 = Actual dBs.
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Parameters:

Results:

Example:

Type Of Channel (E.g., 'CHAN_INPUT 'CHAN_PLAY" or
'CHAN_OUTPUT)

Channel Number

Channel Value (dBs) - 100

Actual Volume (dBs)

SléChanVel CHAN OUTPUT 1 100

say'Actual Channel Volume: ' result ‘dBs’
El16ChanVol CHARMN PI 106 !  BdBs
5l16ChanVol 1 | 0OdeE=
SlaChan | -6dBs
516 | =-12dBs
5l6 0o | -00dBs

S16Close

Description:

Parameters:
Results:

Example:

This command closes a previously opened sample. If yvou are
closing a playback sample, S16Close will wait for the sample
to finish playing back. If you are closing a record sample then
the close will stop the record and close the file.

One 'Key' value (supplied by an Open)

None

S5160pen 'Audio:Sample
key=result

Sl6Trigger key
SEleClo=se key

S16EXxit

Description:
Parameters:
Results:

Example:

Always use this as the last Swudio 16 AREXX command.
None

MNone

S16Filter

Description:

This command alters the filter cutoff value of cards with this
capability (currently just the AD1012).
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Parameters:
Results:

Example 1:

Example 2:

ARREX Commands Chapter 8

Desired Filter Cutoff (Hz)

Actual Filter Cutoff (Hz)

result 'Hz

S16Gain

Description:

Parameters:
Results:

Example:

This command alters a cards input gain, provided the card
supports this kind of parameter. Notice that 106 = 6dB, 100 =
0dB and 75 = -25dB. See the S16ChanVol example for
details,

Desired Gain (dBs)

Actual Gain String (dBs)

)
=
Ty

6Gain 10

ay 'Actua

oo

Gain: ' result 'dBs'

7]

S160pen

Description:

Parameters:
Results:

Example:

This command opens a sample for playback, and preloads the
sample. A sample must still be triggered to start playback,
and closed.

Complete Sample FileName String.

key - a unigue value used to identify the sample
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S160penRecord

Description: This command opens a sample for recording. The samples
must then be triggered, to start the record, and then closed, to
stop the recording.

Parameters: Complete Sample FileName String.

Results: key - a unique value used to identify the sample

Example: Sl60penRecord 'Ram:Number9
key=result

Trigger key

b & e
WaltGPI

oh &h h

W
o
I

e By

]
Q
1]

S160penWithAutoClose

Description: This command is used for playing back samples without
having to close them, this is done automatically when the
sample ends. You still must trigger the sample,

Parameters: Complete Sample FileName String.

Results: key - a unique value used to identify the sample

Example: S160penWithAutoClose 'Audio:Sample’
key=result

S16Pan

Description: This function alters the pan of a sample that is already playing
back. Notice that 0 = Pan full Left, 100 = Center and 200 =
Pan full Right.

Parameters: Type Of Channel (E.g., 'CHAN_INPUT 'CHAN_PLAY' or
'CHAN_OUTPUT
Channel Number
Desired Pan (dBs)

Results: Actual Pan (dBs)
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Example:

S16Play 7eLes

Description: A simple way of playing back audio from a Studio 16 card
Mo opens, closes or triggers are needed. Notice that this,
command returns after the sampléhs ﬁJlnmlude"rG' f

7 4
Parameters: [L'Q Complete Sample Path string

Results: MNone y
A%,

Example: 516P1 ayl toddaudio:11_Intre
516 Plry SR0O’ ﬁuHm:wuu L aul}y B g

S16QuerySmpteTime

Description: This command returns the current SMPTE time in string
format.

Parameters: None

Results: TimeCodeString

Example: Sl6QuerySmpteTime
say 'Current Smpte Time is: ' result

S16SmpteStart

Description: This command starts the internal timecode generator.
Parameters: None

Results: None

Example: S16SmpteStart
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S16SmpteStop

Description: This command stops internal timecode generation, This
command does not effect external timecode.

Parameter None
Results: Naone
Example: 5l165mpteStop

S16SmpteSet

Description: This command sets the internal SMPTE time.
Parameters : SMPTE Timecode Siring

Resulis: None

Example: 02:30:00

S16Rate

Description: This command alters the sampling rate. [t should be used
before you record a sample, since you are not assured of a
particular startup sampling rate.

Parameters: Desired Sampling Rate (samp/sec)
Results: Actual Rate (samp/fsec)
Example 1: S16Rate 44100
say 'Actual Rate: ' result
'samps/sec’
Example 2: (try all rates)
rate=100000
Sl1E6Rate rate
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S16StopAllPlayback

Description:

Parameters:
Results:

Example:

This command stops all audio Playback. S16Closes are still
required for all samples that are S160pened.

None
Mone

c16

£

topAllPlayback

S16ToBack

Description:

Parameters:
Results:

Example:

This command places the Studio 16 screen behind all others.
It performs the same function as the screen's depth gadget.

None
Mone

SléToBack

S16ToFront

Description:

Parameters:
Results:

Example:

This command places the Studio 16 screen on top of all
others. It performs the same function as the screen's depth

gadget.
None
MNone

816ToFront

S16Trigger

Description:

Parameters:

Results:

This command starts a sample's record or playback. Multiple
'Keys' may be passed to start and stop stereo sample playback
and record. Up to eight keys may be passed at one time.

One or more "Key' values (supplied by an Open)

Mone
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Example: SléOpenWithiuteClose 'Audic:Sample_Left'
keyvli=result
Sle0penWit

Sl6Trigger keyl key2

S16Version

Description: This command is used to determine the version of Studio 16
and the version of the Swdio 16 AREXX port.

Parameters: None

Results: Version String 'Studio 16 Vers XXX, AREXX Port Vers
AXX

Example: options results
Sl6Version
say 'You are using result

S16WaitGPI

Description: This command waits until a GPI Trigger occurs. GP1 is the
Joystick button (as used by the Video Toaster),

Parameters: MNane
Results: None
Example: S1lEWaitGPI
ElePlay 'Audio:Sample’

S16WaitTimeCode

Description: This command waits for a particular SMPTE Time Code.
When the time is reached or exceeded, execution continues
on the next AREXX command

Parameters: TimeCode String

Results: 0 1f time found
6 (RX_ER_TIME_CODE_PAST) if time code past

Example:
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ARREX Errors Codes

6

I
12
13
14
21
22

23

Time Code Past
Unsupperted Parameter
Could not Allocate Key
Could not Find Sample
Invalid Parameter

No Handler

Invalid Channel Type
Could not Open Sample

ARREX Constants

2
3

CHAN_INPUT
CHAN_PLAY
CHAN_OUTPUT

Chapter 8
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Cue List

Keyhoard Shortcut:
Class:

Description:

b B
Application Module

The Time Line Cue List is a SMPTE synchronizable audio
recorder and time line editor that lets you visually work with
Cue Lists, It lets you easily import, create and visually
arrange time based entries in your Cue Lists. Entry types
currently supported are Audio Entries and AREXX Entries.

The Time Line combines standard tape deck style transport
controls with a multiple track visual interface. The transport
controls let you record and play Audio Entries. The
multitrack interface lets you arrange your samples with much
finer control than allowed by tape decks. AREXX Entries let
you control other programs directly from the time line.

You can easily move Entries in time or from track to track
using your mouse. By simply dragging one Audio Entry over
another you can cross fade between samples. Choose between
fixed or variable overlap intervals, with your choice of cross
fade curves.

You can visually crop Audio Entries and adjust fade-in and
fade-out times with the mouse. Movable flags let you control
automated punch-in and punch-out recording and set
commented auto-locate points.

You can synchronize the Time Line to SM PTE time code for
accurate music production, audio-for-video, and motion
picture soundtrack work.

The Time Line replaces both the Cue List and Transport
modules used by previous versions of Studio 16.
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Figure 8-2. Time Line Cue List

Cue List Overview
What Is the Time Line?
The Time Line is a where you work on Cue Lists in a visual way. The Time Line is

not itself a Cue List.

Think of the Time Line as a window on time. You can set its starting time and ending
time boundaries to choose what range of time it can view. Within that range of time
you can zoom in and out, and when vou're zoomed in you can scroll forward and
backward in time.

What Is a Cue List?

A Cue List is a file that helds information about Audio and AREXX Entries, For
Audio Entries, a Cue List file stores when they start and end, the location of the
samples {but not the sample data), the tracks, cross fades, volume settings, pan
settings, and more. For AREXX Entries a Cue List stores the tracks, commands and
start times for each entry.

A Cue List file also stores Time Line settings for start time, end time, and zoom
amount,

Matching the Time Line to a Cue List

Usually you'll set your Time Line so it shows all the entries in a Cue List, There are
two ways to do this:

B aulomatic

m  manual

Automatically Size Time Line
The Auto Size Cue List command lets you quickly adjust the boundaries of the Time
Line to fit the entries in any Cue List.

. Opena Cue List.
2. Select the Auto Size Cue List command in the Options menu, (A-A).

Studio 16



User's Manual

Cue List cChapters

MNow the Time Line is automatically resized to start thirty seconds before the first
entry begins, and end thirty seconds afier the last entry ends.

3. Save the Cue List with the Save command in the Cue List menu and the Time
Line's boundaries will be saved with the Cue List. The Time Line will then be
properly sized the next time you open that Cue List,

Manually Size Time Line
To manually adjust the start and end time boundaries of the Time Line to include all
the entries in a Cue List:

1. OpenaCue List

[ ]

Choose the Cue List Preferences command in the Options menu,

3. Inthe Display Boundaries area in Cue List Preferences, type a time in the Start
Time field that is before the first entry's start time, and hit the return key,

4. Type atime in the End Time field that is after the last entry, and hit the return

key.

This will set the Time Line's Display Boundaries to include all the entries in the

Cue List. You can also use this method to make the Time Line's Boundaries

larger than the current Cue List needs so you have room to add new entries.

NOTE

The Start Time and End Time fields will accept the type of time code selected in the
Time Options section of the same requester.

5. Save the Cue List with the Save command in the Cue List menu and the Time
Line's boundaries will be saved with the Cue List. The Time Line will then be
properly sized the next time you open that Cue List,

Using Zoom With the Time Line

Once you've set the Time Line's boundaries, the Zoom field and buttons in the lower
left corner of the time line let you zoom in and out.

Zoom Field
To use the Zoom field, type the amount of time you want to see at one time.,

Zoom Buttons

To use the Zoom buttons, click the Up Arrow button to zoom out and the Down
Arrow button to zoom in. You can also see more or less of the Time Line's view by
using the sizing gadget of the window to make the window larger or smaller,

As you zoom in the smallest unit you'll actually see depends on the time option
you've chosen in Cue List Preferences. For example, if you've chosen SMPTE in the
Time Options, the smallest displayed unit 1s 1/30th of a second (1 video frame). If
you choose the SMPTE Plus option the smallest unit you'll see is 1/100th of a frame.
The displayed unit is rounded up from the actual resolution of Studio 16.
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Resolution refers to the degree of detail that can be seen and edited. Studio 16 has an
actual resolution of a single sample for Audio tracks, which at a sampling rate of
48KHz is 1/48,000th of a second. The resolution is even greater for AREXX tracks.

Scrolling With the Time Line

When you're zoomed in on the Time Line’s view, you can use the horizontal scroll
bar at the bottom of the time line to scroll forward or backward in time between the
start time and end time boundaries. To move backward drag the scroll bar to the left.
To move forward drag the scroll bar to the right. If the Time Line is zoomed out so
that the scroll bar is a solid bar, you are seeing the entire view of the Time Line and
the horizontal scroll bar will not have an effect,

When there are more tracks in the window than vou can see in the Time Line
window, the scroll bar on the right side of the Time Line lets you scroll up and down
through a Cue List's tracks.

Procedures
Adding an Existing Sample to the Cue List

There are two ways to add recorded samples to the current Cue List:
®  Drag & drop them into the Time Line from Sample List
®  Use the Timecode Add command in the Entry menu,

Timecode Add allows you create a blank Audio Entry on the fly that you can later
change to trigger an existing sample.

Drag & Drop From Sample List

The most direct way to add a new sample to the Time Line is to drag it from Sample
List with the mouse and drop it onto an audio track on the Time Line. The Sample
will appear as an Audio Entry on the audio track where you dropped it. If there are
no Audio tracks in the Time Line, you can create one using the Add Track command
in the Track menu. You can't drop a sample onto an AREXX track,

Drag Mode Buttons

The Drag Mode setting for the Time Line will also affect where the new Audio entry
will start on the Time Line when you drag a sample from the Sample List. You can
set the Drag Mode using the Drag Mode buttons at the top of the Time Line window.
You can select only one at a time.

Figure 8-3. Drag Mode Buttons
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From left to right, the Drag Mode buttons are:
®  Any Direction
B Lock-To-Grid
® Vertical Only

If you are in Lock-To-Grid mode when you drag a sample from Sample List onto an
Audio track in the Time Line, the Audio Entry will snap to the nearest grid line.

If you are in Any Direction or Vertical Only mode when you drag a sample from the
Sample List onto an Audio track in the Time Line, the Audio Entry will start at the
position of vour mouse pointer.

The state of the Keep Original Time menu in Options will determine where the
dropped sample is placed on the track. If Keep Original Time is activated, and the
sample was recorded when SMPTE was running, the sample will drop to the
recorded SMPTE spot. If Keep Original Time is not active, the sample will drop
under your cursor.

An example of Drag & Drop with Keep Original Time

1. Record samples from a video tape while feeding time code to your SunRize
card's time code reader

2. Each sample you record will remember where it starts in relation to the video.

3.  Activate Keep Original Time,

4, Drag the samples from the Sample List and drop them onto an Audio track in the
Time Line.

The samples will automatically appear in time where they should in relation to
the video. If you then turn ON the Time Line and play the video with its time
code fed to your SunRize card's SMPTE reader input, the Audio Entries will stay
in sync with the video.

NOTE

Depending on how the start and end time boundaries are set in the Time Line, you
may not be able to see the sample you just dropped onto a Time Line audio track if
you're in Keep Original Time mode. If that happens, use the Auto Size Cue List
command in the Options menu to change the boundaries of the Time Line to include
the new Audio Entry.

Using the Timecode Add Command

The Timecode Add command lets you add blank entries to the time line on the fly.
This is great for dropping in sound effects while you watch the picture.

Use the Timecode Add command
|, Connect the time code output from your video deck to the time code input jack
on your AD516 or AD1012.
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3
s

Select a Time Line track onto which to create a blank Audio Entry, by clicking
the arrow buttonn.

3. Turn the Cue List ON,

4. Start the video, and use the Timecode Add command's A-T shortcut to mark
where sound effects should go while you watch the picture. Each time you type
A-T, you will insert a blank Audio Entry onto the track.

NOTE Blank Audio Entries are represented on the Time Line as a different colored
rectangle than normal Audio Entries, If you are using the Default color scheme,
blank entries are blue.

5. After you've added blank Audio Entries, add samples to them by double clicking
the blank entry to bring up Audio Event Parameters.

6. Drag a sample from the Sample List, and drop it into the Sample field at the top
of the requester.

7. Close the requester.

Now the sample you dragged from the Sample List has replaced the blank Audio
Entry. The Audio Entry still starts where you added it using the Timecode Add
command above, so your sound effect starts right where you wanted it 1o, Of course if
your reaction time was off you can just move the sound effect by dragging it along
the Time Line.

Recording a New Audio Entry

Here are the typical steps you can use 1o record a sample from the Time Line. The

setups depend on the source of your audio signal,

®  Fora video tape deck, audio tape deck, CD player, or synthesizer - connect their
outputs directly to the AD516 or AD102's inputs,

®  For microphones, or electric guitars - connect them to an external mixer, and
then connect the output of the mixer to the AD516 or ADI012,

®  For the output of the Time Line itself (mix downs), don't connect anything to
your AD516's inputs,

Record a Sample From the Time Line

1. Select the record path in the Sample List (the & box). The record path is where
the new samples you record are stored. If you don't have the correct path
showing in Sample List, add the path and then select it as the record path.

2. Select New from the Cue List Menu to open an empty Cue List

3.  Select a Time Line track onto which to record. If you want to record a
monophonic source, click the track select button on one track. To record a stereo
source, shift-click the track select buttons on two audio tracks.

4. Select the input source you want for each track. To do so, click the track name
button and select the input source using the Record drop list in Audio Track
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Parameters. For each track, you can choose an input on either the AD516 or
ADI1012 installed in your system.

Y ou can also choose to record the left or right output of the Time Line itself.
This is a very handy way to bounce multiple tracks together into either a single
monophonic sample or a stereo mix, using several tracks, It's also an easy way 1o
combine the samples that overlap during a real time cross fade into a single
sample.

5. While you're in Audio Track Parameters change the name of the track to reflect
the recording you're about to make. You can do this by typing a new name in the
Name field at the top of the requester, and hitting the return key on your
keyboard.

6. Name the new sample you're about to record, by typing a new name in the
Record field below the Record drop list. The default sample name is "Untitled™.

7. If you are going to record the output of the Time Line, mute (no speaker) the
playback of any tracks you don't wanl to record. And, turn on the Sound button
(speaker showing) to enable the playback of a tracks you do want 1o mix down.

8. Drag the Punch-In flag to where you want the recording to start.

9, Drag the Position flag five seconds or so before the punch-in flag.

10. Drag the Punch-Out flag to where you want the recording to stop.

11. Click the Record button to enable recording.

12. When you're ready to record, click the Play button,

13. The time line will play from the Position flag. It will automatically begin
recording at the Punch-In flag, and it will stop recording at the Punch-Out flag or
when you click the Stop button.

By leaving the punch-in flag at the same location, you can easily record a series
of samples that start at the same time. Record each sample on a different track
and the time line becomes a very {lexible digital multitrack recorder.

Grouping/Ungrouping Entries

The Time Line has a powerful grouping feature that works much like the object
grouping in a drawing program.

To group entries together:

1. Shift-click each entry

2. Select the Group command from the Entry menu.

When entries are grouped, if you select one entry you will select all entries in the
group. If you move one entry you will move all the entries in the group, which is

great for keeping entries in sync with each other. If you remove one eniry you will
remove all entries in the group.
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If you did something to a whole group that you meant to do to one entry, simply:

. Use the Undo Edit (A-Z) to restore where vou were.

ed

Select Ungroup to separate all the entries in the group.

Lk

Select and change individual entries again.

To remove all entries from all groups in the Cue List, use the Ungroup All command
in the entry menu,

Cropping an Entry
The Time Line makes it very easy to non-destructively crop the beginning or end of
any sample.

. Click an Audio entry to select it. You'll see the entry change color, and you'll see
four small boxes appear. The two boxes on each end of the entry (not the ones
on the top corners) are called the Crop Gadgets,

2. Drag the Crop gadget on the left edge of the entry to crop the beginning of the
sample,

3. Drag the Crop gadget on the right edge of the entry to crop the end of a sample,

You can not use Crop to extend a sample beyond the length of the original entry. You
can only shorten the sample by cropping off the beginning or end, or restoring what
you've cropped. Cropping can be very useful for removing unwanted noise at the
beginning or end of a sample.

Cropping in the Time Line is non-destructive. It does nothing to the original sample
data on your hard drive, so you can experiment and make changes as often as you
want. If you change your mind, simply move the Crop gadgets again until you're
satisfied with the result.

Fading an Entry
The Time Line makes it very easy to non-destructively fade the beginning or end of
any sample.

I, Click an Audio entry to select it. You'll see the entry change color, and you'll see
four small boxes appear. The two boxes on the top corners are called the Fade
Gadgets,

2. Fade in the beginning of the sample by dragging the fade gadget on the left edge
of the entry.

3. Fade out the end of a sample by dragging the Fade gadget on the right edge of
the entry.

You can only drag a Fade gadget inward, toward the entry. When you do so you will
be adjusting the fade in time for the beginning or the fade out time for the end.
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Fading done in the Time Line is non-destructive, It does nothing to the original
sample data on your hard drive, so you can experiment and make changes as often as
you want. If you change your mind, simply move the Fade gadgets again until you're
satisfied with the result.

Cross Fading Entries

Cross fading entries is very simple on the Time Line. All you have to do is slide one
sample over into another on the same Audio track. The cross fading is automatic and
non-destructive. If you don't like the cross fade, simply move either sample again
until you're satisfied with the result.

Looping Entries

Loops are processed by duplicating a sample and repeating it many times. By using
the limited cross fade edit mode, you can get a seamless looping action out of any
sample.

Loop an Entry
1. Click the entry to be looped.

2. Select the limited crossfade edit mode. If required, edit the crossfade overlap in
Cross Fade Preferences.

3. Control drag a copy of the entry to the right of the original sample. Leaving
them crossfaded.

4, Control drag another copy to the right. Continue the control drag technique until
you have duplicated the sample as many umes as required.

Editing an Entry

Load an Audio Entry Into an Editor

1. Click the entry to select it.

9. Choose the Edit Selected command in the Entry menu (A-E). An Editor will
open for the sample.

This will not work if the entry is part of a group.

Ungroup an Audio Entry and Load It Into an Editor

1. Select the entry.

2. Choose the Ungroup command from the Entry menu.

3. Click anywhere on a track outside the entries to deselect all entries.

4. Select the entry again and choose the Edit Selected command in the Entry menu
(A-E). An Editor will open for the sample.

Load a Grouped Audio Entry Into an Editor
1. Double click the entry to bring up Audio Event Parameters.
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2. Chick the Edit button in the requester and an Editor will open for the sample.

WARNING Edits made in the Editor will change the actual sample. If the same sample is
used in other Audio Entries, in the same Cue List or other Cue Lists, the edits you
make will affect those other Audio Entries.

You should consider making a copy of a sample under another name in the Sample
List. Then you can import the copy into the Audio Entry, by dragging it from the
Sample List onto the Sample field at the top of the Audio Event Parameters
requester, This will insure that you have a unique sample for that entry and you can
edit it without worrying about affecting other Audio Entries.

Playing an Entry
Play a Single Audio Entry

1. Click the entry to select it

2. Choose the Play Selected command in the Entry menu (A-P).
This will not work if the entry is part of a group,

Ungroup an Audio Entry and Play It

. Select the entry.

]

Choose the Ungroup command from the Entry menu.
Click anywhere on a track outside the entries to deselect all entries,

3
4. Select the entry again and choose Play Selected in the Entry menu (A-P).

Play a Grouped Audio Without Ungrouping
1. Double click the entry to bring up Audio Event Parameters,
2. Click the Play button in the requester.

Changing Volumes and Pans

To change volume and pan settings for an Audio Entry, double click the entry to
bring up Audio Event Parameters. In that requester yvou can move the Pan slider lefi
or right to pan the sample between the left and night outputs (this is only available if
you have an AD516) and move the Volume slider up and down to raise and lower the
sample's volume.,

You will not be able to hear the results of these settings if the Use Mixer Levels
command is activated in the Options menu, Use Mixer Levels should not be activated
when you want to use the Audio Event Parameters settings to control volumes and
pans from within the Time Line. Activate Use Mixer Levels when you want to do an
automated mix with the Mixer module
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Removing an Entry

To remove an entry, click it once to select it, then use the Remove Selected command
in the Entry menu, or just hit the Delete key,

Remove more than one entry by shifi-clicking the entries you want to remove then
using the Remove Selected command.

Removing entries from the Cue List in the Time Line will not delete the actual
sample data from your hard drive. If you change your mind you can drag the samples
back from the Sample List into the Time Line, or simply use the Undo command in
the Time Line.

Replacing an Entry

A simple way to replace an entry or to try different sound effects at the same position

is to use the Drag & Drop capabilities of Audio Event Parameters. This can replace

the sample in an Audio Entry with another sample from the Sample List

Replace One Sample With Another

|. Double click the Audio Entry to bring up Audio Event Parameters.

2. Drag a sample from the Sample List and drop it in the Sample field at the top of
the requester.

3. The sample you dragged from the Sample List has replaced the sample that was
in the Audio Entry.

Using AREXX

You can send messages to other programs directly from the Time Line. Use AREXX
commands to:

Show piclures

Play animations

Start video decks

Run video disk players

Control a light show

Trigger the NewTek Video Toaster (Toaster Handler required}

Dial a phone number

Before you can use AREXX, you must run the RexxMast program that came with
your Amiga (WorkBench 2.04 and higher). This program listens to AREXX
messages sent by all programs and routes them to the specific program for which
they're intended. To run it, double click the RexxMast icon (check your Amiga’s
documentation for the location of the RexxMast icon). It's a good idea to put the
RexxMast icon into your WorkBench Startup Drawer. Then it will run automatically
whenever you boot your Amiga, and you won't have to start it up manually every time
you use AREXX,
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To send AREXX messages from the Time Line you need an AREXX track.

Create an AREXX Track
l. Choose the Add Track command from the Track menu,
2. Click the word "AREXX" in the requester to add an AREXX track. An AREXX

track will appear on the Time Line. The Track Name button on the left edge of
the track will say "AREXX",

Figure 8-4. Track Types

Next you specify the AREXX port to be addressed. An AREXX port is the name that
tells the RexxMast program to which other program you're sending messages.

Specify an AREXX Port
I. Find out the name of the AREXX port for the program to addressed by looking
in that program’s manual.

2. Run the program to be addressed. This step is optional, but it makes it possible
to test if the AREXX communication is working,

3. Click the Name button on the AREXX track to open AREXX Track Parameters,

4. Type the AREXX port name in the Port field and hit the return key on your
keyboard,
5. The bottom of the AREXX Track Parameters requester should now say "Port

Found", If it deesn't, you cither don't have your AREXX program or RexxMast
running, or you typed the Port name incorrectly.

6. It's important that you type it precisely the way it's shown in the manual of the
AREXX program, AREXX is case sensitive, so match upper and lower case
letters exactly,

While you're in AREXX Track Parameters, you can change the name of the track
from "AREXX" to something else, like the name of the program you're addressing.
There's room for up to nine characters in the track name button.

Change the Name of a Track
|, Click the Name field and erase the name "AREXX" by typing A-X.

NOTE This is the standard Amiga keyboard shortcut for erasing the contents of fields. You
can also use the delete key or the backspace key. When a field is not activated, the
Time Line uses A-X 1o cut selected tracks into the Paste buffer.
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2, Type the new name for the track and hit return.
The new name will appear in the Track Name button for the track. You can
change the name at any time.

3. When you're done with the name change, close AREXX Track Parameters by
clicking the close gadget in the upper left corner.

Now that you've set up the track to address another program’s AREXX port, the next
thing to do is add an AREXX Entry to the track. AREXX Entries let you send a list
of commands to the program the track is addressing. The commands will be sent at an
exact time on the Time Line.

Add an AREXX Entry to an AREXX track

1. Select the AREXX track or tracks on which to add an entry.

2. Drag the Position flag to the point in time where the entry will be added.
3, Choose the Timecode Add command in the Entry menu.

This will add an AREXX Entry at the time of the Position flag on any selected
AREXX tracks. An AREXX entry looks like a vertical line with a small box in
the center of the line.

NOTE Time Code Add command is the only way to add AREXX entries.

If the Time Line is playing, the Position flag will be moving and you can add
entries on-the-fly with the A-T shortcut for the Timecede Add command.

If you feed SMPTE time code from a video deck to the SMPTE input of your
SunRize card, vou can use A-T to add AREXX Entries where you want them in
relation to the video, while you watch the video.

4. Double click the entry to open the AREXX Event Parameters,

Specify the commands you want the AREXX Entry to send by typing them in the
Cmdl through Cmd?9 fields. The commands will be sent in order starting with
Cmdl.

Figure 8-5. AREXX Event Parameters
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To learn the AREXX commands available for the program you are addressing, refer
to the program's manual.

Test the AREXX Commands

. Make sure the program to be addressed is running.

2. Chick the Test CMD button. The commands will be sent to the program.

Type a name in the Name field. This name will appear next to the AREXX Entry in
the Time Line. You can give it a name appropriate to its function, like "Picture”,
“Animation”, or whatever,

You can also type in an exact time in the Time field, if you need itto sync o a
specific time. If there is a delay between the time set in the Time field and the time
the program you are addressing actually responds, you can move the AREXX Entry

back in time to compensate. To move it, either enter a new time in the Time field, or
drag the entry with the mouse,

Moving an Entry

To move an entry, just drag it with the mouse. You can drag an entry:

® et - to move it earlier in time
® right - to move it later in time
B up/down - to move it from one track to another

If you drag an Audio entry into another Audio entry on the same track, they will
automatically cross fade.

If you hold down the Control key and drag an Entry, the original entry will remain
and you will drag a duplicate entry.

You can only drag Audio entries onto Audio tracks and AREXX entries onto
AREXX tracks.

How you can move an entry depends on the Drag Mode yvou've selected. You can set
the Drag Mode using the Drag Mode buttons at the top of the Time Line window.

Figure 8-6. Drag Mode Buttons

From left to right, the Drag Mode buttons select:
B Any Direction
®  Lock-To-Grid
® Vertical Only
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Any Direction
To drag entries with no restrictions, click the Any Direction button.

To move more than one entry at the same time:

1. Shift-click the entries to move.

2. Then when you drag any one of the grouped entries, you'll drag them all.

Lock-To-Grid

To drag entries so that they lock to the nearest grid lines, click the Lock-To-Grid
button. You can use this to align entries to the same start time or match sound effects
to musical beats.

Vertical Only

To drag entries so that they only move between tracks, click the Vertical Only button.
Use this when you already have entries synchronized and don't want to lose their
positions in time,

Auto-Locating Flags

The Time Line has 10 locate flags. You can put them wherever you want along the
Time Line to mark a location and you can then jump to that location with a single
keystroke. You can add a comment that will be displayed next to a Locate flag.

Add a Locate Flag

1. Drag the Position flag to where you want the Locate flag to be.

2. Hold down the shift key and type a function key.

3. A Location flag corresponding to the number you typed will appear at the
Position flag. For example, if you typed F1, the "banner” of the flag says "F1".

If you've already created a particular Locate flag and you do the above steps, the
Locate flag will relocate to the new position. You can also move Locate flags by
dragging them left or right. If the Lock-To-Grid editing mode is on when you
move a Locate flag, it will move in grid increments.

4. Once you've added a Locate flag, move the Time Line to that flag by typing the
function key or the number on the numeric keypad that corresponds to that flag.
The Time Line will scroll to show the flag, and the Position flag will move to the
Locate flag. If yvou click the Play button, the Time Line will begin to play from
the Locate flag.

It can be useful to put a comment next to a Locate flag to remind yourself what it's
marking. For example, you could put "Verse", "Chorus”, or "Chase Scene”,

Comment a Locate Flag
I. Double click the flag's banner to open Flag Parameters .
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2. Type a comment in the Comment field and hit the return key on your keyboard.

The comment will appear to the right of the flag's banfer, above the Time Line.

Ef.___l -,—— — F" Tl Par. !_ _— s I!F-
I Tanes 8:808:17:85 | =showa] Retiovet
Cansn: T e
Figure &7, Flag Parameters

Remove a Locate Flag
1. Double click the flag's banner to open the Flag Parameters.

2.  Click the Remove button.

The flag will be removed from the Time Line.

Opening and Saving Cue Lists

You can Open Cue Lists into the Time Line by using the Open command in the Cue
List menu. A file requester will let you select a Cue List file to open. You can save
the Time Line to a Cue List file by using the Save As or Save command. See
Chapter 6 - Cue List Tutorial for step by step instructions.

NOTE

A Cue List does not contain samples. It is a file that contains the descriptions of
events to be tniggered and when every entry should be triggered.

Triggering Entries From the Time Line

The Time Line can trigger Audic and AREXX entries when its Activation button is
turned ON and the Time line has been triggered. There are three ways to trigger the
Time Line:

m  Click the Play button

m  Click the Play from Start Buuon

®  Start the SMPTE generator, either internal or external

Internal sources include the SMPTE Generator or SMPTE Output in the Swdio 16
software, External sources include the SMPTE output of a video tape deck or
multitrack audio recorder connected to the SMPTE input of your AD516.

It may take the Time Line several seconds to find the correct position to start
playback, especially if the computer is busy, or if you are triggering near the end of a
long sample.

Selecting SMPTE Frame Rate and Source

Studio 16 supports SMPTE frame rates of 24, 25, and 2997 frames per second, and
30 frame per second drop frame (DF}. The Time Line will expect whatever frame
rate set in Studio 16 Preferences.
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Select a Frame Rate

. Use the Preferences command in the Project menu to open the Preferences.

2. Choose the frame rate clicking the appropriate button in the SMPTE section in
the upper right corner.

3. You can use the SaveSetup command in the Project menu to save your choice as
the default frame rate.

NOTE

The SaveSetup command also saves other information about your initial setup,
including the windows you have open, their locations, default file requester paths,
screen colors, and more,

Setting Cue List Defaults
When you first open the Time Line, it will open a Cue List called "Untitled.cue”. The
same file is opened when you select the New command in the Cue List menu.

You can customize the layout and design of this default file by creating Cue List
format of your choice and then choosing the Save Default command in the Cue List
menu. Your customized Time Line will then be saved as Default.cue.

Cue List Reference

Transport Buttons

| ([ e

Figure 8-8. Transport Butions

You'll find the transport buttons in the upper left corner of the Time Line window.
You can click them with the left mouse button or use their keyboard shortcuts. They
function much like the buttons on a standard multitrack tape recorder.

There are six transport buttons:
® Record

m  Play From Start
m Play

m Stop

m Rewind

m  Fast Forward
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Figure 8-9. Record Button

Record Button The Record Button lets you put the time line into record
maode. In record mode, you can record a sample onto one or
more tracks. However, clicking the Record Button will not
immediately cause the time line to begin recording.

Keyboard Shortcut: 4+ -

On the numeric keypad, you can use the + key to turn the
record button on, and the - key to trn the record button
off.

Record From the Cue List

1. Click the Record Button. This puts the Time Line into record mode,

2. Select one or more tracks by clicking the Track Select button for each track you
intend to record onto. The Track Select button is to the right of the Track Name
button. [t displays an arrow when selected. Typically you'll select one track for a
monophonic recarding, or two tracks for a stereo recording.

3. Open the Audio Track Parameters by clicking the Track Name button. There
you'll see the Record drop list in the Track Parameters . Choose from the inputs
on any SunRize boards installed in your system.

Y ou can also choose to record the output of the Time Line. This lets you
combine muluple tracks into a single sample.

4. Move the Punch-In and Punch-Out flags to define the start and end times of the
recording.

5. Move the Position flag to the left of the Punch-In flag so that playback begins
before the start time of the recording.

6. Click the Play button.

Or, you can also use the Play-From-Start Button, if the Start Flag is to the left of
the Punch-In Flag. Recording always begins at the Punch-In Flag. Recording
stops at the Punch-Out Flag or when you click the stop button.

NOTE The + and - keyboard shortcut for the Record button means you can go in and
out of record mode without looking at the monitor to see what mode you're in, This
can be helpful if you're recording an instrument that picks up hum from the monitor,
like an electric guitar. Using keyboard shortcuts, you can do your recording with the
monitor off, 1f necessary.
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Figure 8-10. Play From Start Button

Play-From-Start

Button Click the Play-From-Start Button when you want the Time
Line to begin playing from the Start Flag, rather than from the
Pasition Flag location.

Keyboard Shortcut:  You can use the 0 key on numeric keypad to activate the Play
From Start Button,

If the Record Button is enabled, the Time Line will
automatically start recording onto selected tracks when the
Lacation Flag passes the Punch-In Flag.

NOTE You can move the Start Flag to any location by dragging it. but typically you'll put it
ahout five seconds befare the beginning of your soundtrack or song. You can use the
ten Locate Flags to set other locate points within your soundtrack or song.

>

Figure 8-11. Play Button

Play Button Click the play button when you want the Time Line to start
playing from the Position Flag.

Keyboard Shortcut:  Enter (keypad)

You can use the Enter key on the numeric keypad to toggle
playback on and off. The Enter key will also stop rewind and
fast forward operations

The Position Flag marks your current playback location on
the time line. When you're not playing, rewinding or fast
forwarding, the Position Flag will be wherever you last
stopped playback, unless you drag it somewhere else or move
it to a Locate flag position using one of the function keys.

If the Record Button is enabled, the Time Line will
automatically start recording onto selected tracks when the
Position Flag passes the punch-in flag.
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Figure 8-12, Stop Button
Stop Button Click the Stop button to stop any playback, recording, fast-

forward or rewind operation.
Keyboard Shortcut: . Enter (keypad)

You can use the Decimal Point key or the Enter key on the
numeric keypad to stop playback, rewind and fast forward
operations. The Decimal Point key will always stop the
current transport operation, The Enter key toggles between
the Play and Stop buttons.

Figure 8-13. Rewind Button

Rewind Button Click the rewind button to move the Position Flag rapidly
backward in time. Click the stop button when yvou want the
Position Flag to stop,

Keyboard Shortcut:  Left arrow key

You can use the left arrow key to scroll the Time Line to the
left while keeping the Position flag at about a third of the way
from the left edge of the Time Line. This is not exactly what
the Rewind button does, but it's similar enough that you can
often just use the left arrow key to rewind,

If the Grid Snap button is turned on, the Position Flag will
move in grid increments. Otherwise it will move in seconds.

NOTE You'll see the changing SMPTE location of the Position Flag if you open the SMPTE
Monitor.

Figure 8-14. Fast Forward Button

Fast Forward Button Click the fast-forward button to move the Position Flag
rapidly forward in time. Click the stop button when you want
the Position Flag 1o stop
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Right arrow key

You can use the right arrow key to scroll the Time Line 1o the
right while keeping the Position flag at about a third of the
way from the left edge of the Time Line. This is not exactly
what the Fast Forward button does, but it's similar enough
that yvou can often just use the right arrow key to fast forward.

If the Grid Snap button is turned on, the Position Flag will
move in grid increments. Otherwise it will move in seconds.

NOTE You'll see the changing SMPTE location of the Position Flag if you open the SMPTE

Monitor.

Drag Mode Buttons

The Drag Mode buttons are at the top of the Time Line window to the right of the

Transport Control buttons. You can click them with the left mouse button or use their
keyboard shortcuts. They let you determine how freely you can drag entries and flags
with the mouse.

Figure B-15.

Drag Mode Buttons

There are three Drag Mode buttons. Only one button can be active at a time.

& Any Direction
m  Lock-To-Grid
m Vertical Only

Dragging Entries

Dragging Grouped
Entries

Dragging Flags

You can drag an entry in the time line by clicking it with the
left mouse button, and while still holding the left mouse
button down, moving the mouse. The entry will follow the
mouse. It can be dropped on any audio track.

You can drag grouped entries together by dragging any
member of the group. Select and group multiple entries by
clicking each entry while holding down the shift key, and then
select the Group command in the Entry menu,

You can drag a flag by clicking it with the left mouse button,
and while still holding the left mouse button down, moving
the mouse left or right. The flag will follow the mouse.

If you drag a flag or entry beyond the right or left edge of the
Time Line window, the Time Line will scroll.
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You can move entries and flags freely in time, but there's another issue to be aware
of. There are only so many pixels on the computer screen to represent all the
resolution available in the Time Line. If you are zoomed out and you move a flag,
you may notice that in order to represent the amount of time you're viewing, each
time you move the flag by a single pixel it may jump several frames, or even several
seconds depending on the time the Time Line needs to display.

The larger the amount of time you show in the Time Line by zooming out to see more
of the Time Line, the more time each pixel has to represent. Zoom in for more
resolution.

NOTE Pixel is short for Picture Element. A Pixel is a single tiny rectangle on the screen that
combines with other pixels 1o create what you see on your computer screen. On a
normal, (non-overscan) Amiga high-res interlaced screen there are 640 pixels from
the left side of the monitor to the right side of the monitor.

For example, in Any Direction Mode, with SMPTE selected in the Time Options area
of Cue List Preferences. If dragging an entry or flag by single pixel moves it more
than a thirtieth of a second, and you need finer control, zoom in to display a smaller
portion of the Time Line using the Zoom Arrow Buttons to the left of the Horizontal
Scroll Bar, You can also make your Time Line window wider using the sizing gadget
in the lower right corner.

I 1
|

Figure 8-186. Any Direction Button

Any Direction Button Use the Any Direction button to select the Any Direction
maode. This mode lets you drag entries forward or backward
in time, at the current resolution of the Time Line. It also lets
you drag entries up or down, from one track to another.

Keyboard Shortcut: Tab or -

Let go of either the tab or tilde key to turn on the Any
Direction Button

If you are in Any Direction mode when you drag a sample
from Sample List in the Time Line, the Audio Entry will start
where your mouse pointer was when you dropped the entry.
However, if Keep Original Time activated, the sample will be
added at the correct SMPTE frame.

The Any Direction Mode also lets you move flags forward or
backward at the current display resolution of the Time Line,
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NOTE For speedy keyboard access to all modes, select the Any Direction button. Then hold
down the tilde key — (abave the Tab key) on your keyboard when to termporarily
select Vertical Only, or the Tab key to select the Lock-To-Grid button. Releasing the
tilde key or Tab key will reselect the Any Direction button.

v — ol

|

Egura 8-17.

Lock-To-Grid Button

Lock-To-Grid Button In Lock-To-Grid mode, when you drag entries in ume they

Kevboard Shortcut:

snap to the nearest grid increment. You can drag entries
between tracks.

Tab key

Press and hold the tab key to turn on Lock-To-Grid. Release
the tab key to turn it off,

Use this mode when you want entries to start exactly at a
predefined interval. Also, snapping left and right stereo
samples to the same grid increment 1s a quick way to
synchronize them exactly. If you then group them, you can
then drag them anywhere, in Any Direction Mode, without
losing stereo sync,

You can also set a custom grid increment to match the tempo
of a musical sample, and then drag sound effect samples to
lock to the grid so they follow the beat.

If you are in Lock-To-Grid mode when you drag a sample
from Sample List onto an Audio track in the Time Line, the
audio entry will start at the nearest grid line.

Flags will also snap to the nearest grid increment when you
move them. Use the "Set Grid Spacing” command in the
Options menu to change the increment.

Figure B-18.

Vertical Only Button

Vertical Only Button

In Vertical Only mode, you can prevent any time changes
when moving entries between tracks. In this mode you will
not be able to move entries forward or backward in time.
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Keyboard Shortcut: -

Press and hold the ~ tilde key (above the Tab key) to turn
the Vertical Only button on. Release it to turn it off,

This is handy when you have a sound effect placed exactly at
the time you want, but you need move it to another track.
Another use is to record a second take on a separate track,
then “punch in” to the original track.

Since flags can only be moved horizontally, they are not
restricted by this mode. Just like the Any Direction mode,
Vertical Only mode lets you move flags forward or backward
in time at the current display resolution of the Time Line.

NOTE For speedy keyboard access to all modes, select the Any Direction button. Then hold
down the tilde key ~ (above the Tab key) on your keyboard when to temporarily
select Vertical Only, or the Tab key to select the Lock-To-Grid button. Releasing the
tilde key or Tab key will reselect the Any Direction button.

Edit Mode Buttons

You'll find the Edit Mode buttons at the top of the Time Line window to the right of
the Drag Mode buttons. You can click them with the left mouse button or use their
keyboard shortcuts. They let you determine how freely you can overlap entries that
are on the same track.

Figure 8-19. Edit Mode Buttons

There are three Edit Mode buttons. Only one of these buttons can be active at a time.
®  Unlimited Cross fade

®  Limited Cross fade

= Burt Edit

What Is Cross Fading?

If you have two sounds that overlap in time on the same track, the Time Line will
automatically cross fade them. Cross fading is the process of wurning down the first
sound while simultaneously turning up the second sound, This gives you a smooth
transition from one sound to the next,

Cross fading is amazingly easy in the Time Line. Just drag one Audio Entry over
another on the same track, and you're done. Change the cross fade time by either
dragging the Entry to the lefi or right. Or, change the crossfade times without actually
moving the Entries by dragging either Entry's crop gadgets. Note that Crossfades are
CPU intensive, too many crossfades may decrease your number of playback tracks.
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You can also select from a variety of cross fade curves that determine how the
volume fades on each of the overlapping samples. Just change the cross fade types by
clicking the cross fade area and bring up the Cross Fade Type Requester.

Figure 8-20, Unlimited Crossiade Button

Unlimited Cross Fade

Button Select the Unlimited Cross Fade button to turn on Unlimited
Cross Fade mode. In this mode you can automatically create
any length cross fade by dragging part of one sample over
part of another sample on the same track. You can see the
cross fade area as you are dragging one sample over another.

Figure 8-21. Limited Cross Fade Butlon

Limited Cross Fade

Button In Limited Cross Fade mode, if you drag any sample over any
other sample, the overlap area is restricted to be no greater
than the default cross fade time set in Cross Fade Preferences.
In other words, you can create a cross fade that is less than or
equal to the default cross fade time. Create a cross fade of
exactly the default time by dragging until the cross fade area
stops growing.

Change the default or maximum cross fade time by moving
the slider at the bottom of the Cross Fade Preferences
requester. You can bring up Cross Fade Preferences from the
Options menu. Save your new cross fade time as the default
cross fade time with the SaveSetup command in the Project
meénu,

i‘:___

Figure 8-22. Butt Edit Button

What Is A Butt Edit?

A butt edit is when one sample starts exactly when another stops. The two samples
will not overlap, nor will there be a gap between them. Precise butt edits are easy to
do. Just drag one sample against another while in Butt Edit mode.
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Butt Edit Button Use Butt Edit mode to create perfect butt edits. When vou
drag one sample into another on the same track, they will butt
up against each other exactly. They will not overlap, nor will
there by a gap between them.

Cross Fade Curve Types

When you create a real time cross fade, it will initially adopt the types set in Cross
Fade Preferences. Note that Crossfades are CPU intensive, too many crossfades may
decrease your number of playback tracks.

Figure 8-23. Default Cross Fade Preferences

If you change the settings in Cross Fade Preferences, your chosen fade types will be
used for any new real time cross fades you create from then on.

Your default cross fade time will be used by any cross fades you create while in
Limited Cross Fade mode. To change this default cross fade time, drag the slider at
the bottom of the requester left or right. Dragging it left will decrease the default
cross fade time while dragging it right will increase the default cross fade time.

NOTE Use SaveSetup to save these settings so they'll be there next time you run Studio 16,

Use the curve types to choose how the first sample will fade out and how the second
sample will fade in, There are four fade types:

m  Linear

B Logarithmic
m  Exponential
B Instant

— .'".‘I'Hi:;.mml-.i-r:.tn'*.- :
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Figure 8-24. Linear In and Linear Out

A linear fade changes the volume of the sample at a constant rate,
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Figure 8-25. Logarithmic In and Logarithmic Out

A Logarithmic fade at the end of a sample changes the volume only a little at first,
but it changes it at an increasing rate, losing more than half the volume in the last
third of the overlap area.

Use this for the fade out curve type when you want the first sample in a cross fade to
slowly become less prominent during the cross fade.

A Logarithmic fade at the beginning of a sample changes the volume quickly at first,
but it changes it at a decreasing rate, easing into full volume. It gains more than half
its volume in the first third of the overlap area. Use this for the fade in curve type
when you want the second sample in a cross fade to become prominent quickly.

Figure B-26. Exponential In and Expanential Out

An Exponential fade at the end of a sample changes the volume quickly at first, but it
changes it at a decreasing rate, easing into the complete fade out. Use this for the fade
out curve type when you want the first sample in a cross fade to guickly become less
prominent during the cross fade.

An Exponential fade at the beginning of a sample changes the volume only a little at
first, but it changes it at an increasing rate, gaining more than half its volume in the
last third of the overlap area. Use this fade in curve when you want the second
sample in a cross fade to slowly become prominent.
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Figure 8-27. Instant In and Instant Cut

An Instant fade at the end of a sample changes the volume of the sample instantly
from full on to full off. Use this for the fade out curve type when you want the first
sample in a cross fade to play at full volume to its end, with no fade.

An Instant fade at the beginning of a sample changes the volume of a sample
instantly from full off to full on. Use this for the fade in curve type when you want
the second sample in a cross fade to begin without a fade, at full volume.

One good use for using Instant In or Instant Out fades is when you have samples that
already have linear, logarithmic, exponential, or other fade types as part of their data.
In that case you wouldn't impose another long fade in or out type on top of the
existing fade, but you might still overlap such samples. Choose Instant In or Instant
Out when you overlap such samples, and their built-in fades can then make the cross
fade.

Changing Curve Types On Existing Cross Fades

Even after you've created a real time cross fade it's easy to change the curve types.
Just click the cross fade area, and then click the curve types you want in the Cross
Fade Type requester that appears.

Figure 8-28, Cross Fade Type

The Cross Fade Type requester lets you choose from the same curve types as Cross
Fade Preferences .

Overlap Contention

If you drag a smaller sample completely over a larger sample, the overlap contention
requester appears 50 you can choose how you want the samples to be handled .

Studio 16



User's Manual

Chapter 8

Figure 8-29. Overlap Contention

There are seven choices in the Overlap Contention requester,
®  Insert the sample with butt edits or cross fades
®  [Insert and crop the either sample with a butt edit or cross fade

m  Undo the sample move

When you choose an option that uses a cross fade, Studio 16 will normally use the
default cross fade type and time as set in Cross Fade Preferences, unless you've
chosen a different type in the Audio Event Parameters for each sample.

From top 1o bottom, and left to right the overlap options are:
Left & Right Bun

Left Butt

Right Butt

Left & Right Cross Fade

Left Cross Fade

Right Cross Fade

Undo Last Edit

Left & Right Butt

Click this button to insert the new sample over the old sample. The old sample will
be copied and cropped so that one copy of the old sample begins before the new
sample, and the other copy of the old sample begins after the new sample. Both
copies of the old sample will be butted up against the new sample. The data in the old
sample will not be moved in time, but a section of the old sample’s sound will be
replaced by the new sample.

This is a non-destructive operation, so there's no risk of losing data. If you change
your mind, use the Undo command in the Options menu,

Left Butt

Click this button to insert the new sample on the lefi of the old sample. The old
sample will be cropped, and the two samples will be butted together.

This is a non-destructive operation, so there’s no risk of losing data. If you change
your mind, use the Undo command in the Options menu.
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Right Butt

Click this button to insert the new sample on the right of the old sample. The old
sample will be cropped, and the two samples will be butted together.

This s a non-destructive operation, so there's no risk of losing data. If you change
your mind, use the Undo command in the Options menu.

Left & Right Cross Fade

Click this button to insert the new sample over the old sample. The old sample will
be copied and cropped so that one copy of the old sample begins before the new
sample, and the other copy of the old sample is begins after the new sample. Both
copies of the old sample will be cross faded with the new sample.

This is a non-destructive operation, so there's no risk of losing data. If you change
your mind, use the Undo command in the Options menu.

Change the default cross fade amount with the shider in Cross Fade Preferences. Save
your new cross fade time as the default cross fade time with the SaveSetup command
in the Project menu.

Left Cross Fade

Click this button to insert the new sample to the left of the old sample. The old
sample will be cropped, and the two samples will be cross faded together.

This is a non-destructive operation, so there's no risk of losing data. If you change
your mind, use the Undo command in the Options menu,

Right Cross Fade

Click this button to insert the new sample to the right of the old sample, The old
sample will be cropped, and the two samples will be cross faded together.

This is a non-destructive operation, so there's no risk of losing data. If you change
your mind, use the Undo command in the Options menu.

Undo Last Edit

Along the bottom is a big button labeled "UNDO Last Edit". If you didn't mean to
drop one sample completely over another, click this button and your last sample
move will be undone.

Same Start Time Contention

If you have two audio entries that are to begin at exactly the same time, the Same
Start Time Contention requester will appear.
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Figure 8-30. Same Start Time Requester

This can also happen if you drag a copy of one Audio Entry exactly over the original,
or if you record one Audio Entry over another,

The Same Start Time Contention requester gives you five choices:

m  Move First Sample

Move Second Sample

Delete First Sample

Delete Second Sample

Undo Last Edit

Move First Sample
Choose this to move the first Audio Entry over by one second.

Move Second Sample
Choose this to move the second Audio Entry over by one second.

Delete First Sample
Choose this to remaove the first Audio Entry from the Time Line.

Delete Second Sample
Choose this to remove the second Audio Entry from the Time Line.

Undo

Choose this to remove the second Audio Entry if you recorded one over the other, or
to move the second Audio Entry back where it was if you moved one Audio Entry
over the other.

Performance Issues

The Time Line uses the powerful Digital Signal Processor (DSP) chip on your
SunRize card to play audio. This frees your Amiga's Central Processing Unit (CPU)
chip for other tasks. The Time Line takes advantage of this free CPU time to offer
real time cross fades. Most of the time you probably won't need that CPU time for
anything else while playing the Time Line.

If vou do need to run other tasks while playing the Time Line, and find you are
running short of CPU time, you can record tracks that have real time cross fades onto
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other tracks. This will create new samples that sound the same but that have the cross
fades fixed into the sample data. When vou play these new tracks, no extra CPU time
will be needed for cross fades.

For more information on how to record existing tracks into new samples, see the
previous Procedures section,

Text Area

The Text Area in the upper right corner displays a variety of messages as you work.
S —— | = e

Figure 8-31. Text Area

The entry start time when you click an entry
The entry start ime as you drag an entry
The entry start time or end time as you drag an entry's Crop gadgets

The entry fade in or fade out time as you drag an entry's Fade gadgets

The flag time as you drag a flag (except the Position flag)

Activation Button

Jon_

Figure B-32. Aclivation Bullen

The Activation button toggles between ON and OFF. When it's ON, the Time Line
will sync to whatever time code source is running. When it's OFF, the Time Line will
ignore the sync source, This can be useful when you work on video editing without
needing the Time Line playing.

NOTE When the Time Line is off, it will not play samples or send AREXX commands. If
you are having trouble getting the Time Line to work, make sure the Cue List is ON,

Figure 8-33. Flag Area

T
o

Flags are handy visual markers that you can move with the mouse. You can use the
flags to see where you are in the Time Line, to mark places in the Time Line, and to
define the start and end times for recording.
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The banners of the flags float just above the time line and just below the transport
buttons and the text area. The "flag poles” of the flags are vertical lines drawn over
the time line to show the exact location of each flag in time.

To move a flag, just grab its banner and drag it lefi or right in time. If you drag past
the left or right edge of the Time Ling, the Time Line will scroll.

The Drag Mode buttons, at the top of the window between the Transport buttons and
the Edit mode buttons, affect how you can drag the flags. If you're in Any Direction
mode or Vertical Only mode, vou can drag flags freely. If you are in Lock-To-Grid
mode you can only drag flags in grid increments. The latter is useful for aligning
flags with exact times or beats.

NOTE

You can set the grid increment time in Set Grid Spacing from the Options menu.

There are 14 flags:

m |- Siart Flag

® |- Punch-In Flag
® |- Punch-Out Flag
® | - Position Flag
]

10 - Locate Flags

The flags have keyboard shortcuts. If you type a flag's keyboard shortcut on your
Amiga keyboard, the Position flag will go to the location of that flag. The Time Line
will also scroll to show that flag.

If you hold down the shift key and type a flag's keyboard shortcut, the flag will be
relocated to the same location as the Position flag.

Figure 8-34. Start Flag

Start Flag The Play-From-Start button plays from the Start Flag's
location. Think of the Start Flag as a special locate flag that
vou would normally use to mark the start of a video, the start
of a song, or the beginning of any sound effects project.

Keyboard Shortcut:  / (keypad)

You can use the [ key (slash) on numeric keypad to put the
Start flag on top of the Position flag, or shift / to move the
Position flag to the Start flag.

You may find it handy to temporarily move the Start Flag to
the start of any section in your project while you're working.
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e
Figure 8-35. Punch-In Flag
Punch-In Flag Use the punch-in flag to specify where recording will start.

You can drag the Punch-In flag to any time on the Time Line.
Keyboard Shortcut:  {  (keypad)

Youcan use the ( key on the numeric keypad to put the
Punch-In flag on top of the Position flag, or shift ( to move
the Position flag to the Punch-In flag,

If you drag the Punch-In flag to a point in time after the
Punch-Out flag, the flags will swap positions so that the
Punch-In flag is before the Punch-Out flag.

A common use of Punch in and out follows:

l. Setthe Position flag to a location five seconds or so
before the punch-in flag.

2. Select the audio track or tracks onto which you want to
record.

. Click the record button,.

4, Click the play button,
The time line will begin 1o play, and when the Location
flag reaches the punch-in flag, the time line will start
recording.
The recording will end when the position flag reaches the
Punch-Qut flag or when you click the stop button on the
Time Line’s transport.

Figure 8-36. Punch-Cut Flag

Punch-Out Flag Use the Punch-Out flag to specify where you want recording
to stop. You can drag the Punch-Out flag to any time on the
Time Line.

Keyboard Shortcut; }  (keypad)

You can use the ) key on numeric keypad to put the Punch-
Out flag on top of the Position flag, or shift } o move the
Position flag to the Punch-Out flag.
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If you drag the Punch-Cut flag to a point in time before the
Punch-In flag, the flags will swap positions so that the Punch-
Out flag is always after the Punch-In flag.

Figure 8-37.

Position Flag

Position Flag

The Pasition flag shows where the Time Line will begin to
play if you click the Play button in the Time Line’s transport.
When the Time Line is playing, you can watch the progress of
the Position flag's vertical line as it moves through the Time
Line.

When the Time Line is stopped, you can move the Position
flag to another time by dragging it with the mouse. For
example, to hear a section of the Time Line, drag the Position
flag to a time just before the section begins. Then click the
Play button in the Time Line's transport to hear the section.

Patio

Figure 8-38,

Locale Flags

Locate flags

Keyboard Shortcut;

The Locate flags are useful for marking times in the Time
Line. You can have up to 10 Locate Nags, tied to your
Amiga's function keys, F1 through F10 (F10 is shown as F0).
You can also use the numeric keypad keys 1-9 for Locate
flags F1-F9, and the * key for locate flag F10 (F0).

FIF2ZF3F4F3F6 FT FEFOFD (keypad) 1 234567809 #

You can use the F1 through F10 (F10 is shown as FO) or the
numeric keypad keys 1-9 for Locate flags F1-F9, and the *
key for locate flag FO (F10).

You can use the function keys on your kevboard to:
®  Create a Locate flag
®  Gotoa Locate flag

m  Play from a Locate flag

Creating a Locate Flag

To create a Locate flag, hold down the shift key and press any function key on your
Amiga keyboard. The Locate flag will then appear on top of the Position flag.
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For example, if you type shift-F1, you'll see a flag marked "F1" appear on top of the
Position flag.

NOTE If you've already created the F1 Locate flag, it will move to the Position flag when
you type Shifi-F1.

Moving a Locate Flag

Click and drag a Locate flag with the mouse to move it in time. If you drag past the
edge of the Time Line window, the Time Line will scroll to reveal more of the time
line in that direction. Another way to move a Locate flag is to double ¢lick the flag to
bring up the Locate Flag Requester.

Change the time in the Time field and hit the return key. This is a quick way to move
a Locate flag to an exact time. You can then click the Show button to scroll the Time
Line to show the flag's new position.

Finally, you can move the Locate flag, by holding down the shift key on your Amiga
keyboard, and then typing the function key for the Locate flag you want to move. The
Locate flag will move to the Position flag.

Playing the Time Line From a Locate Flag's Position

Type the function key or numeric keypad number for an existing Locate flag and the
Position flag will move to the Locate flag. The Time Line will also scroll to show the
Locate flag. Then click the Play button in the Time Line's transport.

Putting a Comment by a Locate Flag

Double click a Locate Flag to bring up the Locate Flag Requester, In the Flag
Requester you'll see a field called "comment”. Type any comment into the field and
hit the return key, and you'll see that comment tied to that Locate flag. For example,
if you're working on a film soundtrack you might label a Locate flag with a scene
name, like "scene 14". Or, if vou're recording a song, you might use a song section
name like "chorus” or "verse 2". You can use whatever comments are appropriate for
the project you're creating.

Deleting a Locate Flag

Double click a Locate Flag to bring up the Locate Flag Requester, Click the Remove
button in the Flag Requester. The Locate flag will be removed,

Figure 8-39. Flag Parameters

Flag Requesters
Double click any flag to open the Flag Requester Tor that flag. Depending on the flag
type, the Flag Requester will have the following elements:
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Time Field

The time field allows you adjust a flag's location from the keyboard. If youtypea
new time in the Time field and hit the return key, the flag will move to the new
position. This is a quick way to move a flag to an exact time.

NOTE

You can change the time unit from Cue List Preferences in the Options ment.

Show Button

The Show button lets you move the time line so that the flag is visible. Since it's
usually more useful to see more of the ime line to the right of the flag, the Show
button puts the flag about 1/3 of the way from the left edge of the time line.

Comment Field

You can use the Comment field to store a comment for any flag. Locate (function
key) flags will show their comments on the Time Line. Other flags won't show their
comments on the Time Line.

It can be very useful to add a comments to Locate flags. You can create commented
Locate flags to mark the beginnings of scenes in a video, or to mark the beginnings of
sections. such as verses or choruses, in a song. As you work, the flag comments can
help you keep track of where you are.

Remove Button
The Remove button is available only for Locate (function key) flags and the Punch
in/Punch out flags. Use the remove button to remove the flag fram the Time Line.

NOTE

You can add Locate flags by holding down the shift key and typing any of the
function keys or the numeric keys on the numeric keypad. This will create a Locate
flag with the number you typed. The Locate flag is placed on top of the Position flag.

The Name Button

Each track has a Name button. It's on the left side of the Time Line, between the Solo
button and the Selection button. When you first create a track, the Name button will
indicate the type of track you created, either "Audio” or "AREXX".
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Figure 8-40. Audio Track Parameters

Audio Track Parameters

Click the Name button on any Audio track to open the Audio Track Parameters
Requester. Here you can change the name, playback parameters, recording
parameters and display parameters for the track.

MName Field

Use the Name field in the Audio Track Parameters to change the name shown on the
track’s Wame button.

When you first create an audio track, the Name button will read "Audio”, Use the
Name field to change the name to anything you want. For example, you could choose
names like "Dialog", "Music”, "Sound Effects”, "Lead Vocal", or whatever makes
sense for each track.

Type a name into the Name field to name a track. When you hit the return key, the
MName button for the track will be updated with your new name.

Sampling Rate Slider And Arrow Buttons

All samples on an audio track will be played back using one sampling rate for that
track. Use the Sampling Rate slider and the left/right arrow buttons next to the slider
to set the sampling rate for the track.

All tracks played back by the same SunRize card must also be set to the same
sampling rate.

Playback Channel Drop List

The Playback Channel drop list lets you choose which channel the track will use to
play back the audio entries on the track. When vou click the down arrow, it will show
you a list of all the possible playback channels you have available. The number of
channels will depend on the number of SunRize cards installed in your Amiga.

The default choice is "Any". With this choice Studio 16 will use any available
channel to play the audio entries on the track. Unless you want to force the track to
play on a particular SunRize card, you will probably want to use the Any setting.
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If you have multiple SunRize audio cards installed you can specify a channel on a
specific card to force the track to use that card. For example, if you had two AD516
cards, to force the track to play on the second card you could select "AD516 #2 Play
1", That would select the second AD516's first track.

Multiple cards also allow you to use multiple sample rates. You can have different
sampling rates for each card. With a one card system (the most common case), all
tracks would have the same sampling rate.

Record Source Drop List

The Record Source drop list lets you choose which channel the track will listen to
when recording the track. When you click the down arrow, it will show you a list of
all the possible sources you can record. The number of sources will depend on the
number of SunRize cards installed in your Amiga.

The default choice is "None”, If you want to record on the track select an input.

If you have just one AD1012 card, you can choose from Input or Output. Input lets
you record any source connected to the audio input of your AD1012, Output lets you
recard the output of the Time Line. Select Output to bounce tracks together.

If you have a single AD516 card, you can choose from Input L, Input R, Output L,
and Output R. Choosing either input lets you record from any source connected to
that input. To record a stereo source, select two tracks for recording and choose Input
L for one and Input R for the other in each track's Audio Track Parameters.

If you have several SunRize cards installed, you can choose an input or output
channel from any of the cards. Choosing an output channel of a card means that you
will be recording any of the tracks that are set to play through that channel on that
card. For example, if you choose the output of ADS516 #2 Left, you will be setup to
record all the left channel information being played by your second AD516 card.

Record Sample Name Field

Use the Record Sample Name field to type a name for a sample you are about to
record. If you don't change the name, the sample will be named "Untitled".

NOTE

You can change the name of any existing sample in Sample List.

Record Gain Slider
When recording, you can use the Record Gain slider to raise the level of the
incoming signal, if needed.

The Gain slider adjusts the gain of the card's internal input amplifier. This is similar
1o a "record level” on a tape deck. Keep the gain as high as possible without causing
clipping. Clipping occurs when the input signal exceeds the analog to digital
converter's range.
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Clipping is indicated in Meters and Mixer:

B Meters - the digital meter hits the right side and turns red at the end

®  Meters - the scrolling waveform touches the top and bottom of its box
®  Mixer - the peak indicator over the scrolling graph flashes

Chpping causes distortion in your recording. To avoid clipping, reduce the gain with
the Gain slider. When you click the slider, the audio input for that channel will
automatically be monitored, you'll see the input signal on the input VU meter, and
you'll see the input signal on the mixer's metering. Try to feed the highest levels to
the input that you'll be using when yvou record. As you do so, watch the meters and
adjust the input gain for the highest level before clipping. Optionally, if your
recording source has gain control, you can leave the Record Gain Slider at zero and
instead adjust the output of your source for highest gain befare clipping.

All Tracks/This Track Button

This button toggles between "All Tracks” and "This Track”. When in the All Tracks
position, any changes you make 10 the Display controls will affect all the tracks in the
Time Line. When in the This Track position, any changes you make to the Display
controls will only affect the track whose Audio Track Parameters you're editing. The
default setting is This Track,

Selection Column lcon Headings

To the right of the All Tracks/This Track button are two icons. The gray icon
represents unselected entries, while the highlighted icon represents selected entries.
Any selections made in the Display area can be made to affect all entries or just the
selected entries,

The buttons in the Display Area allow you to choose which information is displayed
in entries. Having two options lets you choose to display different information in
selected entries than in unselected entries. For example, you might want to choose to
show more information in selected entries than unselected entries.

Region Name Buttons

Click the first Region Name button to show names in unselected entries. Click the
second Region Name button to choose to show names in selected entries. By default
both of these options are selected.

Start Times Buttons

Click the first Start Time button to show start times in unselected entries. Click the
second Start Time button to choose to show start times in selected entries. Both of
these options default to the deactivated position.

Sample Size Buttons
The third Display option lets you choose whether to show sample size. When you
choose to show sample size, the actual size of the sample will be shown as an
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outlined box even if you've cropped or faded the sample using the Crop or Fade
gadgets. Click the first button to show sample size in unselected entries. Click the
second button to choose to show sample size in selected entries. By default Sample
Size is activated on selected samples only.

Fade Times Buttons

Click the first button to show fade times in unselected entries. Click the second
hutton to choose to show fade times in selected entries. By default Fade Times is
activated on selected samples only.

AREXX Track Parameters

The Time Line gives you AREXX control of other programs through AREXX tracks.
An AREXX track is just like an Audio track except that instead of holding samples,
the AREXX track holds AREXX commands. AREXX is the Amiga's interprocess
communications language,

When you click the Track Name button of an AREXX track, you will see the
AREXX Track Parameters.

Figure B-41. AREXX Track Parameters

This requester lets you name the track and specify the AREXX port name for the
program you want to address from that track.

NOTE

You can learn more about AREXX by reading the AREXX chapter of the
AmigaDOS manual that comes with all versions of AmigaDOS from 2.04 and up.
AREXX is not a part of AmigaDOS versions 1.3 or below. If you have an older
version of AmigaDOS you can buy AREXX separately, but it would be better to
upgrade to the latest version of AmigaDOS since many other improvements have
been made.

Name Field

Use the Name field to name the track. When you first create a track, the Name button
will indicate the type of track you created: "Audio” or "TAREXX". Use the Name
field to change the name to anything you want. For example, you could choose names
like “Triggerl”, "Scenel", or whatever makes sense for what you'll be playing from
each track.

Type a name into the Name field to name a track. When you hit the return key, the
Name button for the track will be updated with your new name.
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Port Field

The Port field lets you specify the name of an AREXX port for the commands in any
entries on the AREXX track to address.

To specify the port name, type it in the Port field and hit return, If the program you
want to address is running, and you entered its port name correctly, the bottom of the
AREXX Track Parameters requester will say “Port Found",

If it says "Could Not Find Port" at the bottom of the AREXX Track Parameters
requester, and the program you want to address isn't running, run the program you
want to address. Then, to test if you can address it, click in the Port field where you
already typed its port name, and hit return. Now it should say "Port Found". If not,
you've entered the port name incorrectly,

NOTE AREXX port names are CASE SENSITIVE! Type the name of the AREXX port just
as it’s listed in the manual of the program you are trying to address. Match the upper
and lower case letters exactly. Otherwise the AREXX contro] from the Time Line
will not work.

An AREXX port is kind of like an ear listening to another program that is also
running on your Amiga. All AREXX commands you trigger from that track will be
sent to the program that listens to the port you specify. If the other program is
running, it will hear your commands. You can use commands that contral that
program and share data with it. By specifying different AREXX port names for
different AREXX tracks, you can control and share data with multiple programs, all
running at the same time as Studio 16,

NOTE The programs to be addressed must be running, or they won't be there to respond to
your commands. Start the other programs before yvou play the Time Line,

[P Auate ||

Figure 8-42. Sound Bulton

Sound Button

At the beginning of each track is the Sound button. When it's on, it looks like a
speaker, For audio tracks, when the Sound button is on (speaker showing), the track's
samples will sound when vou play the Time Line. For AREXX tracks, when the
Sound button is on and the track is playing, the commands in the track’s AREXX
entries will be sent to the program you specified.

When the Sound button is off (no speaker showing), the entire track will be muted. A
muted audio track’s samples will not sound, nor will a muted AREXX track send
commands when the time line is played.

126 Studio 16



User's Manual

The Sound button is great for temporarily turning a track off, For example, you might
copy a track, paste it to create a new track, and then experiment with the new track.
While you experiment you would turn the original track's Sound button off s0 you
hear only the new track. After trying some things on the new track, you can decide if
you like the new version or the original version of the track. and turn the sound
button on for the track you like best and off for the other one. You can then either
remove the track you don't like, or keep it around just in case.

Another example is if you are producing a video in several languages. When making
your final video submasters for each language, you can turn the sound button on for
the track that has the language you need for each submaster, and off for the other
languages.

Yet another example is if you are recording a song. You can record a number of takes
for vocals and instrumental performances. Use the Sound buttons to wrn off tracks
with takes that you are not currently using but might want to keep around as possible
options for later use.

Finally, you might want to temporarily turn off an AREXX track 1o keep from
triggering multimedia actions, like picture viewing, video disk playing or animations,
while working on the soundtrack,

To turn a track’s Sound button on and off, click it with the mouse. When you create a
new track, the Sound bution will be turned on.

NOTE

If you run into a situation where you want to hear only one track, or only a few
tracks, and where it would be time consuming to click all the Sound buttons to set
this up, consider using Solo buttons instead.

[0 _Auaie 1]

Figure 8-43. Solo Button

Solo Button

On the lefi of the Sound button on each track is the Solo button for that track. When
it's on, it displays a pair of headphones.

When you turn it on for a track (headphones showing), only that track will sound
when the time line is played. When you turn it off for a track, that track will sound if
its Sound button is on and no other tracks have their Solo buttons turned on.

To solo a track, click the Solo button for that track. To solo several tracks at once,
shift-click all the Solo buttons on the tracks you want to solo. If any Solo buttons are
on, only those tracks that have their Solo buttons turned on will sound when the time
line is played.

To turn all the Solo buttons off, let go of the shift key and turn any solo button off.

127



Cue List

Chapter 8

128

When any Solo button is on, the Time Line will ignore the settings of the Sound
buttons, When all Solo buttons are off, the Time Line will play the tracks that have
their Sound buttons on,

Solo works the same for AREXX tracks as it does for audio tracks. Soloing an
AREXX track is a good way to test AREXX commands without the distraction of
other tracks running,

Figure 8-44. Track Select Button

Track Select Button

The Track Select button looks like an arrow when it's on. It's the button just right of
the Track Name button. Click the Track Select button when you want to select a track
to cul, copy, paste, remove, duplicate, save or record,

If you want to do any of these things to more than one track at a time, shift-click the
Track Select buttons on multiple tracks to select them all at once.

Track Display Area

The Track Display area is the main area of the Time Line.

'F‘._:;_..'“‘-_':_ = .'.". ar e =i

Figure 8-45. Track Display Area

Here you can see all your entries. You can scroll left and right through time using the
horizontal scroll bar at the bottom, and you can scroll up and down through tracks
using the vertical scroll bar on the right. You can move entries with the mouse and
visually see cross fading between Audio Entries overlapped on the same track. When
you click on an entry to select it, it will change color.
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Figure B-46. Grid Markings

Grid Markings are regular vertical lines marking a regular interval of time. They are
used by the Lock-To-Grid Drag mode, which forces entries and flags to align with
grid markings. They are also handy visual indicators of where you are.

Specify the grid interval with the Set Grid Spacing command in the Options menu.
You can choose from preset grid intervals or specify your own custom grid spacing.

The custom grid spacing option will match the units you choose in the Time Options
section of the Cue List Preferences.

To make a grid that works with Bars/Beats/Clocks:

I. Select the BPM option in the Cue List Preferences,

r3

Enter a tempo and time signature,

3. Activate Set Grid Spacing to specify a custom grid.
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Figure 8-47. Time Code Markings

Time Code Markings

Along the bottom of the Time Line are numbers marking where you are in time.
Think of them as your "time ruler”. You can choose the units these numbers will use
from the Time Options in the Cue List Preferences. Choose from:

m  Hours/Minutes/Seconds

®  SMPTE, (Hours/Minutes/Seconds/Frames)

®  SMPTE Plus, (SMPTE with 1/100ths of a frame)
m  BPM - Beats Per Minute, (Bars/Beats/Clocks)
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Figure B-48. Zoom Field

Zoom Field

You can use the Zoom field to type an exact amount of time you want to see in the
visible width of the Time Line, without scrolling. You can't specify more time than is
available between the Time Line's start time and end time. Set the start time and end
time in the Cue List Preferences.

You can also choose the units the Zoom field will use from the Time Options in the
Cue List Preferences. Choose from:

B Hours™linutes/Seconds

®  S5MPTE, (Hours/Minutes/Seconds/Frames)

m  SMPTE Plus, (SMPTE with 1/100ths of a frame)
®  BPM - Beats Per Minute, (Bars/Beats/Clocks)

Open Cue List Preferences from the Options menu.
o

Figure 4-489. Zoom Arrows

Zoom Arrows
Keyboard Shortcut: Up and down arrow keys

The Zoom Arrows let vou show less time (zoom in) or more ume (zoom out) in the
visible width of the Time Line, without scrolling. Click the Up Arrow button to zoom
out and the Down Arrow button to zoom in.

In the Time Line the smallest unit you'll actually see depends on the time option
you've chosen in Cue List Preferences . For example, if you've chosen SMPTE in the
Time Options, the smallest displayed unit is 1/30th of a second (1 video frame). If
you choose the SMPTE Plus option the smallest unit you'll see is 1/100th of a frame.
The displayed unit is rounded up from the actual resolution of Studio 16,

Resolution refers to the degree of detail that can be seen and edited. Studio 16 has an
actual resolution of a single sample for Audio tracks, which at a sampling rate of
48KHz is 1/48,000th of a second. The resolution is even greater for AREXX tracks,
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Figure 8-50. Scroll Bars

Scroll Bars

Keyboard Shortcut: Left and Right arrow keys

Use the left arrow on the keyboard to scroll to the left, and the right arrow to scroll to
the right. Unlike just moving the scrall bar, these kevboard shortcuts also move the
Position flag so it stays about a third of the way from the left edge of the Time Line,

When you're zoomed in on the Time Line's view, you can use the horizontal scroll
har at the bottom of the time line to scroll forward or backward in time between the
start time and end time boundaries.

s Move forward - drag the scroll bar to the right (right arrow key)

m  Move backward - drag the scroll bar to the left (left arrow key)

If the Time Line is zoomed clear out so the scroll bar is a solid bar, you are seeing
the entire view of the Time Line and the horizontal scroll bar will not have an effect.

Entry Features

One of the key concepts in the Time Line is that of "entries”. An entry is a visual
element representing either a sample, called an Audio Entry, or a list of AREXX
commands, called an AREXX Entry.

Audio Entries

Audio Entries are rectangular, but they can change their shapes to indicate fade-ins,
fade-outs or cross fades. You can drag an Audio Entry, either forward or backward in
time, or up and down to move it from one Audio track to another. If you hold down
the Control key and drag an Audio Entry, the original entry will remain and you will
drag a duplicate entry.

NOTE

Control-drag an entry to duplicate it.

If you drag one Audio Entry over another on the same track they will automatically
cross fade. When they cross fade you will see a visual indication of the cross fade
area. If you click a cross fade area you can change its curve types in the Cross fade
Type requester,

When you click an Audio Entry to select it, you'll see four small rectangles appear.
The ones that are on each end, but not in the corners, are the Crop gadgets. You can
drag them to crop the beginning or end of the sample. The squares at the upper
corners of an Audio Entry are the Fade gadgets. You can drag them to quickly create
fade-ins or fade-outs. The actions of the Crop and Fade gadgets are non-destructive!
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You can choose to have Audio Entries display their start and end times, fade times,
sample size outlines, and sample or sample region names by setting the display
controls in the Audio Track Parameters. Click the Track Name button for a track to
see its Audio Track Parameters,

Audio Entry gadgets

Figure 8-51. Crop Gadgeis

Crop Gadgets Click an Audio entry to select it. You'll see the entry change
color, and you'll see four small boxes appear. The two boxes
on each end of the entry (not the ones on the top corners) are
called the Crop Gadgets,

To crop the beginning of a sample drag the Crop gadget on
the left edge of the entry. To crop the end of a sample, drag
the Crop gadget on the right edge of the entry.

You can't drag a Crop gadget beyond the length of the
original entry. You can only shorten the sample to crop off
the beginning or end, or restore what you've cropped.
Cropping can be very useful for removing unwanted noise at
the beginning or end of a sample.

Cropping done in the Time Line is non-destructive. It does
not affect the original sample data on your hard drive, so you
can experiment and make changes as often as you want. If
you change your mind, simply move the Crop gadgets again
until you're satisfied with the result.

Figure 8-52. Fade Gadgets

Fade Gadgets Click an Audio entry to select it. You'll see the entry change
color, and vou'll see four small boxes appear. The two boxes
on the top corners are called the Fade Gadgets,

To fade in the beginning of the sample, drag the Fade gadger
on the left edge of the entry. To fade out the end of a sample,
drag the Fade gadget on the right edge of the entry. You can

only drag a Fade padget inward, toward the entry. When you
do so you will be adjusting the fade-in time for the beginning
or the fade-out time for the end,
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Fading done in the Time Line is non-destructive. It does
nothing to the original sample data on your hard drive, so you
can experiment and make changes as often as you want. If
you change your mind, simply move the Fade gadgets again
until you're satisfied with the result.

Audio Event Parameters Requester

Double click an Audio Entry to open the Audio Event Parameters for the entry. You
can make many adjustments to an entry here.

Play the sample

Replace the sample

Change the start or end time

Adjust the fade-in or fade-out times
Change the fade-in or fade-out curve types
Adjust the pan (if you have an AD516)
Adjust the volume

Load the sample in an Editor

Audio Event Parameters

Sample Field

The Sample field shows the path to the sample being used by
the Audio Entry. A path is a description of the location of the
sample file on your hard drive. The path will start with the
name of the hard drive partition, which will end with a colon.
Then you'll see the names of any drawers the sample is i,
each separated by a slash. Finally, you'll see the name of the
sample or sample region itself.

NOTE

The Cue Lists you save from the Time Line do not store the actual sample data for
samples used by Audio Entries. Cue Lists save the path to each sample, as shown in

the Sample field.
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Start Time Field

End Time Field

If you want to change the sample being used by an Audio
Entry, you can drag a different sample from Sample List and
drop it onto the Sample field. The new sample will replace
the old sample for that Audio Entry. This can be a quick way
to try different sound effects at the same spot in your
soundirack.

The Start Time field shows the time when the sample begins,
It uses the units set in Cue List Preferences,

You can type a new time into this field to move the start time
of the sample to an exact time. Since the sample length
remains constant, when you change either the Start Time or
the End Time, the other time will also change.

The End Time field shows the time where the sample finishes,
Type a new time into this field to move the end time of the
sample to an exact time, Since the sample length remains
constant, when you change either the Start Time or the End
Time, the other time will also change,

Fade In and Fade Out

Fields

The Fade In and Fade Out fields show the fade time for the
sample. It uses the units set in Cue List Preferences.

You can type a new time into Fade In to adjust the time it
takes from the initial sample playback to where the sample is
playing at full volume. Initial sample playback will begin at
the start of the sample unless the sample has been cropped.

You can type a new time into Fade out to adjust the time it
takes fade the sample from full volume to silence.

Fade In and Fade Out

Curves

134

You ¢an choose from any of four curve types. Choose a curve
type to specify how the sample will fade in or out, There are
four curve types:

B Linear

® Logarithmic

®  Exponential

| [nstant

Linear
A linear fade changes the volume of the sample at a constant
rate.
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Pan Slider

Logarithmic

A Logarithmic fade in at the beginning of a sample changes
the volume quickly at first, but it changes itat a decreasing
rate, easing into full volume. It gains more than half its
volume in the first third of the overlap area. Use this for the
fade in curve type when you want the sample to become
prominent quickly.

A Logarithmic fade at the end of a sample changes the
volume only a little at first, but it changes it at an increasing
rate, losing more than half the volume in the last third of the
overlap area. Use the Logarithmic fade out curve type when
you want the sample to slowly become less prominent during
the fade

Exponential

An Exponential fade at the beginning of a sample changes the
volume only a little at first, but it changes it at an increasing
rate, gaining more than half its volume in the last third of the
overlap area. Use this for the fade in curve type when you
want the sample to become prominent slowly.

An Exponential fade at the end of a sample changes the
volume quickly at first, but it changes itata decreasing rate,
easing into the complete fade out. Use this for the fade out
curve type when you want the sample to quickly become less
prominent during the fade.

Instant

An Instant fade at the beginning of a sample changes the
volume of a sample instantly from full off to full on. This is
the same as dragging the entry’s left Fade gadget clear to the
left. You can use this to temporarily turn a fade-in off without
losing the position of the left Fade gadget.

An Instant fade at the end of a sample changes the volume of
the sample instantly from full on to full off. Use this for the
fade out curve type when you want the sample to play at full
volume to its end, with no fade. This is the same as dragging
the entry's right Fade gadget clear to the right. You can use
this if to temporarily turn a fade-out off without losing the
position of the right Fade gadget.

If you have an AD516 card you can use the Pan slider, a
horizontal slider near the bottom of the Audio Event
Parameters requester, to select either left output, right output,
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Volume Slider

OK Button

Play Button

Edit Button
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or anywhere in between for Audio Entry playback. The more
you slide the slider to the left, the more the Audio Entry will
be sent to the left output. The more you slide the slider to the
right the more the Audio Entry will be sent to the right output,
Sliding the slider Full Left or Full Right will send the Audio
Entry out of only one output,

As you slide the slider it will read in dB increments. If you
click on either side of the slider knob but within the slider
area, the slider will move toward the mouse 1dB per click,
The Pan slider for one Audio Entry will not affect the same
sample when it's used in another Audio Entry, whethet in the
same Cue List or in other Cue Lists.

The Pan slider setting will have no effect if the Use Mixer
Levels command is selected in the Options menu,

You can use the Volume slider, a vertical slider on the right
of the Audio Event Parameters requester, to raise or lower the
volume of the Audio Entry when it's played back in the Time
Line. The Volume slider for one Audio Entry will not affect
the same sample when it's used in another Audio Entry,
whether in the same Cue List or in other Cue Lists,

As you move the slider it will read in 1/2 dB increments. If
you click above or below the slider knob but within the shider
area, the slider will move toward the mouse 1/4 dB per click.
Here are some dB examples:

+6dBs = 200% volume

0dBs = 100% volume
-06dBs =  50% volume
-12dBs =  25% volume

The Volume slider setting will have no effect if the Use
Mixer Levels command is selected in the Options menu.

Click the OK button to accept any changes made in Audio
Event Parameters.

Click the Play button to hear the Audio Entry.

Click the Edit button to open an Editor for precision editing
of the Audio Entry's sample.

Studio 16



User's Manual

Edits made in an Editor will change the actual sample. If the
same sample is used in other Audio Entries, in the same Cue
List or other Cue Lists, the edits you make will affect those
other Audio Entries.

You should consider making a copy of the sample under
another name in the Sample List and importing the copy into
the Audio Entry by dragging it from the Sample List onto the
Sample field at the top of the Audio Event Parameters
requester. That will insure that you have a unique sample for
that entry and you can edit it without worrying about affecting
other Audio Entries.

Cancel Button Click the Cancel button to reject any changes you made n
Audio Event Parameters and revert the Audio Entry to its
previous settings,

AREXX Entries

An AREXX Entry is shaped like a vertical line with a small square in the middle of

the line. The line aligns with the time when the AREXX Entry's AREXX commands
will be sent when you play the Time Line.

NOTE

Using the Time Code Add command is the only way to add AREXX entries.

Double click the square to open AREXX Event Parameter, where you can type the
AREXX commands for the Entry, type a new time, test the AREXX commands, and
give the AREXX entry a name that will be visible in the Time Line.

You can also drag an AREXX Entry by the square, either forward or backward in
time, or up and down to move it from one AREXX track to another. If you hold down
the Control key and drag an AREXX Entry, the original entry will remain and you
will drag a duplicate entry.

AREXX Entry Parameters

Double click an AREXX entry to open AREXX Event Parameters. Here you can.

s Name the AREXX entry

m  Change the time

m  Specify the AREXX commands for the entry

m  Test the AREXX commands
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Figure B-54. AREXX Event Parameters

Name Field To have a name show up in the Time Line next to the
AREXX entry, type that name here. This is optional,

Time Field The Time field shows the current location of the AREXX
entry in ime. You can type a new time here to specify an
exact time for the entry.

The Time field uses whatever units are selected in Cue List
Preferences. Open Cue List Preferences from the Options
menu,

Test Cond Button Click the Test Cmd button to test all the commands you've
entered into the Cmd| through Cmd9 fields. This is an casy
way to see if they are doing what you want without having to
play the Time Line.

NOTE The program you're sending the commands to must be running, and the track must be
addressing that program’s AREXX port. To specify the AREXX port for a track, type
an AREXX port name in the Name field of AREXX Track Parameters. Click the
track's Name button to bring up this requester.

Cmd]1 through Cmd?9

Fields In each of the Command fields, labeled Cmd] through Cmd9,
you can enter a separate AREXX command for the program
you're addressing on the track. It doesn't matter if vou leave
some of them blank. However, because AREXX commands
are case sensitive, you must type them in exactly as written in
the program's manual,

The commands you can use depends on which program you're
addressing. Look in the manual for the program you're
addressing to find out which commands it responds to and
how to use them.
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When the Time Line plays and the Position flag passes the

AREXX Entry, the commands in the Cmd1-Cmd?9 fields will
be sent to the program whose AREXX port specified for that
track. The commands are sent in order, starting with Cmd-1.

Menus
Cue List Menu

New Use the New command to open your Default.cue file.
Keyboard Shortcut:  A-N

You can save any setup into the Default.cue file by creating a
blank Cue List then using Save Default.

Typically you'll save an empty Cue List, with perhaps a few
blank audio and AREXX tracks, as your Default.cue file.
Then when you use the New command, you'll have a blank
Cue List that you can use (o start a new project.

If you haven't saved your own default file, the Default.Cue
supplied with Studio 16 is an empty list with four audio tracks
set to a 44.1KHz sampling rate.

Open Use the Open command to open an existing Cue List file into
the Time Line.

Keyboard Shortcut: ~ A-O

When you use the Open command, a file requester will
appear that allows you to choose a Cue List file to load. It
defaults to the Studiol6_3:CueLists/ drawer.

Figure 8-55. Cue List Load File Requesler

NOTE You may want to create drawers within your Studiol6_3:CueLists/ drawer for
different projects. Remember that AmigaDOS lets you create drawers within drawers
within drawers. For more information check your Amiga's manual.
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If you store Cue Lists somewhere other than inside the
Studiol6_3:CueLists/ drawer, you can use the file requester
and navigate to where your Cue Lists are and then choose the
Cue List file to load.

Change the default drawer:

. Select a new drawer for your Cue Lists in the requester,

2. Close the requester.

ek

Select Save Setup from the Project menu.  It's best to do
this when you first start up Studio 16, before you've
loaded any Cue Lists into the Time Line or made any
other changes to your default setup, Otherwise you may
inﬂd"-'{‘rlcntl_z.' save changes o :r'{‘II]I' Cusiom H.I:.‘".l.p.

Merge Use the Merge command to combine two Cue Lists into one.

This lets you work on sections of large projects in separate
Cue Lists that you can later combine for the final mix,

To Merge two Cue Lists:

|.  Load one Cue List with the Open menu item.

2. Choose the Merge menu item. A Merge file requester
will appear,

3. Choose a second Cue List to merge with the first,

4. Click the OK button. The two Cue Lists will be merged
in the Time Line.

L

Select Auto Size Cue List (A-A)

6. Save the new Cue List, preferably under a new name.
To merge more than two Cue Lists, merge two lists as above,
then continue to use the Merge command to add the
additional lists to the Time Line. When you're done, save the
new Cue List,

Save Use the Save command when you want to save the current
Cue List in the Time Line,

Keyboard Shortcut:  A-W
If you haven't saved the list before, the Save command works
like Save As and brings up a file requester where you can
name the Cue List file. (See Save As below.)

Onee you've named and saved the Cue List, using the Save
command will save the current state of the Cue List over the
same file, without bringing up the file requester.
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Save As
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Saving to your hard drive preserves your work so you can
reload it later, the next time you want to use that Cue List. To
open a Cue List file into the Time Line, use the Open
command in the Cue List menu.

Use the Save As command to save a Cue List file under a new
name. It will save all the information in your Cue List to a
file, with the a ".cue" extender.

The Save As command saves a new Cue List. It will also let
you save an existing Cue List under a different name. The
latter can be very useful if you want to keep one version of a
Cue List around while you experiment on another version.

I ELE

T ER A T

==

Figure 8-56.

Cue List Save File Requester

Save Default

Type a file name in the File field and click the OK button to
save the Time Line to a Cue List file. If you decide not to
save the Cue List, click the Abort button.

Once you've save a Time Line to a Cue List file, you can use
the Open command in the Cue List menu to reload the Cue
List at any time.

Unless you change the default directory, Studio 16 will look
in the Studiol6_3:CueLists/ drawer. You can change the
default directory by selecting a different directory in the file
requester and then using the Save Setup command in the
Project menu. Be aware that the Save Setup command saves
other startup information as well.

Use the Save Default command to save your own Default.Cue
file. The Default.Cue file is opened automatically when you
select New from the Cue List menu.

Typically you'll want to save an empty Cue List, with a few
blank Audio and AREXX tracks, as your Default.Cue Cue
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List. Then when you use the New command, you'll have a
blank Cue List that you can use to start a new project.
The Save Default command saves:

Tracks

Entries

Sound, solo and track selection settings

Drag mode

Edit mode

Cue List Preferences

Locate flags

NOTE Cue Lists, including the Default.Cue, do not save window size and position. To save
the initial size and position of any open Studio 16 windows, use the SaveSetup
command in the Project menu,

Print To File The Print To File command lets you save a reference list of
your Cue List in ASCII text format, The file includes:

Number

Sample Name

Track Name

Start Time

End Time

ASCII text is a standard format that can be loaded into word
processors on any personal computer.  If you send a floppy
disk to someone who doesn't use an Amiga, use an IBM
format disk. The ability to format a disk in IBM format is
included in AmigaDOS 2,1 or greater.

Track Menu

The Time Line gives you the flexibility to add enough tracks to keep your projects
organized. For example, you can have a track for an announcer, perhaps a pair of
tracks for stereo music, several sound effects wracks, and other tracks as needed for
wild sound, dialog, or whatever. It's handy to group similar types of sounds onto
tracks. That way it's easy to mute or solo similar sounds using the Sound and Solo
buttons that are available for each track.

For example, if you put all the final narrator samples for a video onto a single track,
you can 1solate the narrator with the solo button on that track. Then you will hear just
the narration and you can insure there are no pops or noise problems that need
editing.

142 Studio 16



It's also handy to copy tracks for backups while you expeniment on the original
tracks. You can keep adding tracks if you don't exceed the sample playback
capabilities of your hardware,

NOTE You can combine multiple tracks by recording the output of the Time Line onto new
tracks. Then mute the old tracks and play the new tracks instead. Keep the old tracks
around, in case you need to make changes later.

Add Track Use the Add Track command to add a track to the Time Line,
You will be able to choose which type of track to add
The track types currently supported are:
m Audio tracks
®  AREXX tracks
When you use the Add Track command, you will see the
Type Of Track To Add requester.

:F-I-..I:. — — £ -.... . . — -

fAudio I

AREXX 4
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Figure 8-57. Type of Track to Add
Click Audio to add an audio track, AREXX to add an
AREXX track, or Cancel.
You can add as many as 100 tracks to the Time Line. Keep
in mind that you will only actually be able to play as many
simultaneous samples as your SunRize hardware will support.

NOTE The AD1012 card can play up to four sounds simultaneously and the AD516 card

can play up to eight sounds simultaneously depending on your system configuration.
You can combine cards to play more simultaneous sounds.

User's Manual

AREXX Tracks

The Time Line can trigger actions in other programs via
AREXX, the Amiga's flexible interprocess communications
language. You can use AREXX to:

®  Play animations

s Control the Video Toaster
m  Control laser disk players
m  Control video decks

m  Display pictures

143



Cue List chapters

® Control lighting
B Trigger pyrotechnic effects

Multitasking and AREXX

Unlike some personal computers that use the Macintosh
Operating System or Windows/MSDOS, the Amiga has an
operating system that is preemptively multitasking. That
means that programs made by different software companies
will normally be able to run at the same time, without any
extra effort on the part of the developers. The multitasking is
managed transparently by the operating system itself. Like on
a UNIX workstation, switching from one Amiga program to
another will not normally cause the first program to stop
running,

NOTE An exception is the Video Toaster, which takes over the Amiga for mast transition
effects. To use Studio 16 with the Toaster, consider using the Toaster Handler option
tfrom SunRize,

Because it's normal to have multiple programs running
simultanzously on the Amiga, the AREXX language was
added to the operating system to allow simultaneously
running programs to talk to each other, share data, and
control each other. AREXX 15 a version of the REXX
language, a language that can be found on mainframe
computers and has been more recently been supported by
IBM's O8/2 operating system.

The Time Line gives you an open window to AREXX control
of other programs through its AREXX tracks. An AREXX
track is just like an Audio track except that instead of holding
Audio entries, the AREXX track holds AREXX entries. An
AREXX entry can hold up to nine commands.

Add AREXX entries to an AREXX track by selecting the
track and using Timecode Add in the Entry menu. Timecode
Add will add a blank entry at the location of the Position flag.
If the Time Line is playing. the Position flag will be moving,
so you can place entries on-the-fly.

NOTE Using the Time Code Add command is the only way to add AREXX entries.

Double click on an AREXX entry to open AREXX Event
Parameters,
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Figure 8-58.

AREXX Event Parameters

Add Audio Track

Keyboard Shortcut

Remove Track(s)

User's Manual

Here vou can type commands to be sent to the program that
listens to the AREXX port you specified for that track. Each
program you address will have its own set of AREXX
commands. Check the documentation for each program you
want to control to find out the commands it supports and how
1o use them.

You can specify the AREXX port name for an AREXX track
by clicking the Track Name button and entering in the Port
Name field in AREXX Track Parameters.

AREXX tracks can be muted by turning off their Sound
buttons, and they can be isolated with their Solo buttons, just
like audio tracks.

You can learn more about AREXX by reading the AREXX
chapter of the AmigaDOS manual that comes with all
versions of AmigaDOS from 2.04 and up. AREXX is not a
part of AmigaDOS versions 1.3 or below. If you have an
older version of AmigaDOS3 you can buy AREXX separately,
but it would be better to upgrade to the latest version of
AmigaDOS since many other improvements have been made.

You can use the Add Audio Track command to add an audio
track to the Time Line. It's just like using the Add Track
command, except that it doesn't ask you what kind of track to
add. This is a very fast way to add audio tracks.

A-+

Use the Remove Track command to remove any selected
tracks from the Time Line. Use this to remove:.

m  Old backup tracks you no longer need
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Duplicate Track(s)

Cut Trackis)

Keyboard Shortcut:
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®  Empty tracks vou never used
®  Experimental tracks you didn't like
B Any other track that you no longer want

Remove Track does not delete any of the samples used in the
selected tracks. The samples will still be available in Sample
List. If you want to delete actual sample data, use Delete in
the Entry Menu or from Sample List.

To select a track for removal, click its Track Selection button,
which is to the right of the Track Name button. The Track
Selection button turns into an arrow when selected. To select
maore than one track, hold down the shift key and click the
Track Selection buttons of all the tracks you want to select.
Once you've selected the track or tracks you want to remove,
select Remove Track.

Use the Duplicate Track command to add copies of tracks to
the Time Line. You can use this to make copies of tracks for
experimentation, The original tracks then remain untouched
in case you need them again.

Duplicate does not create any new copies of the actual
samples. The new track or tracks will play the same samples
as the original track or tracks,

To select a track, click its Track Selection button, which is to
the right of the Track Name button. The Track Selection
button turns into an arrow when selected. To select more than
one track, hold down the shift key and click the Track
Selection buttons of all the tracks you want to select.

Once you've selected the track or tracks you want to
duplicate, use Duplicate Tracks to add the duplicate tracks to
the Time Line.

Cut Track temporarily removes any selected tracks from the
Time Line. It works just like the Remove Track command
with one exception. The Tracks you cut are kept in the Paste
buffer, and you can use the Paste command to add them back
to the Time Line. You can't see the contents of the Paste
buffer, but it always holds the last set of cut or copied tracks.

A-X

This can be handy for changing the order of tracks. To move
a track, select it with the Track Select button, cut it into the
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Paste buffer with the Cut Track command, select the track
above where you want the cut track to be moved, and use the
Paste Track command to paste the track back in.

The Cut Track command also lets you group tracks together.
Suppose you had a bunch of guitar tracks scattered among
other tracks in the Time Line. You can organize them with the
following steps.

Shift-click to select all the guitar tracks.
Select Cut Track (A-X) to move them to the Paste buffer.

L b —

Select the track you'd like all the guitar tracks to be

below.

4. Select Paste Track (A-V) to put them there. Now all the
guitar tracks are together. You can do this with any
similar audio or AREXX tracks in your projects to keep
yourself organized.

Cut Track does not delete any of the samples used in the

selected tracks. The samples are available in Sample List. If

you want to delete actual samples, use Delete in the Entry

Menu or in Sample List.

Ta select a track, click its Track Selection button, which is to
the right of the Track Name button, The Track Selection
butten turns into an arrow when selected.

To select mare than one track hold down the shift key and
click the Track Selection buttons of all the tracks you want to
select, Once you've selected the track or tracks you want to
remove, use the Cut Tracks command to remove them from
the Time Line and add them to the Paste buffer. Then you can
use the Paste Track command to add the tracks back to the
Time Line below the last selected track.

WARNING If you use the Cut or Copy Track command again before placing any tracks you
previously cut, those tracks will be lost. The Paste buffer can hold only one set of cut
or copied tracks at a time.

Copy Tracki(s)

Keyboard Shortcut:

User's Manual

Use the Copy Track command to put a copy of the selected
tracks into the Paste buffer. Then you can use the Paste
command to add the copies back into the Time Line.

A-C

This can be handy for creating a copy of a track for
experimentation. By experimenting on a copy, you'll still have
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Paste Track(s)

Keyboard Shortcut:

Load Tracki(s)
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the original around if you don't like the changes you made to
the copy.

You can't see the contents of the Paste buffer, but it always
holds the last set of cut or copied tracks,

To copy a track, select it with the Track Select button, copy it
into the Paste buffer with the Copy Track command, select
the track above where you want the copy of the track to be
placed, and use the Paste Track command to paste the copy
into the Time Line.

Use the Paste Track command to paste the contents of the
Paste buffer back into the Time Line, just below the last
selected track. You can't see the contents of the Paste buffer,
but 1t always holds the last set of cut or copied tracks.

AV

This can be handy for changing the order of tracks. To move
a track, select it with the Track Select button, cut it into the
Paste buffer with the Cut Track command, select the track
above where you want the cut track 1o be moved, and use the
Paste Track command to paste the track back in.

The Paste Track command also lets you group tracks
together. Suppose you had a bunch of guitar tracks scattered
among other tracks in the Time Line. Organize the tracks
with the following steps,

Shift-click to select all the guitar tracks.
Select Cut Track (A-X) to move them to the Paste buffer.

TSN S

Select the track you'd like all the guitar tracks 1o be

below,

4. Select Paste Track (A-V) to put them there. Now all the
guitar tracks are together. You can do this with any
similar audio or AREXX tracks in your projects to keep
yourself organized.

To select a track, click its Track Selection button, which is to

the right of the Track Name button. The Track Selection

button turns into an arrow when selected.

The Save Track and Load Track commands give vou a handy
way to copy tracks from one Cue List to another,
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Save Track(s)

Use the Load Track command to load tracks into the Time
Line. This command loads track files you've saved using the
Save Track command

When you use the Load Track command it will bring up the
Load Track file requester. Select the file name of the track
you want to load and click the OK button to load the track, If
you decide not to load any tracks, click the Abort button.

Unless you change the default directory, the Load Track
requester will be in the Studiol6_3:CueLists/T: racks/ drawer.
You can change this default directory by selecting a different
directory in the file requester and then using the Save Setup
command in the Project menu. Be aware that the Save Setup
command also saves other startup information.

Save Track and Load Track give you a handy way 1o copy
tracks from one Cue List to another. Select any tracks you
want to save, and then use the Save Track command to save
the selected tracks to a file. When you use the Save Track
command it will bring up the Save Track file requester.

Figure 8-59.

Save Track File Requester

Type a file name in the File field and click the OK button to

save the selected tracks. This will save the file with the name
you gave it plus an extender of ".Track". If you decide not to
save the selected tracks, click the Abort button.

After you've opened another Cue List with the Open
command in the Cue List menu, you can use the Load Track
command to load saved tracks into that Cue List.

Unless you change the default directory, it will be looking in
the Studio16_3:CueLists/Tracks/ drawer. You can change this
default directory by selecting a different directory in the file
requester and then using the Save Setup command in the
Project menu. Be aware that the Save Setup command also
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Entry Menu

Select All

Select All On Track

Deselect All

Offset Selected

150

saves which windows are open and where they are, the screen
colors, and other startup information,

Use the Select All command to select each of the Audio
Entries and AREXX Entries in the Time Line.

Select All and Offset Selected are often used to shift all
entries in the Cue List,

Use the Select All On Track command to select all the Audio
Entries and AREXX Entries on any selected tracks.

Select a track by clicking its Track Selection button, which is
on the night side of the Track Name button and looks like an
arrow when it's selected. If you want to select more than one
track, shifi-click the Track Selection buttons on the tracks you
want to select.

Use the Deselect command to instantly deselect all the Audio
Entries and AREXX Entries in the Time Line.

Use the Offset Selected command to move the start and end
times of all the selected Audio Entries and AREXX Entries
by a set amount.

Select the Entries to move.
Select the Offset Selected menu item.

L b

Type a positive or negative number as an offset. The

display units are set in Cue List Preferences.

4. Click the close gadget and the selected entries will move
by the amount specified,

If you moved the entries out of the start time-end time range

of the Time Line, use the Auto Size Cue List command in the

Options menu and you'll be able to see the entries again. You

may have to scroll or zoom to see them,

If you need to move everything in the Cue List to match the
time code on a different master video tape;

1. Use the Select All command to select all the entries in
the Cue List,

Use the Offset Selected command to add or subtract time
from all of them in order to match the time code on the
new master ll'lFI-E.

]
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Time Code Add

Keyboard Shortcut:

3. If you change your mind, use Undo Edit (A-Z) to revert
the entries to their original times.

Use the Time Code Add command to add blank entries at the

Position flag.

A-T

Audio Tracks

For example, if you select an Audio track, the Time Code
Add command will add a blank Audio Entry that starts at the
Position flag. If the Time Line is playing, you can add a series
of blank Audio Entries by repeatedly using the Time Code
Add command.

This turns out to be very useful if you're synchronized to
video, with the SMPTE output of your video deck connected
to the SMPTE input of vour SunRize card. You can then
watch the video, and use the Time Code Add command to put
a blank Audio Entry at every place you want a sound effect.
The keyboard shortcut (A-T) makes this easy. Then you can
double click each blank entry to open Audio Event
Parameters, and drag the sound effect you want for that entry
onto the Sample field.

AREXX Track

If you select an AREXX track, the Time Code Add command
will add a blank AREXX Entry where the Position flag 1s
parked. This is the only way to add an AREXX entry. Then
you can double click the AREXX Entry to open AREXX
Event Parameters, where you can type the AREXX
commands you want to send from that AREXX Entry.

NOTE Using the Time Code Add command is the only way to add AREXX entries.

User's Manual

Don't forget to specify the AREXX port for the AREXX
track. Click the Track Name button to open Track
Parameters, and then type the name of the AREXX port in the
Port field. AREXX port names are case sensitive, so type the
name of the AREXX port exactly the way it's written in the
manual of the program you want to control. Otherwise the
program will not respond.

You can shift-click multiple tracks before you use the Time
Code Add command. Then when you use the Time Code Add
command it will add blank entries at the position flag time on
all the selected tracks at once. You can even add AREXX
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Remove Selected

Keyboard Shortcun:

Delete Selected

Keyboard Shortcut:

Entries and Audio Entries at the same time by selecting both
types of tracks before using the Time Code Add command.

Use the Remove Selected command to remove all selected
Audio Entries and AREXX Entries from the Time Line.

Delete key

The actual samples will NOT be deleted from your hard
drive; they will still be available in Sample List.

If you change your mind, use the Undo Edit command in the
Options menu and the entries will reappear in the Time Line.

To make a blank Cue List that has the track structure of the
Cue List you started with use Select All and then Remove
Selected. You can then use the Save Default command in the
Cue List menu to save that blank Cue List as your default Cue
List; the one that's loaded when you use the New command in
the Cue List menu.

Use the Delete Selected command to permanently delete all
selected Audio and AREXX Entries,

A-D

WARNING Delete permanently removes samples from your hard drive. Undo does NOT
reverse Delete Selected.

Group

Keyboard Shortcut;

Ungroup

Keyboard Shortout:
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The Group command combines entries so when you select
one entry, all the entries in the group will be selected.

A-G

If you move one entry in a group, they will all move together.
You can move entries by dragging them with the mouse or by
using the Offset Selected command in the Entry menu.

This is very handy for keeping stereo pairs of Audio Entries
in syne when you move them. It's also useful for keeping all
the Audio Entries in a section synchronized if you have to

move them to match editing changes made in a video.

If you want to remove an entry from a group, click an entry of
the group and use the Ungroup command. Now all the entries
in the group are no longer grouped.

A-U
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Ungroup All

Play Selected

Keyboard Shortcut:

Stop Playback

Keyboard Shortcut:

Edit Selected

Keyboard Shortcut:
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“This is useful when you want to click on one of the entries
and use commands like Play Selected and Edit Selected in the
Entry menu, commands that don't work with groups.

The Ungroup command is also necessary if you want to take
some of the entries in one group and recombine them with
other entries into a different group. In that case ungroup the
first group before you create the second group.

Use the Ungroup All command to take all entries in the entire
Time Line out of any groups that may exist. Once you've used
the Ungroup All command, there will be no groups in the
Time Line,

If you want to hear a single Audio Entry, click it to select it
and use the Play Selected command. The Entry will play. The
Playback will include the effect of any cropping you may
have done with the Crop gadgets and fades you may have set
with the Fade gadgets.

A-P

This is a good way to audition the effect of different crop
amounts, fade times and curves.

Play Selected will not work if the Entry is part of a group.Use
the Ungroup command in the Entry menu after you selected
it, or double click the entry to open Audio Event Parameters
and click the Play button,

This option cancels the Play Selected option.
A-S

If you want to edit the sample in an Audio Entry, click the
entry to select it and use the Edit Selected command. The
sample will open into the Editor.

A-E

Edit Selected will not work if the Entry is part of a group. If it
is part of a group you can either use the Ungroup command in
the Entry menu after you selected it, or double click the entry
to open Audio Event Parameters and click the Edit button.
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WARNING Edits you make in an Editor will change the actual sample. If the same sample is
used in other Audio Entries, in the same Cue List or other Cue Lists, the edits you
make will affect those other Audio Entries!

You should consider making a copy of the sample under
another name in the Sample List and importing the copy into
the Audio Entry by dragging it from the Sample List onto the
Sample field at the top of the Audio Event Parameters
requester. That will ensure that you have a unique sample for
that entry and you can edit it without worrying about affecting
other Audio Entries.

Options Menu
Cue List Preferences

The Cue List Preferences requester lets you change aspects of the appearance and
behavior of the Time Line, including:

n- _.._'*. S
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Figure 8-80. Cue List Preferences

Displays warnings for certain actions
Appearance of highlighted tracks
Appearance of selected tracks

How the Time Line scrolls

Which time units are displayed
Number of Undo levels

Start and end time display boundaries
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Figure 6-61.

Digplay Options

Display Options

Display Warnings
If you have Display Warnings checked, the Time Line will
warn you before it does certain actions.

For example, if you drag a sample between tracks that are set
at a different sampling rate, you will get a warning that the
sampling rate will be changed only if Display Warnings is
checked. Otherwise the sampling rate will automatically be
changed without notifying you.

As another example, if you change the Time Line's start ime
boundary so that it's larger than the end time boundary you
will get a warning only if the Display Warnings is checked.
Otherwise the values will automatically be swapped without
notifying you,

It's a good idea to leave Display Warnings checked until you
have worked with the Time Line long enough to feel like an
expert. By default Display Warnings is activated.

Track Select Highlight

When you turn on the Track Select Highlight button, every

time you click the Track Select button for a track, that track
will be highlighted with a different background color, This

helps make it obvious which tracks are selected. By default
Track Select Highlight is activated.

Track On Highlight

When you turn on the Track On Highlight button, every track
that has its Sound or Solo button on will be highlighted with a
different background color. This helps make it obvious which
tracks are active for playback or for AREXX triggering. By
default Track On Highlight is activated.

Smooth Runtime Scroll

When you select the Smooth Runtime Scroll button, the Time
Line will scroll the Time Line to try to keep the Position flag
at about a third of the way in from the left.
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With the Smooth Runtime Scroll button off, the Position flag
will move across the Time Line window from left to right.
When it reaches the end, the Time Line will jump to display
the next chunk of time, with the Position flag starting from the
left and moving right again, and 50 on. By default Smooth
Runtime Scroll is not activated,

Figure 8-62. Time Options

Time Options The Time Options let you choose the display units for all the
time displays in the Time Line. The units you select here will
also be available for creating custom grid increments in the
Set Grid Spacing requester,

The display units do not affect the underlying resolution of
the Time Line. Studio 16 has an actual resolution of a single
sample for Audio tracks, which at a sampling rate of 48KHz
15 1/48,000th of a second. The resolution is even greater for
AREXX tracks. That resolution is rounded up, for display
purposes, to the display units you choose.

Hours Minutes Seconds
Choose Hours Minutes Seconds to work with real time.

SMPTE
Choose SMPTE to work with hours, minutes, seconds and
frames.

You can choose the SMPTE rate from the Project Menu in
Perferences. Select between;

® 2997 frames per second for color NTSC video

® 30 frames per second drop frame (DF) for NTSC video
with frames dropped to stay accurate with real time

® 25 frames per second for PAL video

® 24 frames per second for film work

SMPTE Plus
SMPTE Plus is just the same as SMPTE, but it also shows
extra resolution in the form of 1/100ths of a frame.
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EPM

BPM stands for Beats Per Minute. If you select this, all the
time displays in the Time Line will actually show bars, beats
and clocks. This lets you view your time line against a
musical time increment that corresponds to the one used by
MIDI sequencing programs like Bars & Pipes Professional
from The Blue Ribbon Soundworks.

If you select BPM, you can set the beats-per-minute tempo by
typing the tempo in the Tempo field to the right of the BPM
button. The default tempo is 120 beats per minute. You can
specify the time signature by typing a numerator and a
denominator in the Time Signature fields. The default nme
signature is 4/4.

The number of beats per bar (measure) depends on the time
signature. A time signature of 4/4 means four quarter note
beats per measure. A time signature of 3/4 means three
quarter note beats per measure, There are 1000 clocks per
quarter note.

Undo Levels

Undo Levels Whenever you move anything you can undo it with the Undo
command. When you undo an action, the Time Line will
arrange itself to be just as it was before you did the action.
For example, if you move a sample and then use the Undo
command, the sample will be moved back to where it was
before you moved it

There are five different buttons for choosing the number of
Undo Levels, ranging between 5 and 100. Each level stores
one of your actions. For example, if you have 5 levels of undo
and you move 5 samples, you can use the Undo command 5
times and they will each, in turn, be moved back to where
they were before you moved them.

NOTE The amount of free RAM in your system determines the recommended number of
Undo Levels.

The bigger the Cue List, the more memory Undo needs. If
you have four megabytes of RAM or less, it's a good idea to
usge 10 levels of Undo or fewer. With more memory you can
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generally use more levels of Undo. For the maximum Undo
setting (100) you need at least SMB of free RAM,
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Figure 8-64. Display Boundaries

Display Boundaries Think of the Time Line as 1 window in time. You can set its
starting time and ending time boundaries to choose what
range of time it can view. Within that range of time you can
#oom in and out, and when you're zoomed in you can scroll
forward and backward in time,

Because is possible to have entries in a List that are not
visible within the range of time displayed, Auto Size Cue List
is a quick way to insure that all the entries are visible within a
Time Line’s boundaries. Auto Size Cue List changes the start
time of the Time Line to be 30 seconds before the start of the
first entry, and the end time of the Time Line to be 30
seconds after the end of the last entry.

Start Time field

The Start Time field shows where the Time Line begins, To
change where the Time Line begins, type a new time. When
you save the Cue List, the start time will also be saved.

End Time field

The End Time field shows where the Time Line ends. To
change where the Time Line ends, type a new time. When
you save the Cue List, the end time will also be saved.

Cross Fade Preferences

Choose the default curve types in Cross Fade Preferences. Your chosen curve types
will be used for any new real time cross fades you create from then on. Note that
Crossfades are CPU intensive, too many crossfades may decrease yvour number of
playback tracks.

Figure 8-65. Default Cross Fade Preferences
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To save these settings so they'll be there the next time you run Studio 16, use the
SaveSetup command in the Project menu.

Use the curve types to choose how the first sample will fade out and how the second
sample will fade in.

There are four curve types:

m  Linear

m  Logarithmic

= Exponential
=

Instant

Figure B-B66. Linear In and Linear Out

Linear
A linear fade changes the volume of the sample at a constant rate.

Figure B-67. Logarithmic In and Logarithmic Out

Logarithmic

A Logarithmic fade out changes the volume only a little at first, but it changes it at an
increasing rate, losing more than half the volume in the last third of the overlap area.

Use this for the fade out curve type when you want the first sample in a cross fade to

slowly become less prominent during the cross fade.

A Logarithmic fade in changes the volume quickly at first, but it changes it at a
decreasing rate, easing into full volume. It gains more than half its volume in the first
third of the overlap area. Use this for the fade in curve type when you want the
second sample in a cross fade to become prominent quickly.
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Figure 8-88. Exponential In and Exponential Cut

Exponential

An Exponential fade out changes the volume quickly at first, but it changes itat a
decreasing rate, easing into the complete fade out. Use this for the fade out curve
type when you want the first sample in a cross fade to quickly become less prominent
during the cross fade.

An Exponential fade in changes the volume only a little at first, but it changes it at an
increasing rate, gaining more than half its volume in the last third of the overlap area.
Use this for the fade in curve type when you want the second sample in a cross fade
to become prominent slowly.

Figure 8-69, Instant In and Instant Out

Instant

An Instant fade out changes the volume of the sample instantly from {ull on to full
off, Use this for the fade out curve type when you want the first sample in a cross
fade to play at full volume to its end, with no fade.

An Instant fade in changes the volume of a sample instantly from full off to full on.
Use this for the fade in curve type when you want the second sample in a cross fade
to begin without a fade, at full volume,

If you have a sample that already has a fade edited into the sample itself, use the
Instant In or Instant Cut.

Maximum Time

You can also choose a maximum cross fade time. Your chosen cross fade time will
be used by any cross fades you create while in Limited Cross Fade mode. To change
the default cross fade time, drag the slider at the bottom of the requester left or right.
Dragging it left will decrease the default cross fade time while dragging it right will
increase the default cross fade time.
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Because loops are processed by the duplication of a sample many times on a track,
you can set a Maximum Time to selecta default crossfade time for the looping
sample. By setting a specific Maximum Time and using the limited cross fade edit
mode, you can get consistent seamless looping.

Set Grid Spacing
Use the Set Grid Spacing command to change the tme interval used to space the
vertical grid marks on the Time Line. The grid is a handy visual timing reference.

It's also used in the Snap-To-Grid mode. When you drag an entry or flag, they will
jump to the nearest grid line. You can set a custom grid increment to match the tempo
of a musical sample, and then drag sound effect samples to lock to the grid so they
follow the beat.

NOTE

Snapping left and right stereo samples to the same grid increment is a quick way to
synchronize them exactly. Group them to maintain synchronization.

Figure 8-70. Set Grid Spacing

When you select the Set Grid Spacing command, you'll see the Set Grid Spacing
requester. The requester gives you a scrolling list of options and a text field where
you can enter your own grid interval.

Click an option on the list and the Time Line's grid spacing will change immediately.

The options are:

m Every Hour

Every 10 Minutes

Every Minute

Every Ten Seconds

Every Second

Every NTSC Second (997 of a second)
Custom

None

Click any of the first five options 1o set the grid to specific time intervals. Choose
Custom when you want to specify your own interval. Change the interval used by the
Custom option by typing a time in the Time field at the bottom of the requester.
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Use the None option to remove all vertical grid marks from the Time Line.

Auto Size Cue List
Keyboard Shortcut:  A-A

Think of the Time Line as a window on time. You can adjust the view of that window
to be whatever you want. You can even set the boundaries so that they don't include
all the entries in your Cue List, or so they include far more time than needed to show
the entries in your Cue List.

Normally you want to see all the entries in your Cue List, and you don't usually want
to see more time than your Cue List needs. The Auto Size Cue List command lets you
quickly adjust the boundaries of the Time Line to fit the entries in any Cue List.

When you use Auto Size Cue List, it will automatically start the Time Line's view 30
seconds before the start of the first entry, and end the Time Line's view 30 seconds
after the end of the last entry. This is handy to size the Time Line to fit your project.

You can also size the Time Line's view manually using the Display Boundaries
section in Cue List Preferences. There you'll see a Start Time field where you can
type a new beginning time for the Time Line, and an End Time field where you can
type a new end time for the Time Line.

Undo Edit
Keyboard Shortcut:  A-Z

Whenever you move anything you can undo it with the Undo Edit command. When
you undo an action, the Time Line will arrange itself to be just as it was before you
did the action, For example, if you move a sample and then use the Undo command,
the sample will be moved back to where it was before you moved it,

You can choose between 5, 10, 25, 50 and 100 levels of undo in Cue List

Preferences. Each level restores one action. For example, if you have 5 levels of undo
and you move 5 samples, you can use the Undo Edit command 5 times and they will
each, in turn, be moved back to where they were before you moved them.

NOTE The amount of free RAM in your system determines the recommended number of
Undo Levels.

The bigger the Cue List, the more memory Undo will need. If vou have 4MB of
RAM or less, 5 ar 10 levels of Undo is recommend. If you have more memory you
can generally use more levels of Undo. For the the maximum Undo settings ( 100)
you need at least 8MB of free RAM.

When you use the New or Open commands to load a different Cue List, you will no
longer be able to undo anything you did on the previous list,
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Redo Edit
Keyboard Shorteut: A-R

Use the Redo Edit command to again do the last command that you rescinded using
the Undo command, Between the Undo command and the Redo command, you have
the freedom to experiment and change your mind, The number of Redo levels is
equivalent to the number of Undo levels set the in Cue List Preferences.

Keep Original Time

If SMPTE time code was running during the recording of a sample, that sample will
have an associated SMPTE time code. In which case, you have the option of
dragging that sample from Sample List and either dropping it at the precise SMPTE
point where it was recorded, or dropping it anywhere on the time line.

Activate this option to enter a sample on it's recorded SMPTE time. Just click and
drag the sample from Sample List and drop it on the preferred track. The sample will
jump to its correct SMPTE time. Note that depending on the start and end time
boundaries set in the Time Line, you may not be able to see the sample you've just
dropped in. If this happens, use Auto Size Cue List (A-A) in the Options menu to
change the boundaries of the Time Line to include the new Audio Entry,

To position your sample with your mouse pointer and not by SMPTE time code,
deactivate Keep Original Time.

Use Mixer Levels

When you want to use automated Mixer control of volume and pan changes in real
time, activate Use Mixer Levels, When it’s activated, pan and volume settings in the
Cue List will be ignored in favor of the real time changes you make using the Mixer.

If Use Mixer Levels is deactivated, the Time Line will use the volume and pan
settings saved with your samples, or set in Audio Event Parameters.
Ignore SMPTE Errors

If you activate the Ignore SMPTE Errors command, the time code reader will skip
past errors as it reads the time code. If you are having trouble reading the SMPTE
time code on a particular tape, try selecting this command.
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Editor

Keyboard Shortcut:

Class:

Description:

Lasal] |

*E or A-E

AE Opens an empty Editor. A-E Opens an Editor with a
sample loaded provided the sample is highlighted in the
Sample List and the Sample List window is active.

Application Module

The Editor allows you to manipulate the data of sound files.
It is accessed from Applications Menu, Sample List or from
the Cue List. From the Applications Menu, load an empty
editor by selecting Editor. To open an editor for a specific
sample, highlight a sample in Sample List and select Edit
Sample. Note that multiple select works to edit samples
simultaneously.

Editing is accomplished in Studio 16 as it would be with a
traditional 8 bit sample editor like Perfect Sound or Audition
4. An editor displays a graph of the sound being edited and
allows you cut, copy, and paste sounds. You can move parts
of a sound around, delete unwanted sections, fade in or out
sections of sound, or even reverse sound. You can also use
the "frechand” mode to draw with the mouse to remove pops.
In addition, the editor also allows you to change a sample’s
default playback rate, volume, and filter setting and contains
more advanced features like echo, FFT, and resample.

W s

H T

BE:BR:Q0:88

A@:eB:AB:19

BB:E@:81:87

(BP:BA:PB:B3)

AR:B@B:88:23

: —— — =i =t
Figure B-71. Editor Window
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Layout:

Status Display

Along the top of the Editor is the status display. It includes
numerical positions of the marked range and the current graph
display. The numbers on the far left and right are the first and
last positions for the entire display. The numbers toward the
center of the window are the fist and last positions of the
marked range. The range length is displayed in parentheses.

The status display is generally shown in SMPTE time code. It
can be displayed in numbers of samples by activating Units in
Samples in the Editor's Option Menu,

You also have the option of entering an offset for the status
display. The offset is added from the Editor's Option Menu -
Set Display Offset. An offset is often used with the Cue List,
When editing a sound that is also entered in the Cue List, you
can set the offset equal to the Cue List start time code. So
when you drag ranges, the SMPTE display of the ranges in
the editor window will match the sound's position on tape.

Graph

Maost of the Editor window is occupied by a sound's graph.
The vertical axis of the graph represents the amplitude of
sound, and the horizontal axis represents time.

Because Studio 16 samples are hard disk based (they are not
in RAM), the editor has a unique difficulty, How can a
graphic representation of the digitized sound be displayed fast
enough to be usable? Studio 16 solves this problem by
building a graph in RAM from hard disk, and using this
"graph buffer” to display the "on screen” graph,

When you first edit a sound, a window will appear and a
graph will begin to form from the left to the right. Your hard
disk light will also be quite active, Studio 16 is building its
"graph buffer”, a process that only has to be done once -
when you first load the sample in the editor. For long
samples, this can take a while. For example, a 3-4 minute
sound (~14 MB) will take about 40 seconds to build the
graph. This process can be sped up slightly by increasing the
"Copy Buffer" in Preferences. Once the graph is built, the
editor window will be redrawn with the graph displayed. For
quicker graph updates, select the Fast Graph option in the
Editor's Options Menu.
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Editing is accomplished by dragging your mouse over the
graph to mark a range, then selecting a editor menu option.

Buttons

The navigation buttons are located along the bottom of the graph. See the Buttons
Reference for a detailed explanation of each button.

Procedures

Load a Sample In an Editor

1. Select Sample List from the Applications Menu. (*O)
2. Select a sample to edit.

3. Select Edit Sample from the Sample List Menu, (A-E)

Removing Leading Dead Space

1. Examine the beginning of the graph to note where the dead space, or silence
appears.

2. Using the graph as a guide, use your mouse to drag a range highlighting the
silence. This will be easiest if you click on the right side of the intended range
and drag to the left. By dragging past the left edge of the graph, you will be sure
your range includes the first sample.

3. Type A-L to play the marked range to listen to the area you have just highlighted
{or select Play Range from the Editor Menu). You should not hear anything,
except perhaps background noise.

4, On the basis of listening to the range, you may want to fine tune your marked
range. You can use the mouse to grab the end of the marked range and adjust it.
To get a closer view of your sample, click the Show Range button, and then click
the Zoom Out button to zoom out a little,

5. Once the range is finalized, select Non-Destructive Cut from the Edit Menu. You
have now performed a "non destructive cut.” The data you have cut is still on
your hard disk, but it will not be played when you access the sample. You can
restore it by selecting Undo Last.

6. If you want to free the hard disk space currently being occupied by the silence,
you need to make the non-destructive edit permanent. Select Make Permanent
from the Edit Menu, This operation can take a while, depending on the length of
your sample. Once it is complete, the graph will be regenerated.

Fading a Sound In

|. Examine the beginning of the graph to note where the fade should occur.

2. Using the graph as a guide, use your mouse to drag a range highlighting the
section to fade. This will be easiest if you start on the right side of the intended
range and drag to the left. By dragging past the left edge of the graph, you will
be sure to start your fade on first sample.
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3. Type A-L to listen to the area you've just highlighted.

NOTE Editor fades are permanent. Once done, they can not be undone. You may want to
make a copy of the sound before doing a fade as a reserve. For non-destructive fades,
use the Cue List,

4. On the basis of playing the range, you may want to fine tune your marked range.
You can use the mouse to grab the end of the marked range and adjust it. Zoom
In for a closer look of the waveform by clicking the Zoom In button,

3. Once the range is finalized, select Scale from the Effects Menu.

6. A Select Scale Requester will appear. To fade in, change Start to 0%, and End
to 100%. To fade out you would set Start to 100% and End ta 0%,

NOTE Use Cue List to perform non-destructive fades that can be undone.

Scale/Fade *CarStart’
[Start  ®x% | =<|=]
J End __ 188% | <=l
oK | LANCEL |
Figure B-72. Scale Selector

7. Click OK.
8. The fade will now be performed. It may take a while, depending on the length of

the marked range.

Creating a New Sample Out of a Marked Range

1. Highlight a range on the main graph, A new sample will be created out of this
range. To duplicate an entire sample, click the Range All button,

b

Select Destructive Copy from the Edit Menu. A destructive copy will cause a
new file to be created from the marked range called CopyBuffer.

3. Bring the Sample List module to the front by typing ~0, or by selecting it from
the Applications Menu.

4. Select the sample CopyBuffer in Sample List.
5. Select Rename from the Sample List Menu and type in a new name for the
sample and hit the Enter key.

Pasting a Range From One Sample Into Another
I.  Before you begin this tutorial, close all modules except Sample List,

2. Pick two samples in the Sample List that have the same sampling rate, They will
be referred to as SourceSample and DestinationSample.

3. Highlight ane of the samples in the Sample List and type A-E, or select the Edit
Option from the Sample List Menu,
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4. Bring Sample List to the front ("0). Highlight the second sample and select Edit
again to open a second Editor.

5. You now have 2 editors open. Resize and move the Editor windows so that you
can view both of them on your screen at once,

6. Mark a range on the graph of the SourceSample. This will be pasted into
DestinationSample,

7. From the SourceSample editor, select Destructive Copy. At this point, a new
sample will be created called CopyBuffer.
Mark an insertion point for the range in the DestinationSample.

9 In the DestinationSample Editor, select Destructive Paste - Insert at Start.
CopyBuffer 1s inserted now. The process can take a while if the files are large.

Project Applications Editor Effects Options
: Non Destructive
=i Cut ®
Copy C
i Paste
il Keep K
Li ¢ Delete D
o f PO Undo Last Z
1 Undo ALL
! I : MHake Permanent
I 0o £ more £ £ e
4 Cut
Play EI !tne’ Igl_-!gu ﬂj Range [ Copy HAs..
EL Paste B
=i AUDI0:DestinationSy Keap e
Delete [v|

— i =

Flay R|_Stop | Show A Range | Show R| Zn In{Zn Outl |
Figure 8-73. Moving a Range from SourceSample 1o DestinationSample
Buttons
Play Range This will play the marked range in the editor window.

Stop Any playing sound is stopped.

Show All Adjusts the zoom ratio so the entire sample is displayed on
the graph.

Range All Will create a range over the entire sample, Will also Show All
in the process.

Show Range This expands the marked range to fill the graph - changing the

z00m ratio and the scroll as needed.
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Zm In To "Zoom in” on your sound's graph to see more detail, click
this button. Successive clicks will zoom you in closer until
you are zoomed all the way in. When zoomed all the way in,
you will be viewing the sample on a scale where each
horizontal screen pixel represents one sample.

Once you've zoomed in on a sample, vou can use the scroll
bar along the bottom of the graph to move around in the
sample. Usually the graph is updated from the "graph buffer”,
so scrolling is a very quick process. However, if you zoom all
the way in, the editor may access the hard disk. When this
happens, the updates will become slower, and you will see the
hard disk light flash. To speed things up, zoom out a little.

You can also zoom in on the sound by marking a range (use
your mouse to drag a range on the graph) and then clicking
the Show Range button. This will expand the marked range
to fill the graph.

Zm Out Reverses the zoom ratio, so you can see more of a sample.
Click Show All to zoom all the way out of a sample quickly.

Editor Menu

New Clears all samples from the Editor Window, The samples are
not deleted, they are just removed from the Editor.

Open Opens a file requester allowing the addition of a sample to the
display. Up to 8 samples can be in the editor at once allowing
synchronous edits.

Play All Plays the entire sample in the editor. You can also play
sounds from Sample List and Cue List.

Play Range This will play the highlighted range on the graph.
Play Display Plays the portion of the sample that is currently displayed in

the graph.

Play to Start Plays a small portion of a sample preceding the marked range.
Stop Playing All playing sound is stopped.

Edit Menu

Non Destructive A "non- destructive” edit will not alter your original sound. It

just remembers which changes have been indicated. Since
non-destructive edits don't alter your hard disk data, they can
be "undone” at any time to restore your original data. Another
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Cut

benefit of "non-destructive” edits is speed. Since hard disk
access is not required, non-destructive edits are much faster to
execute than destructive edits.

Non-destructive edits only work on one sample at a time,
That is, you can't do a non-destructive copy, then paste the
copied range into a different sample. The non-destructive
paste must be into the same sample where the non-destructive
copy was performed.

This is the same as selecting a non destructive Copy and
Delete. If you want to delete a range while maintaining the
sound after the cut in sync, use zero.

Non-Destructive Copy remembers the marked range for use
in future pastes. No new sample is created.

Non-Destructive Paste has a submenu that determines where
to paste;

®  Insert at Start

®  Insert at End

m  Replace Range

Selecting Insert at Start or End will insert the copied range at
the beginning or end of the marked range. Selecting Replace
Range will replace the marked range with the last copied/cut
range.

The non-destructive Copy - Paste - Insert action allows you
to duplicate a section of sound repeatedly. You can insert
multiple copies of a range into a sample without using more
hard disk space (unless you select Make Permanent or doa
destructive edit),

NOTE With Studio 16 version 3.0 there is a limit of 128 non-destructive edit clips.

Keep

Delete

Undo Last

User's Manual

This non-destructive edit is the inverse of Delete. It deletes
all of the wave except what is highlighted in the marked
range.

This non-destructively deletes a marked range (it can be
reversed by Undo). To delete a range while maintaining sync,
use zero, Note that Zero is destructive.

This will unde the last non-destructive edit. 1t does not have
any effect on other types of edits or effects. Clicking Undo a
second time will reverse the Undo.
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Undo All This option will undo all non-destructive edits. It has no
effect on destructive edits or effects.

Make Permanent Allows you to do non-destructive editing on a sample and
then transform the results into a permanent sample with a
single "destructive edit”. This option will update the current
sample's data taking non-destructive edits into account,
Performing a destructive edit will also make all non-
destructive edits permanent.

There are two reasons to make non-destructive edits
pcrmanv:m:

l. You have performed non-destructive cuts on a sample so
that if the edits were made permanent only a fraction of
the disk space would be required by the sample,

Example

You record a 20MB sound file, then edit the sample in
the non destructive mode, doing cuts, copies and pastes.
The resulting sound would fit in a much smaller SMB
space. However, since your edits were non-destructive,
the original 20MB file is still on your hard disk. If you're
confident you won't need the original unedited sample,
by making the edits permanent you can create a new
sample that contains just the SMB of edited data, thus,
freeing 15MB of hard disk space.

2, You are experiencing long delays between selecting Play
All or Play Range and the sound actually playing. This
happens when the computer must seek long distances
from the beginning of the sound's data file to find the

quite slow. As a result, you may want to make the edits
permanent to eliminate the delay.

NOTE Make Permanent will create a new file on your hard disk, then delete the old file. As
a result, it will not work unless there is enough free space on your hard disk 1o
temporarily hold both the original file and the new "compressed” file.

Make Permanent can make a file larger if you have performed many Paste - Inserts.

Destructive An edit is "destructive” if it alters your sample's data on the
hard disk. Destructive edits are generally used 1o wansfer
clips from one sample to another. (Non-destructive edits only
work within a single sample.) For example, if you wanted to
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cut part of sample and paste it into an another sample, you
would have to use Destructive Copy and Paste,

Destructive edits are also used when you want to create a new
sample from an existing sample.

As well as the destructive Cut, Copy, and Paste, effects are
also destructive, These include Resample, Scale, Invert, and
others.

A destructive cut will remove a marked range and place itina
sample called CopyBuffer. CopyBuffer is a normal sample in
all respects, except that by convention it is used in
Destructive Paste. CopyBuffer is created in the active
directory.

Deestructive copy will copy a marked range into a new sample
called CopvBuffer.

It is often useful to create a new sample out of a marked
range. Destructive Copy As will bring up a file requester and
prompt you for a name for the new sample.

Copy As will create the new file with the default file format
set in Preferences. This allows you to easily create samples in
different file formats from ranges of original samples.

Destructive Paste, like its non destructive counterpart, has a
sub menu that allows you to select where to paste:

®  [Insert at Start

m  Insertat End

m  Replace Range

Selecting Insert at Start or End will insert any sample named
CopyBuffer at the beginning or end of the marked range.
Selecting Replace will replace the marked range with the
contents of CopyBuffer.

To transfer a clip of sound between samples, do a Destructive
Copy in the source sample followed by a Destructive Paste in
the destination sample.

To append one sample to another, select Insert @ End. But
make sure the destination sample's range includes the last
sample of the sound.

Destructive delete will remove a range from the sample. A
delete is similar to a cut, but it does not create a CopyBuffer,
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and it 1s quicker to perform. It may be preferable to delete a
range, if you are working with long samples and you are
certain you do not require the marked range. There is no undo
for non-destructive delete.

Keep Keep is the reverse of delete. Tt will permanently remove all
of the sample except for the marked range. It is safer to do a
non-destructive keep and then make the edit permanent.

Effects Menu

Echo This option brings up an echo range requester that allows you
tor set the Delay, Feedback and DLevel of an echo on
accelerated Amigas.

Ec N

ange in

Feedback 58% |
Delay 15.61ms|
| DLevu
Dol| Trv | Stoe|
Figure B-74. Echo Selector
Try

This will allow you to preview the effect.

Delay
This adjusts the length of time between repeats.

Feedback

Controls the number of echoes you hear. This is
accomplished by adding a percentage of the delayed signal
back into the original.

D Level

Controls the volume of the echoes, at 100%, the first echo
and the original signal are the same volume, At 0% yvou will
not hear an echo

FFT Fast Fourier Transform breaks down a waveform into its
constituent sinusoidal parts. The "Fourier Transform” is a
mathematical transform that translates time domain
information (like sampled sound) into the frequency domain.
The "FFT", or "Fast Fourier Transform" is a computationally
efficient method of computing the Fourier Transform.
Actually, Studio 16 implements the "DFT" or "Discrete
Fourier Transform". However, many people use FFT and
DFT interchangeably.
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Figure 8-75. FFT Display

In any case, the FFT will produce a plot that shows you which
frequency components are present in the samples analyzed.
An FFT algorithm always processes a power of 2 samples. In
Studio 16's case, it always processes 512 samples. It then
produces 256 real "frequency samples”. Each of these points
is plotted by Studio 16 in a bar graph. Since there always 256
points, or "bins", these bins contain a range of frequencies.
The center frequency in this range is displayed in the upper
right hand corner as you move the cursor,

When selecting a range for an FFT keep in mind that only the
first 512 samples will be used in the calculation. To mark a
range that is exactly 512 samples in length, activate Units in
Samples from the Option Menu in Editor. Then, watch the
range's status display (the center most numbers along the top
of the graph) as you adjust you range to 512 samples.

Invert This option inverts the ranged waveform along the y-axis.
The sample will not sound different,

Mormalize A variation of scale that first measures the peak value of the
sample, and then scales the entire range by the percentage
required to bring the peak to a maximum setting. The
maximum level for 16 bit samples is 32,767. Refer to Chapter
| for more information on maximum levels.

Normalize can also be used to find the maximum sample in a
range since it is determined before scaling and you can
always cancel the normalization before it alters your sample.

Reverse This option will reverse a sound's data so that it plays
backwards,
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Scale This option allows you to scale (attenuate or amplify) a
sample. It also allows you to fade in or fade out a section of a
sample by specifying a starting and ending percentage. When
they are equal, a straight scale is performed. When the
percentages differ a fade will be performed.

When using scale to increase the level of a range at an even
rate, consider using Normalize.

Studio 16 Scales are linear. To produce a logarithmic scale in
the Editor, scale the same range twice at the same setting.

NOTE Use Cue List to perform a variety of non-destructive fades.

Zero Mark a range and select zero to silence the existing audio.
This will allow you to remove sound from a track while
maintaining sync throughout the entire track.

Resample Allows you to adjust the sampling rate of a sample. The
parameters will affect the quality of the sample and the
amount of RAM required. Also, resampling is a complex
operation, 5o it may take a while, especially if you are
working with long samples,

Resample can also be used to "pitch shift”. Resample a sound
o a new rate, and then play it back at its original rate.

Resolution Filter Order
ANornal s K21
[ High 11 1@
Current Rate
44188
Mew Rate Time C(25MHz)
y I B8.15 mins
DO _RESAMPLE| _CANCEL |
Figure 8-78. Resample Selector
Resolution

Because resampling is very calculation intensive, Studio 16
pre-computes a sinc table for speed. "Resolution” refers to the
size of the sinc table. The normal table is provided for
machines with small amounts of RAM. High Resolution
requires more RAM, but may give slightly better results
because it uses a larger table,
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Gen Silence

Gen Silence

_OK |

Filter Order

Resample is controlled by a digital filter. Digital filters allow
you to set an order of the filter or the degree of accuracy. The
larger the order of the filter, the more accurate the resample
will be. However, high filter orders take longer to process.
The Filter Orders that are available for resampling are 5, 11,
21, 101.

Current Rate
The default sampling/playback rate of a sample before
resampling.

MNew Rate

A field for entering the new sampling rate. (Open the
Recorder to see the available rates your ADS16/ADI012 can
playback.)

Time

The estimated time required to process the resample. Note the
field will update as you select different filter orders. This
estimated time 15 for an Amiga 3000 with a 25MHz
processor. Stock Amiga 2000s will take much longer.

This option will create silence in the CopyBuffer. A requester
will appear allowing you to select the length of the silence
and the sampling rate. Once the silence is in the CopyBuffer,
you can select destructive edit and paste the silence into your
working sample.

Sampling Rate

The default sampling rate is from your working sample. If
you intend to copy the silence into another sample, you
should use that sample's rate.

Seconds

The number of seconds silence to be generated. Fractions are
okay (e.g. 1.25) Also, since sine waves are generated in RAM
they are limited in length by available memaory.

CANCEL |

Figure B-77.

Generate Silence Selector

User's Manual
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Gen Sine Wave This option will create a pure sine wave in the CopyBuffer, A
requester will appear allowing you to select the length of the
sine wave and the sampling rate. Once the sine wave is in the
CopyButfer, you can select destructive edit and paste the sine
wave into your working samples. This option is well suited to
creating a 1,000Hz sine wave that is often used in the
beginning of an audio tape for reference purposes.

Figure 8-78. Generate Sine Wave Selector

Sampling Rate

The default sampling rate is from your working sample. If
you intend to copy the sine wave into another sample, you
should use that sample's rate. Note your Sampling Rate
should be at least twice, preferably four times, the frequency
of the sine wave.

Seconds
The duration of the sine wave. Note that the longer sine wave
the longer it will take to process,

Wave Fraquency
The frequency of the wave should be no more than 50% of
the sampling rate and preferably no more than 25%.

Options Menu

Set Range Using this option, you can enter a range numerically, Instead
of dragging a range with the mouse, you can use Set Range
to set the range exactly in either number of frames or number
of samples (set by the Units in Samples menu option).

Set Start This is an "on the fly" operation that allows you to set a range
while a sample is playing. Select Play All for a sample and
then use the keyboard shortcuts for Set Start (A-M) and then
Set End (A-E).

Set End Used in conjunction with set start allows you to set ranges
when listening to a sample play, A-E.

Set Sample Parms Use this to alter the sample’s default volume, playback rate, as
well as the filter rate for AD1012s, and the pan for AD516s,
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The default volume is the level at which the sample plays. It
will usually be +00dBs. The Mixer will automatically adjust
itself to this level when the sample is played. However, if Use
Mixer Levels is active in Cue List, the current mixer setting
will be used.

Elt l“lt iiﬁEll E!E!H!EIEI lllh'un.l
I Rate 44188 | <[>
Mol e-qg8 — | x| >
; Pan L+R | ==l
oK CANCEL |
Figure 8-79. Sample Parameters Selector

Set Display Offset

Loop

User's Manual

See the Reference Section on Recorder for an explanation of
sampling and filtering rates. If you have trouble selecting a
sampling rate that is available in the Recorder, use the arrow
buttons or click in the slider to the left or right of the knob.
This will display all available increments. Just dragging the
knob may not show them all.

The pan adjustment allows you to vary the level of audio
playing on each channel. The AD516 has two output
channels, and you can set a sample to play on either the left,
right, or both output jacks. When the pan slider is in the
center, the sample will play equally on both the left and right
outputs, If the pan slider is all they way to the right, the sound
will only play on the right output. If the slider is all the way to
the left, the sample will play only on the left. You can also
vary the levels on each output

Stereo is accomplished by recording two tracks: one panned
full left, and the other panned full right. You use pans that are
not full left or full right when playing back mono tracks that
you want to appear on both the left and right outputs.

Prompts you for a time to offset either the display or the
marked range. Changing either offset will effect the other. If
you know the exact frame you want the sample to trigger on,
set the display offset. On the other hand, if there is an
embedded sound effect in the middle of the sample (marked
by a range), and it is crucial that it play on a specific frame,
set the range offset. The display offset will automatically
calculate a new offset, to match the new range entry.

Activate Loop to have the sample or marked range play
continuously,
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Freehand Draw When activated, you can use your mouse to alter a sound's
data. Selecting freehand will automatically zoom all the way
in. To edit normally, deactivate the option or zoom out.

OK Requesters When activated, OK Requesters will appear for all destructive
edits and effects. It is recommended that users new to Studio
16 leave "OK Requesters” activated until they become more
familiar with Studio 16's operation. Advanced Users will
probably want to turn off this option. A few crucial requesters
are not optional and will remain even when OK Requesters is
deactivated.

NOTE OK requesters can generally be accepted or rejected with the standard keyboard
shoricuts Left A-V and Left A-B for OK and cancel.

Units in Samples The graph and status display are generally displayed in
SMPTE time code. If you prefer to work in numbers of
samples, activate this option,

Show Regions Regions are marked ranges that have been given a name.
Regions are like samples in that they can be dragged into the
Cue List. Show Regions will bring up an "Editor Regions
List" that lists all the regions in a samples. You can drag from
this region List. The "Editor Regions List" has Menu Options
of it own,

Project Applicat ions
Add A
dltnr'- Reai |-_i] Do D
chorus Urdate u
finale r
intro
reprise ﬁl
Figure 8-80. Editor Regions List and Regions Menu
Add Region

Brings up a name requester for the marked range. This range
will then be converted to a region that can be dragged into the
Cue List. Its name will appear in the Editor Regions List
along with any other regions existing for that sample.

Delete Region

Highlight a region's name in the region list and select this
option to forget the region. Note that no data will be lost, this
is not a cut, nor a destructive delete,
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Update Region

Allows you to adjust the region's length. Click on a region's
name in the Editor Regions List, then click on the graph and
move the start or end markers of the region. Next, make the
Editor Regions List active by clicking on the title bar, then
select Update Region to update the region with the new
length.

Grid Displays a vertical grid that indicates boundaries within a
sample. The type of grid is set with the submenu, For
example, you can request that a vertical line be drawn on one
frame or one second boundaries,

Note that you may have to zoom in to see the grid lines. This
is because the Editor will not draw grid lines when there
would be "too many” drawn. In other words, if the editor
thinks that you're going to have trouble seeing the waveform
through all the grid lines, they will not be drawn.

Set the grid to one of the following settings, or turn it off,
Note that the grid is a display only, it does not "snap”.

| _Options |
Set Range
Set Start Mark M
Set End Mark E
Set Sample Parms
Set Display Dffset

Loaop

Freehand Draw

DK Requesters

Units in Sanples

.~ Show Real
as T 1 Frame

1 Second

18 Seconds

1 Hinute
Figure B-81. Grid Settings
Fast Graph When activated, the graph display update is quicker, but less

representative of the actual sample.
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Instance

Keyboard Shortcut: * 1

Class: Application Module (Dormant)

Description: The Instance List can be used to launch Swdio 16 modules
just like the Applications Menu and Keyboard Equivalents.
Instance is loaded from the Applications Menu. And once
loaded, all other application or utility modules can always be
on display rather than in the menu. Usually, due to limited
screen space, it is preferable to use the Applications Menu
and keyboard shortcuts,

This module does not generally require user access.

Instance Menu

Edit Brings up a requester giving you the option of renaming a
module or making a module resident or non-resident. All
Studio 16 modules reside on your disk in the Studio 16_3:
Application, Drivers, and Utilities drawers. For each module,
there is one program file in this directory. As with all
programs, a Studio 16 module must be in RAM to run.
However, when you are not using a module, the module’s
cade can be removed from RAM. The resident/non-resident
option lets vou decide if you want to keep a particular
module’s code in RAM even when the module is not being
used (Resident) or whether you want to free RAM for use by
other programs and remove a module when it is not is use
(Non-Resident).

The advantage of keeping a module resident is speed. A
resident module’s window will open immediately when you
double click its name in the Instance List since it doesn't have
to be loaded from disk. A non-resident module will take a
second or so to load when you double click its entry in the
Instance List. For this delay you save a small amount of
memory. The amount of memory (RAM) saved is relatively
small so it's advisable to keep commonly used modules
resident.

The Utility and Driver modules should always be resident.
Application modules may be made resident at your discretion.
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Duplicate This option creates another Instance of a particular type of
module. For example, select the Meters entry and click the
Duplicate button. You now have two entries in the Instance
List, Meters and Meters#2. This enables you to load two
Meters modules simultaneously, allowing you to show eight
meters at once. However, some Amigas will not have enough
CPU time for this.

Remove This option removes an Instance from the list. For example, if
you don't require that second meter module (added in above
example), you can select Meters#2 and then click the
Remove button, Once a module is completely removed from
Instance, you will have to load Module List to add it back.

Show Sets Instance to display Applications, Utilities, or both.
Utility Modules are used in the operation of Studio 16. They
are not usually accessed by the user. However, you may be
interested in selecting the AD516 or AD1012Handler. I
displays statistics about your hardware.

£

Figure 8-B2. Instance List showing Application Madules

Procedure

To move Instance from the Dormant directory:

1. Quit Studio 16.

2. From WorkBench open the Dormant directory, by clicking its icon.
3. Drag the Instance icon on to the Application directory icon,

4. Delete the 3:Studiol 6Instance.config file.

5. Load Studio 16, Instance will appear in the Applications Menu.
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Message Monitor

Class: Application Module (Dormant)

Description: The Message Monitor is a handy debugging tool for Studio
16. This module is for programmers - most users will not
require opening it. It displays all the messages passed
between the different Studio 16 modules. Tt should be noted
that message monitor can run at low task priorities, while
most other Studio 16 modules run at higher priorities. This
will cause a backlog of messages to be queued if the
computer is fully loaded. These messages get processed by
the higher priority Studio 16 modules before they are
displayed by the message momtor.

Message Monitor is located in the dormant directory. This
means that it is not available from the Applications Menu.

Procedure
To move Message Monitor from the Dormant directory:

1.  Quit Studio 16.
From WorkBench open the Dormant directory, by clicking its icon,

(]

3. Drag the Message Monitor icon on to the Application directory icon.
4, Delete the S:Studiol6Instance.config file.
5, Load Studio 16, Message Monitor will appear in the Applications Menu.

e T T T T [T T e —, [ | P
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Figure 8-83, Message Monitor
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Meters

Keyboard Shortcut:

Class:

Description:

=

.H.'\_-'
Application Module

This module displays sound levels in much the same manner
as the meters on a cassette deck. Like a cassette deck, these
meters are used in adjusting the input gain of incoming sound.
They enable you to get the maximum volume without
clipping. Whenever you adjust the input gain of a card you
should open a meter window, This allows you to make an
informed decision about where the input gain slider should be
sl

Another use of the meters is the visual monitoring of the
sound going through each of the Studio 16 channels. You can
easily tell if a sample was recorded improperly by looking at
the level of a channel to see if it is too low or too high. You
may decide that a sample needs to be re-recorded.

1=

U515 fnpus

Figure 8-B4.

Meters

Layout:

User's Manual

The meter window can consist of an Analog Meter, a Digital
Meter and a scrolling graph. Each meter is assigned to a
specific channel using the Channel Menu option. Each meter
takes up more blitter time, so slower systems should keep the
number of meters to a minimum.

For most applications, the gain information required can be
derived from the digital meters and the scrolling graph on the
input channel. Other than setting the input gain, meters are
optional. While they look nice, they also take up memory and
a surprising amount of CPU and blitter time. It is possible that
if you close down the Meter module you will be able to
playback more channels.
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Meters Menu

Allows you the flexibility to show only the types of meters you require. Each meter
channel can display the volume information in up to three ways: an analog meter
simulation, digital meter simulation with peak hold, and a scrolling graph.

Analog The analog meters use a waited averaging technique to show
the average sample amplitude. Large instantaneous peaks in a
sample’s volume will have only a small effect on an analog
meter's needle position unless they occur frequently, It is
difficult to decide if a sample is clipping using this type of
meter, 50 it is more useful to use one of the other types of
meters for adjusting the input gain of the card,

Digital The digital meter shows the instantaneous peak of a sample's
amplitude in a given period of time. If a sample has one large
peak this type of meter will display the peak. If the right most
LED is displayed, then clipping occurred. In most cases the
input gain should be reduced to prevent this. The peak hold
feature shows the largest amplitude of a sample for a longer
pericd of time, This makes it easy to determine how loud the
peaks of a sample are.

Graph The scrolling graph meter is a type of meter unlike any analog
world counterpart. It shows the instantaneous peak of a
sample on one axis while showing time on the other axis. This
type of meter is useful for determining the type of sound
being played through a channel as well as its amplitude, With
practice you can tell whether a channel is playing back a
voice track, a sound effect or music just by looking at the
shape of the graph.

Channels Menu

Allows you to assign meters to specific channels. Input should always be selected
when monitoring the gain level before recording.

NOTE To select multiple options in a sub-menu click the left mouse button while holding
down the right.

The maximum number of meters per meter module is four. To show more than four
meters, vou must first close the Meter Window and launch Instance. Because
Instance is dormant, you will need to move Instance to the Applications drawer in
order to access it. From Instance duplicate Meters. Then from the Applications Menu
you can access Meters#2, this will provide four additional meters. For mare meters,
duplicate Meters in Instance a second time.
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Mixer

Keyboard Shortcot: M

Class: Application Module

Description: The mixer allows you to adjust the relative volumes of the

playback channels and the input and output volume, If the
ADS516 is installed, a pan adjustment is included for each
playback channel. The mixer uses the DSP chip to digitally
adjust the volume and pan of each channel. You can use the
mixer to adjust a sample that is playing back too loud or too
soft or to make a sample playback on the left or right channel
{or both). The volume and pan may be changed before, after
or during sample playback. The mixer also displays the
sample name currently playing from the Sample List.

Figure 8-85.

Mixear

Slider Control

Volume

You can move the mixer sliders either with your mouse, or by
using an external MIDI controller box. A MIDI controller
box provides physical sliders. When those sliders are moved,
MIDI messages are sent to your Amiga. Studiol6's Mixer
then receives those MIDI messages, and moves its mixer
sliders to match the external control box. See "Enable MIDI"
and "MIDI Preferences..." for more information,

To adjust the volume of a channel simply move the
appropriate slider. The mixer will display which sample is
playing on which track. This makes it easy to identify which
volume slider to adjust. In addition, the Mixer channel names
match those used in the Cue List,

Use the output volume slider to adjust the volume of all the
channels. This is useful for fading in or out entire
soundtracks. The input volume is useful when you want to
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mix the card's playback channels with an external audio
source.

Since the mixer works in the digital realm it 1s almost
distortion free; however, care should be taken to refrain from
clipping a channel since clipping causes distortion. Digital
distortion is somewhat harsher sounding than analog
distortion.

NOTE Ideally, a channel should be maintained at +00dB where the dynamic range is
maximized. When you reduce a channel's volume digitally (as the mixer does), you
are also reducing the channel's dynamic range.

When recording from the Recorder or from the Cue List, the
audio input will be digitized regardless of the Mixer setting.
Note on the figure below, the Record Input Tap is before the
volume adjustment on the Mixer. To record at the output tap
you must use the Cue List and set the Record Channel to

Output.
Record ‘ Allﬁm
INPUT
Tap ]
(A
Record | Y
OUTPUT - T
Tap Audio VOLUME
= ouT SN
Figure 8-86. Mixer Diagram
Decibels The Mixer specifies volumes in Decibels (dBs). Decibels are

a logarithmic scale used to more accurately represent how the
ear hears volume changes. Zero dB means no gain,
Altenuation are negative, and amplifications are positive,
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Pan

For example:

+6dB  is equivalent to 200% volume
0dB  is equivalent to 100% volume
-6dB 15 equivalent to 50% volume

=B 15 equivalent 1o no volume

-, or negative infinity is represented by -00dB in Studio 16,

The pan adjustment allows you to vary the level of audio
playing on each physical channel. The AD516 has two
physical channels (Left and Right). You can set a sample to
play on either the left, right, or both output jacks with the pan
control. When the pan slider is in the center, the sample will
play equally on both the left and right output. If the pan slider
is all they way to the right, the sound will only play on the
right output. If the slider is all the way to the left, the sample
will play only on the left.

Stereo is accomplished by recording two tracks: one panned
full left, and the other panned full right. You use pans that are
not full left or full right when playing back mono tracks that
you want to appear on both the left and right outputs.

NOTE The AD1012 is a mono card and does not have a pan option.

Clip Indicator

Scrolling Graph

Lock

User's Manual

The clip indicator is similar to the peak hold on the digital
meter. It indicates when the channel's volume clips. In
addition, the color of the scrolling graph will turn red when
clipping occurs.

Similar to the Scrolling Graph in Meters. [t is also possible
that the mixer can load down the system. This is true for any
of the windows that responds to real time events. If the
system is too busy, Studio 16 may be limited in the number of
simultaneously playing channels. Closing the mixer window
may increase the number of channels you can play back. Or,
you can try substituting Tiny Mixer instead.

Every channel has a lock button. This button allows you to
lock sliders together so that when one slider is moved, the
locked sliders move as well. For example, this is useful fora
stereo pair, Lock the left and right channels together, to
perform stereo volume adjustments with the mouse.

In addition to normal locking, the lock button allows yvou to
E b

perform a cross lock. In this mode, cross fades can be

performed by using the mouse to move one slider,

191



Chapter8  Mixer

To select normal lock mode, click on the lock button of the
channels to lock together. The colors of the knobs will change
to indicate that the sliders are locked together, By clicking on
the lock button a second time, the slider will be in cross lock
mode. Its color will change again, to indicate its a cross fade
locked slider. Note that any number of sliders can be locked
together. Either normally, or cross faded,

CLR The CLR button will clear any recorded pans or volumes for
the selected channel.

Automated Mixing  The Mixer can memorize a sequence of volume or pan
changes, and play them back later. This is often useful when
used in conjunction with the Cue List. For example, suppose
you had music on Play Channel | and a voice over on Play
Channel 2 in the Cue List. The music is a much longer
segment than the voice over, and you want the volume of
music (o lower while the voice over plays. After the voice
over completes, you want the music volume to raise again,

The above hypothetical case is easily accomplished with the
MIXer:

1. Load the Mixer and Cue List modules.

2. Select Record Volume in the Mixer Options menu to
turn on mixer recording,

3. Select Use Mixer Levels in the Cue List Options menu,

4.  Begin the Cue List by depressing the play button in the
Cue List. This will begin internal time code generation,

L

The music will start playing.

6. Just before the voice over starts playing, lower the mixer
volume level on the music channel. When the voice over
finishes, raise the mixer volume on the music channel
back to its normal level.

7. Press stop on the Cue List. At this point, the mixer has
memorized the music volume changes.

8. You can replay the mix by turning off Record Volume
and turning on Playback Veolume, both in the Mixer
Options menu. Start the Cue List as you do normally, and
the mixer should now perform the volume changes
automatically.
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Mixer Menu

New

Open

Save

Save As...

Options Menu

Record Volume

Record Pans

Snapshot Levels

Mixer Chapters

Clears all record volume and pan movements on all channels.

Loads a previously saved mixer file from disk. All previously
saved volume and pan movements are restored. The current
pan and volume information is erased, and replaced by the
information being loaded from disk.

Same as Save As... except you don't need to specify a file
name. The last file name specified will be used, or a file
requester will open if no prior Save As... was performed.

The information saved in the last Saved As... is lost, and is
replaced with the current volume and pan information.

Allows you to saved the current volume and pan information
for all channels into a file on disk. You will be prompted for
the file name to use when saving.

After you have recorded a mix, you should save it. If you quit
the mixer module or Studio 16 without saving your current
volume and pan information, the information will be lost,

This menu is either activated (indicated by a check mark) or
not. When activated, any volume changes are stamped with
the current SMPTE time code and remembered.

You can perform "punch ins" and make changes to existing
recorded volumes since any new volume changes replace
existing volume changes with similar time codes.

Works the same as Record Volume, except pan movements
are remembered,

Records the current volume or pan slider positions at the
current time code. You can use the SMPTE Generator
module to set the current time code. Snapshot is often used to
set the initial levels at the beginning of a long sequence.

Record Yolume must be activated for snapshot to record the
current volume levels. Similarly, Record Pan must be
activated for snapshot to record the current pan states.
Snapshot Levels is ghosted unless Record Volume or Record
Pan is selected.
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Playback Volume When activated, this will cause recorded volume levels 1o
play back synchronized to SMPTE time code. Note that you
can play and record slider positions simultaneously.

Playback Pan This menu operates the same as Playback Volume, except it
replays pan changes.

Digital Meters When activated, this will change the scrolling graph to a
digital bar meter,

Enable MIDI When activated, the mixer will monitor the Amiga's serial
port for MIDI "control change” messages which it will use to
move the volume and pan sliders.

To use this mode, you will need an external controller such as
the JLCooper FaderMaster or Peavey PC 1600, When using
the FaderMaster, use factory preset | to generate the correct
control change messages, The PC 1600 works well with
preset number 0 or 3.

When Enabled, the default mixer settings responds to M1D1
"control change” events (OxBn) of types 7 (main volume) and
10 (pan controllers). However, these can be changed with
MIDI Preferences...

MIDI Preferences... The MIDI Preferences menu will bring up a new window
where you select which MIDI channel number and controller
ID number each slider should respond to. The default IDs are
7 for volume, and 10 for pan. The default channels start at 0
and move up for each slider,

To alter a particular channel, select its name in the list. Once
selected, the slider gadget will move to indicate the settings
for that channel. You can then move the sliders to change
which MIDI channel number and controller ID the mixer
slider will respond to,

The MIDI Preferences requester also includes a string gadget
where you can specify which Amiga exec device to use for
MIDI information. If you change the device name, you should
disable, then re-enable MIDM for the new device 1o take
effect.

Channels Menu
Allows you to specify which channels the mixer will display, Select the channels
required, Input should be selected to monitor incoming audio.
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NOTE To select multiple options in a menu click the left mouse button while holding down
the right button.
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Module List

Class: Application Module (Dormant)

Description: The Module List, lets you load or unload code from disk and
memory. You can load a module multiple times to create
multiple instances. The Module List will not be used by most
users. It is included for advanced users or for those rare
occasions that require its use.

~|  Module Librarian | =

out
ADS16Handlert
CuelL ist
Editor
Instance
essageMonito
eters
ixer
odList

Figure B-87. Module List (Librarian)

Layout: In the Module List, the left list contains modules on disk in
your Applications, Utilities, or Drivers directories. The right
list contains modules that are currently in RAM. Double
clicking an entry in the left list (the "on disk" list) will cause
the module to load into RAM. Generally the loaded window
won't open unless you select it in the Instance List. Double
clicking an eniry in the right list {the "in RAM" or "Resident”
list) will cause the module to unload itself. However, its
"instance” will remain in the Instance List until removed.

Procedure
Move Module List From the Dormant Directory
1. Quit Studio 16.

From WorkBench open the Dormant directory, by clicking its icon.
Drag the Module List icon on to the Application directory icon.

Delete the S:Studiol6Instance.config file.

o W

Load Studio 16, Module List will appear in the Applications Menu,
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Preferences

Keyboard Shortcut: P

Class: Application Module

Description: Preferences is located in the Project Menu. It is dedicated to

customizing the appearance and performance of Studio 16.
Included in Preferences are: Interface Options, SMPTE
source, Memory Options, and the default Record Format,

Figure B-88. Preferences

Layout: The Preferences window is divided into four sections:
Interface, SMPTE, Memory and Record Format,

Interface

Color Boxes and

Sliders Click on a Color Box to select which color to adjust. Slide the
knob on the red, green and blue sliders to adjust the color,
The affected areas will update as vou adjust the slider, Click
Save Setup in the Project Menu to have Studio 16 use the new
colors on loading.

Preset Drop List Click on the 3 to view a list of preset screen colors, Use the
scroll bar and arrow buttons to scroll through the options.
Click a selection to make the Studio 16 screen update using
the new colors.

Interlace When selecting Interlace, your screen will double in vertical

resolution resulting in a larger work area. To activate the
Interlace mode, you must select Interlace, select SaveSetup
from the Project Menu, Quit Studio 16, and then restart the
program.
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On an Amiga 4000 you must also set the 'Aveoid Flicker' and
‘Mode Promotion’ flags in the IControl Preferences’ program
found in the WorkBench preferences drawer,

An Amiga 2000 in Interlace mode requires a flicker fixer.

ClickToFront Activating this button will allow you to bring windows to the
front by simply clicking anywhere on them. If it is not
selected, you bring a window to the front by clicking the
Depth Gadget in the title bar of windows, or by calling them
to the front with the keyboard shortcut,

SimpleTitleBar This button will cause the Close, Minimize and Depth button
to only show in the active window. All non-active windows
will only display the module name.

SMPTE

SMPTE Source Click on the droplist to select your default SMPTE source.
The recommended setting is either AD516#1 or AD1012#1.
This will set your default Source to vour External SMPTE;
however, it will be overridden to SMPTE gen when you open
SMPTE Generator. Closing SMPTE Generator will cause
Studio 16 to revert to your default setting, (e.g. AD516#1).

SMPTE Rate By selecting 24, 25, 30DF or 29.97 Frames per Second, or
you select which SMPTE Time code format to be used by the
SMPTE Maonitor and Generator, Sample Editor and Cue List
Module.

The common applications for the available formats are:
24 Motion Pictures

23 European Video (PAL)

2997 USA Color Video

30DF USA Color Video

For more information on the various SMPTE formats see
Chapter 5 - SMPTE.

Lock On/Lock Off  When selected, Lock On causes Studio 16 to continuously
inspect SMPTE time being read and automatically adjusts the
play and record speeds required to keep a sample in sync.
This option is recommended if you are triggering long
samples in the Cue List.
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Memory Gadget

Use Extended
Memory

Channel Buf

User's Manual

This button controls which type of memory Studio 16 uses for
its channel buffers. If selected, this button causes Studio 16 10
try to allocated channel buffers in extended memory first,
followed by 24 bit DMA memory, and lastly chip memory. If
it is NOT selected, Studio 16 will not put channel buffers in
extended memory.

You should select this button if your hard disk controller and
‘030,040 processor are on the same PCB. (e.g. You have a
stock A3000, or vou have a GVP combo card.)

You should not select this button if you have an '030 or '040,
but your hard disk is on a stand alone Zorro IT card. (e.g. You
have a GVP series IT DMA hard disk controller and a PP&S
040 card with 32 bit RAM.)

Your Amiga has three types of memory:

Chip Memary
Memory that is directly accessible by the Amiga's custom
chips.

24 Bit DMA Memory

Memory within the first 16MB of an address range. This
kind of memory is directly accessible by Zorro 11 DMA hard
disk controllers.

Extended Memory

Memory beyond the first I6MB of an address range. This
type of memory is usually on an accelerator card, or on the
motherboard of the A3000/A4000. This memory can not be
directly accessed by Zorro IT DMA hard disk controllers.

Studio 16 allocates "Channel Buffers" in RAM when playing
a sound, Data is buffered there on its way to or from the hard
disk. For efficient data transfer, DMA hard disk controllers
need direct access to these buffers. This means that if you
have a Zorro 11 AutoConfig DMA hard disk controller, your
channel buffers can not reside in extended memory. This is
because Zorro 11 cards can not DMA into extended memory.

The Channel Buffer specifies how much RAM you want to
use for buffering each sound that plays back. When playing
back multiple sounds simultaneously, a channel buffer is
allocated for each playing sound.
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If vou have less than 3 MB of RAM, reduce the default
channel buffer size from 256K to about 64K. You may want
to increase the default channel buffer size if you have a slow
hard disk, or you encounter "skipping" while playing sounds,
See the Chapter 7-Troubleshooting for information on
skipping.

Keep in mind that one channel buffer is allocated for each
playing sample. Make sure you have enough system RAM to
cover your requested buffers, The chart below lists the RAM
used by a specific number of playback samples. For example,
if you plan to play four simultaneous tracks with the channel
buffer set to 4096K, you will need 16,384K (or 16 MB) of
free RAM just for buffers.

The default setting (256K) is adequate for most systems.

Channel RAM Usage by a Specific Number of Tracks Playing Simultaneously

Buf Size 1 2 3 4 5 B 7 8

128 0.1MB 0.3mB8 0O4MB OSME OGME OBMB  0SMB  1.0MB
256 0.3MB 05MB  O0BMB 1.0MB  1.3MB. 15MB 1.8MB° 2.O0MB
512 0.5MB 1.0MB 15MB 2O0MB  25MB  3.0MB  35MB 4.0MB
1,024 1.0MB 20MB8 30MB 40MBE 50ME GBOME T7.OME BOMB
2.048 2.0MB 40MB 60MB  BOMBE 10.0ME 12.0MB 14.0MB 16.0MB
4,086 4.0MB 8.0MB 120MBE 165.0MB 200MB 240MB 2B.0MB 32.0MB
Figure B-89. Channel Buffer Size RAM Requiremenis
Copy Buffer Size The Copy Buffer specifies how much memory to use in many

Edit, Save, and Load operations. The larger the CopyBuffer,
the quicker these operations will occur. The default is 32K.
(This setting is not related 1o the CopyBuffer sample created
during destructive edits.)

Record Format

When a sample is recorded it is usually stored in the Studio 16_2.0 file format. This is
the default format selected in Preferences. If your file is to be exported to another
sound program you can convert it to another file format in Sample List. You can also
record it direct to disk in that format.

When converting files to eight bit formats, you will decrease the size of the file by
half, and you will also lower its fidelity. However, if vou are working with samples
that don't require a high Signal-to-Noise Ratio, (e.g. explosions, crashes. etc.)
converting them to an 8 bit format will save disk space and still allow you 1o play
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them simultaneously with your 16 bit samples, assuming they were recorded at the

same rate.

Available file formats are:

Studio 16_2.0

Studiol6_1.0
Format

AIFF 16 bit Format

ATFF 8 bit Format

IFF 85V X Format

RAW Format

Record Path

Free

User's Manual

Studiol6_2.01s a 16 bit format, similar to AIFF, but it
appends special data that keeps track of non-destructive edits
and regions. Note that even though the AD 1012 records with
| 2 bits of resolution, it stores files using 16 bits. This format
was not altered for the 3.0 release of Studio 16.

The original Studio 16 format, similar to Studiol6_2.0 but
does not support regions.

This is a standard file format for 16 bit files. Studio 16 edits,
loads. and saves sounds with 16 bit files. AIFF is very
commeon on the Macintosh, and is used by some Amiga
software.

This is an AIFF format that only uses 8 bits. If you record in
this format, you will lose sound quality since you are
dropping bits. However, the file's size will be about 50%
smaller,

This is a very common Amiga 8 bit digital sound format.
Files recorded in this format can be loaded into 8 bit sound
editors, such as Perfect Sound or Audition 4, If you convert
from 16 bits to this format, you will lose sound quality since
you are dropping bits. However, the file size will be reduced
by half.

This stores raw sample data in two's complement binary form.
The first sample will be in the first word of the file (each
sample is 16 bits), the second sample will be in the second
word (third and fourth bytes), ete. This format is not generally
recommended, except perhaps for use by programmers who
want a simple file format to load.

Is selected in the Sample List. A display is shown in
Preferences.

The displayed number next to Free: is the number of available
megabytes in the selected record path.
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Quit

Keyhoard Shortcut: ()

Class: Project Module

Description: Select Quit, from the Project Menu when you want to end
your Studio 16 session, A requester will appear to verify you
want to quit. To save the current window arrangement and
Preference settings, select Save Setup from the Project Menu
before quitting.

NOTE If you have recorded into RAM, be sure to move your samples to hard disk before
turning off your -""tl'l'lllgi'l..
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Recorder

Keyvboard Shortcut: * R

Class: Application Module

Description: The Recorder Module allows you to monitor incoming audio,

adjust the gain, filter and sampling rate, and record audio to
hard disk.

The Meter Module is often used in conjunction with record.
By evaluating the input levels on the meters, the gain level is
easier 1o adjust

=3 Recorder — ADRS516 — Untitled ==
| Gain 13dBJ
| Rate 18988] =<i>l
_Honitor |__Record |__ Stop |__ Hame ||
Figure 8-90. ADS516 Recorder
Procedure

Record a Sound With the AD516 or AD1012
. Setup your audio connections as mentioned in Chapter 2 - Installation .

2. Launch Recorder, Mixer and Meter from the Applications Menu, AR*M*V.

3. AD516 ONLY - From the Recorder Menu, select Input L and Input R to record a
steren sample.

4, ADIDI2Z ONLY - Record a mono sample, by selecting Input.

5. Click Monitor in the Recorder.

6. With Menitor activated, you will be monitoring the audio input. This means the
audio entering the "audio in" jacks is being digitized and passed back out the
"audio out” jacks. The sound is being digitized, but not stored on your hard disk.

7. With monitor on, you should be able to hear your audio source, and you should
see activity in the Mixer and Meters. If this doesn't occur, check your audio
sources and connections. Check the Mixer input and output level, they should
both be at +00dB.

The Mixer has a scrolling graph for each channel. When Monitor is turned on,
you will see activity in the Mixer's input and output channel,

NOTE ADS516 ONLY - If you are recording in stereo, The scrolling graph will usually be
symmetrical, the recorder is digitizing both the left and right channels. Unplug the
audio from the left channel to see the result of a mono sample on the scrolling graph.
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8. Once you are hearing audio, and see activity in Mixer and Meters you can adjust
the Rate and Gain controls in the record window. (A detailed description
follows in gadget reference.)

9. Click the Name button to assign a name for the sample you are about to record.
When prompted, type in the name and hit return.

10. When you are ready to record, click the Record button. A Record Status Display
will appear with the size of the sample being recorded and the remaining disk
space available in the record path, and the SMPTE start time if SMPTE was
coming into the AD516 during the recording.

11. Click the Stop button to stop recording.
12. Check Sample List for the new sample.

13. Play the sample by selecting the sample’s name in Sample List and hitting A-P.

NOTE ADS16 ONLY - A stereo sample will appear in the Sample List as two samples, like:
Untitled_L, and Untitled_R. Play both channels by selecting both samples in Sample
List. Shift clicking will enable you to select both of them, hit A-P to play.

Gadget

Gain The gain slider adjusts the gain of the card's internal input
amplifier. This i1s similar to a "record level” on a tape deck.
You generally want to keep the gain as high as possible
without causing "clipping”. Clipping occurs when the input
signal exceeds the analog to digital converter’s range. You
can see clipping on your input meters and Mixer. In the
Meters, it shows up in two ways: the digital VU meter in the
meter window will hit the far right side and turn another color
at the end. You can also see clipping when the scrolling
waveform touches the top and bottom of its box often. In the
Mixer, the peak indicator over the scrolling graph will flash.
Clipping causes distortion in your recorded audio and should
be avoided by reducing the gain.

The gain level required varies from device to device. Also,
when adjusting the gain, you may hear small, rapid clicks.
This is called "zipper noise” and is normal on the AD1012.
On the AD516, monitoring will stop while you are adjusting
gain.

There is a big difference between GAIN and VOLUME in
Studio 16, The gain setting adjusts the gain on analog
amplifiers before the Analog to Digital converter. Volume
settings (as in the mixer) use the DSP to digitally attenuate or
amplify a track. When recording a new sample, you should
set the Mixer volume sliders 1o +0dB, and adjust the gain for

208 Studio 16



User's Manual

Recorder Chapters

full scale. You can always lower the volume on playback, For
maximum Signal-to-Noise Ratio, you should always record at
full scale, 0dB.

7N

: i Audi
Al.ljlgm _@} (‘u‘uluma_ p GU‘?

Figure 8-91.

Gain Versus Volume

Filter

If adjusting the gain level has no effect on the audio level,
refer to Chapter 7 - Troubleshooting.

This feature is only available on the AD1012. Tt sets the -3dB
cutoff point of the 8th order low pass anti-aliasing filters of
ADI1012. There are two filters: one on the input and one on
the output, Both are always set to the same frequency.
Preferably, this filter should be set to half the sampling rate,
but you can vary it for different effects.

NOTE

AD516 ONLY - The AD516 has a much sharper digital filter. It's always set to 45%

of the sampling rate,

Rate

This sets the sampling rate for use by Monitor and Record.
For example, 44100 Hz (44.1 KHz) is the sampling rate used
by CD players and gives a theoretical 22KHz frequency
response. The theoretical frequency response of digitized
audio is half the sampling rate.

Studio 16 can record sound at many different sampling rates.
The faster the sampling rate, the better the frequency response
of the recorded signal, Unfortunately, with faster sampling
rates, more disk space is used. And just as importantly, faster
sampling rates mean faster data transfer rates. As a general
rule of thumb, with a 44KHz sampling rate, you will use 5SMB
per minute of audio per channel. See the space requirement
chart in Chapter 4,

As you move the rate slider, the sampling rate will change to
a new value, The AD516 and AD1012 only have certain
distinct rates available--set by the card's master clock. In
other words, the cards can not sample at any arbitrary rate,
Instead, you must select a rate from the predetermined rates
available. (For the AD1012 these rates are determined by the
formula; RATE = 10,000,000 + x, where x can range from
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Monitor

Record

Stop

Auto Filter

Mame

210

122 to 1320, The number 10,000,000 is derived from the
DSP's 10MHz master clock.) The Rate slider will show you
all available rates.

Users often feel the need to use a 44K sampling rate since it
15 the CD standard. But, if your final distribution media isn't a
CD, there’s not much point in using that fast of a sampling
rate. Often, a 30K-32K sampling rate is just as good for
material that will end up on tape. While monitor is on, try
adjusting the rate slider and listening to the effect it has on
audio quality. Pick the lowest rate that gives you acceptable
audio quality. Once you pick a rate you should try to record
all your samples at the same rate. This will prevent any
problems when mixing samples.

There are a few situations that may require you to use lower
sampling rates:

®  Your hard disk is full

®  Your hard disk is skipping during playback

B Your screen flashes
See Chapter 7 - Troubleshooting - for more information.

Click this button to begin monitoring the Audio going into the
A316 or AD1012, To adjust the level of the Monitor, you
can load a Mixer and adjust the monitor or input channel by
sliding the associated bar up or down.

Click this button to start recording.

The Stop button is clicked to stop recording. The hard disk
light may continue to flash for 1-20 seconds. This is normal
and 15 dependent on vour channel buffer size and hard disk
speed.

Only available on the AD1012. Activating Auto Filter will
cause the Filter Value to "track” the Sampling Rate at the
preferred relationship of; Filter Rate =1/2 Sampling Rate.
Changes in the Sampling Rate will automatically cause the
Filter rate to update as long as auto filter is activated.

The ADS16's low pass filter is always set to .45 times the
sampling rate

This button must be selected 1o name a sample before making
a recording. The default setting is Untitled, If the sample
name has already been used, Studio 16 will append a number
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to the new recording. To change a name of a sample after is
has been recorded, you can use the Rename option in the
Sample List Menu,

NOTE Do not use a greater than symbol (=) in a sample name. It 15 reserved to delineate

regions.

Recorder Menu

The Recorder Menu allows you to select the input and output channel(s) to record. If
you are recording in monao, select either Input L or Input R. For stereo, activate both
channels, You may also select Output L or Output R.

If vou have multiple cards installed, you can record more than 2 channels
simultaneously.

Handler Menu

This menu only appears if you have more than one AD516 or AD1012 installed, it
allows you to select which card the recorder settings will affect.
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Sample List

Keyhoard Shortcut: * O

Class: Application Module

Description: The Sample List contains lists of your samples by directory.
You can play, rename, delete, and edit from Sample List.
Launch the Sample List by selecting it from the Applications
Menu, or type * O.

A sample in the Sample List is a digitized sound on your hard
disk. Since Studio 16 always works with files on the hard
disk, it is a little different from most programs. For example,
there is no need to save each sound before you quit. If you
quit Studio 16, then re-run it later, all your sounds in the
Sample List will still be there. Of course, if you have your
samples in RAM:, your samples will be lost when you turn off
your Amiga unless you save them to disk.

All the samples in the Sample List are draggable to the Cue
List. As are the regions that can be displayed in Sample List
(activate Show Regions in the Sample List Menu).

All the Sample List Menu options can be executed on
multiple samples. Select multiple samples by holding down
the shift key, and clicking on the Samples’ names,

=] Sample List |
I AUDIO: _IRAH:
TrackZ_L
TrackZ_R
£ r

= 2}

Figure 8-32. Sample List
Gadget
Record Path The record path is the directory where samples will be

recorded to. It is indicated by an active box next to the
directory name. To change the record path, add another path
{menu option) and then click the active box next to the new
directory’s name.
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Sample List Menu

Play Sample Select this option to play a sample. Select multiple samples
by shift clicking. When playing back multiple samples, the
sampling rate must be the same for all samples. A single
AD516 is limited to a maximum of 8 simultaneous samples,
the ADI012 is limited 1o a maximum of 4.

NOTE ADS516 ONLY - A stereo sample will appear in the Sample List as two samples, like:
Untitled_L., and Untitled_R. Play both channels by selecting both samples in Sample
List. Shift clicking will enable you to select both of them, hit A-P to play.

To adjust the volume and pan of samples while they play,
load the Mixer from the Applications Menu and make level
adjustments in real-time,

Stop Playback To stop playing sounds, select the Stop Playback item, (A-5).
Rename Sample The Rename option allows you to change the name of

samples in Sample List. Select one or more sample names so
that they are highlighted. Select the Rename Samples option.
For each sample selected, a requester will appear asking you
to type in the new name for the sample.

Delete Sample To remove a sound permanently from your hard disk and the
Sample List, select its name in the Sample List then select the
Delete option. This will delete the file.

WARNING There is no way to recover a sample deleted in Sample List or the Cue List.

Convert Sample This option allows you to convert the file format of a sample
to an alternate format. Once a Studio16_2.0 sample has been
converted to another format, it can still be accessed by Studio
16, but any region parameters and/or SMPTE start times that
were associated with it may be lost,

When converting samples to eight bit formats, you decrease
the size of the file size by half, and you also lower its fidelity.
However, if you are working with samples that don't require a
high Signal-to-Noise Ratio, (e.g. explosions, crashes. etc.)
converting them to an 8 bit format will save disk space and
still allow you to play them simultaneously with your 16 bit
samples, assuming they were recorded at the same rate,

Available file formats are:
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Studio 16_2.0 Format

Studiol6_2.01s a 16 bit format, similar to AIFF, but it
appends special data that Keeps track of non-destructive edits
and regions. Note that even though the AD1012 records with
12 bits of resolution, it stores files using 16 bits. This format
was not altered for the 3.0 release of Studio 16,

Studio16_1.0 Format
The original Studio 16 format.

AlIFF 16 bit Format

This is a standard file format for 16 bit files. Studio 16 edits,
loads, and saves sounds with 16 bits. AIFF 15 very common
on the Macintosh, and is used by some Amiga software. AIFF
does not remember regions or non-destructive edits.

AIFF 8 bit Format

This is an AIFF format that only uses 8 bits. If vou convert to
this format, you will lose some sound quality since you are
dropping bits. However, the file's size will be reduced by
about half,

IFF BSWVX Format

This is a very common Amiga format for 8 bit samples. Files
convert to this format can be loaded into 8 bit sound editors,
such as Perfect Sound or Audition 4. If you convert to this
format, you will lose some sound quality since you are
dropping bits. However, if the file is a sound effect you may
not notice the decrease in fidelity, and the file's size will be
reduced by about half.

RAW Format

This stores raw sample data in two's complement binary form.
The first sample will be in the first word of the file (each
sample is 16 bits), the second sample will be in the second
word (third and fourth bytes), etc. This format is not generally
recommended, except perhaps for use by programmers who
want a simple file format to load.

Selecting a sample name then the Edit option will bring up
the sample in an editor, See the Edit Reference Section for a
maore complete description.

Select this option to add another directory to the Sample List,
This is especially useful if you are working with multiple hard
drives or you have samples organized into multiple
directories. When selected, a path requester will appear
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Remove Path

Update Path

Show Regions

216

allowing you to select a new path. Click OK to update Sample
List. A maximum of eight directories can be listed at once.

Select Remove to bring up a Remove Path requester. Only
those directories currently listed in Sample List will be
available for removal

Selecting this option will update the current directories in the
Sample List. This is useful if you are using a removable
media drive like SyQuest, and you change cartridges, or if
you are copying files from DFO and you change diskettes.

When activated, a region list will be added to the right of
your paths. The region list will display the regions that have
been selected for a specific sample. Select a sample with
regions, and the names of the regions will be displayed in the
region list. You can drag regions from the Sample List into
the Cue List.
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SMPTE Generator

Keyboard Shortcut:
Class:

Description:

_~ | _SMPTE Generator |7 |7|

~G
Application Module

The SMPTE Generator module allows you to generate
internal SMPTE time code. You can use the internal time
code generator to drive the Cue List and the SMPTE Monitor
modules.

When SMPTE Generator is opened, it automatically sets the
current SMPTE Source to Internal. When you close the
SMPTE generator, the default source becomes active again.

The main advantage of the internal time code generator is its
ability to trigger the Cue List. Anyone can set up long audio
sequences of different samples without using the editor to do
destructive editing. The Cue List allows you to specify the
starting time code and mix level of an unlimited number of
sounds.

The SMPTE Generator does not output physical time code, or
enable you to stripe tapes. SunRize's optional module,
SMPTE Output, includes this feature.

I | T N

Figure 8-93.

SMPTE Generator

Gadget

Display

Play

The SMPTE display obviously shows the current time code
being generated by Studio 16. Not so obvious is the fact the
you can type directly into the display when it is stopped. Just
click on the digit you want to change and type in the new
number, Also, when used in conjunction with the Cue List,
SMPTE Generator will update to the location of the play flag
whenever it is moved.

This will start time code generation from the current value
displayed. If Cue List has entries listed, and it's turned on,
clicking play here will trigger the Cue List.
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Stop This will stop (pause) the generation of time code, to continue
generation click (play).

Rewind This will advance the counter at 5 % normal speed in the
reverse direction. Time code is not generated in this mode,

Fast Forward This will advance the counter at 5 x normal speed. Time code
is not generated in this mode,

The recommended set time is 5 seconds before the first
sample triggers. This allows time for samples to preload.

SMPTE Gen Menu

Lero SMPTE Time  Select this option to reset the SMPTE counter to 00:00:00:00.

Play / Stop / Rewind

{ FastForward These functions are explained above in the gadget section.
The keyboard shortcuts for the buttons are listed next to their
menu item names.

Store Menu

This menu allows you to store up to 10 preset time codes. To store a specific time
code, first type in the desired frame location into the SMPTE Generator display or
fastforward to the desired time. Then select a Memory # 0-9 item from this menu or
hit the right Amiga key, shift, and a number key (-9,

Recall Menu
To recall a preset time code, simply hit the right Amiga and the number key used 1o
store it or select a TimeCode Recall 00:00:00:00 item
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SMPTE Monitor

Keyboard Shorteut: * 5

Class:

Description:

Application Module

The SMPTE Monitor allows you to view incoming external
or internal SMPTE time code. It is useful for viewing the
value of external time code coming into a card. This module
can allow you to do pencil edits without having to record a
SMPTE window box on video tape. If you own a genlock,
you can use this module to produce a SMPTE window dub.
Select Hide Title Bar from the SMPTE Monitor Menu,

When used in conjunction with the Cue List, SMPTE Monitor
will update to the location of the play flag whenever it is
moved.

LI__EEIHEMF_]EIj

Figure 8-94.

SMPTE Monitor
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The SMPTE monitor displays the current time code in its
window, The SMPTE monitor also looks for three types of
SMPTE errors, invalid time code and SMPTE time-out and
SMPTE jump. If a time code is deemed invalid by Studio 16,
one of three small squares in the upper left corner of the
SMPTE Monitor window will flash. It is normal for this
square to flash occasionally, such as when you start and stop
time code. If the square flashes constantly, check to make
sure that you have set the correct SMPTE frame rate in
Preferences.

From Left to Right, the squares mean:
SMPTE Time Out

No time code was detected for about 1/2 a second. Pausing
your video deck will cause this.

SMPTE Time Code Error

This error is generated if an illegal time code is read by the
SMPTE reader. For example, a time code with 69 seconds

would generate this error. This error typically results from
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distortion, usually a bad cable, a bad connection, or tape drop
out,

SMPTE Time Code Jump

This error means that a discontinuity occurred in the time
code. For example 00:01:00:01, 00:01:00:02, 00:03:00:12,
(0:03:00:13 would cause this error. Jumps typically oceur
when you fast forward or rewind the time code source,

If vou have multiple AD316s or AD1012s, use Preferences to
select the card to be the source of time code monitored.

SMPTE Capture Procedures

SMPTE Capture allows you to determine the exact frame number of a specific event.
By typing A-F when the SMPTE Monitor window is active, you can stop and start
the SMPTE monitor.

1. Load SMPTE Generator and SMPTE Monitor from Applications Menu.

2. Start the SMPTE Generator by clicking Play.
3. IMPORTANT - Click on the SMPTE monitor window to make it active.
4. Select Freeze Display from the SMPTE Monitor Menu to capture the SMPTE

Momitor display. Note that the keyboard shortcut for Freeze Display is A-F
5. Hit A-F again or select the freeze menu option to resume monitoring,

You can also capture specific time frame in the Cue List by using the TimeCode Add
Option.

SMPTE Monitor Menu Procedures

Hide Title Bar

This option removes the title bar from the window. It is ideal for making a SMPTE
dub onto video tape, provided you have a Gen Lock. Click anywhere on the screen to
deactivate this option.

Freeze Display

This option pauses SMPTE Monitor on any time code. Use this option to locate a

specific frame of video as it plays. The keyboard shoricut (A-F) is almost always
used.
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Shell Commands

The following list of Shell commands are available in Studio 16, These commands
allow you to access Studio 16 samples and SMPTE time code without loading the
Studio 16 Program.

Studiol6 - Load Studio 16

StudioClose - Remove Studio 16 Modules from Memory

StudioOpen - Open Library and Load Studio 16 Device Drivers and Utilities
StudioPlay - Play Sounds from AD516 without loading Studio 16
StudioQuery - Display SMPTE Time Code

StudioStop - Stop Currently Playing Sounds

StudioWait - Wait for Specified SMPTE Time to Occur

Studio16

Class: Shell Command
I
Format: Swdiol6 ?uﬁﬁchfﬂl /i< icﬂ”*ﬂ‘f."’k YRHe -{F/
c‘qﬂi {_,--L-,rﬂ{,.ﬂ:' WJE f"f_fr'*/j(- .--"
Description: The Studiol6 command \*‘éd to hum. t tudio 16 A

environment. After Studio 16 loads itself, it will display an L
About window containing the program revision number and @
o

other _Epﬂmmlmm. about mur setup. LA WT"{‘ :
pr T L ST

sptet O C@r\rﬂ-ﬂﬂf fang a7 ..1-:-_;,.
Mdm Iﬁ Screen Option allows you to specify which X
( screen Studio 16 opens its modules sa. 4'} <
BBgwegn f:}- . LN, =
Procedures ‘e, HTle
: - g
Opening Studio 16 on a WorkBench Screen ’i‘\ [ 8
Loading Studio 16 1o a WorkBench screen allows you to take advantage of monitors 5

with higher resolution that only work with WorkBench. From Shell, type:
cd Studiol6_3:

Studicolt Screen WorkBench

You should change your WorkBench screen to 8 colors using WorkBench
preferences.

Opening Studio 16 on any Screen

Open Studiol6 on any screen by using the above command, but replace WorkBench
with the first few letter of the alternate screen's title. The title 15 located in the upper
left corner on the screen’s title bar.
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Example: If you have an application who opens a screen with the text
"ABC Software Corp. (c) 1992" in the title bar, you could
cause Studio16 to open onto this screen by typing:

cd Studiole_3:
Studiolf Screen ABC

Studio 16 prefers an 8 color screen, but it will try to open on
anything. Also, the color mapping of the screen's application
may not match Studio 16's,

StudioClose

Class: Shell Command
Format: StudioClose
Description: StudioClose is a Shell command that removes all Studio 16

modules from memory. It's just like selecting Quit. See
StudioPlay for an illustration.

StudioOpen

Class: Shell Command

Format: StudioOpen <ModuleName>

ModuleName represents the name of a Studio 16 module.
(Optional Parameter)

Description: StudioOpen is a Shell command that will open the Studiol6
library and load device drivers and utilities plus an optional
Studic 16 module into memory. See StudioPlay for an
illustration.

StudioPlay

Class: Shell Command

Format: StudioPlay <SampleName>

SampleName represents the name of a Studio 16 sample. (It
should be a complete path, i.e. Audio:DoorBell)

222 Studio 16



User's Manual

Shell Commands Chapter 8

Description: A Shell command that allows you to play sounds from the
ADS516 without loading Studio 16. It may also be used to
incorporate 16 bit samples in your own programs,

Procedures
Playing Multiple Sounds

If you plan to do multiple StudioPlay commands, and if you want to maximize the
speed at which they respond, you can use the following sequence:

StudioCpen

StudioPlay <SampleName>
StudioPlay <SampleName:>
StudioClose

The command StudioOpen will load Studiol6 device drivers to RAM. StudioClose
removes them.

StudioQuery

Class: Shell Command
Format: StudioQuery
Description: StudioQuery will display the current SMPTE time code in the

format HH:MM:SS:FF. For a quicker response, precede the
command with StudioOpen, and follow it with StudioClose.
See StudioPlay for a similar example.

StudioStop

Class: Shell Command
Format: StudioStop
Description: StudioStop is a Shell command that can used to stop currently

playing sounds from the Shell.

StudioWait

Class: Shell Command

Format: StudioWait HH:MM:55:FF
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Description: StudioWait will wait for a specified SMPTE time to occur
This is useful for synchronizing SHELL or AREXX scripts,
AmigaVision, CanDo, and other programs with SMPTE time
code. To use StudioWait in a program, that program must be
capable of executing a DOS or SHELL command.
StudioWait can be interrupted with a *C or the "break’
AmigaDOS shell command. StudioWait loads the device
drivers when it 15 first executed. For maximum response, you

can use the scquence:
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Time

Class:

Application Module

Description: The Time module displays the current system time of your
Amiga. This module is resizeable which makes it easy to
place on the Studiol6 screen. Refer to you Amiga manual for

instructions on setting the system time,

==

=y Tine

Time

Figure 8-95.
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Tiny Mixer

Class: Application Module

Description: This module controls the volume of each of the playback
channels as well as the input and output channels. The
volume may be changed before, during, or after sample
playback. The input volume slider is used to control the
volume of the monitor channel. That is, the amount of sound
passing from the input of the card to the output of the card.
Use a mixer when you need to adjust a sample's volume in
real-time.

The Tiny Mixer features digital volume controls with a range
from +6dB to -40dB in 1dB increments and -00dB (-= or, no
volume).

=1 Tiny Hixer 1E_*I-r'—~
_I:E_I_I.J..I'::,j.jl:_..!

5 4 .

Figure 8-96. Tiny Mixer

The Tiny Mixer has two advantages over the main Mixer:

«  Tiny Mixer takes up less memory and CPU processing
time than the standard Mixer module. It should be used
on smaller or slower computer systems.

»  Tiny Mixer can be resized to fit just about anywhere on a
crowded Studiol6 screen and easily displays more than
six channels.

NOTE ADS516 ONLY - The Tiny Mixer does not have a pan adjustment,

Tiny Mixer Menu
The only menu option for Tiny Mixer contains the channel selector. Use your mouse
to select which channels to show in the mixer.
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Utility

Class: Utility Module

Description: Utility is responsible for loading and saving files and is used
when playing sounds. It does not require user access,

User's Manual 229



Chapters  Ulility

230 Studio 16



User's Manual

Appendix A

Technical Support

If you have any problems with your Studio 16 system, please note the following
instructions.

1. If you have a read/write error on your installation floppy disks, call SunRize for
replacement.

2. Check the Read_Me file in the Studio 16 directory. This file contains recent
developments and updated information that is not included in this manual.

3. Read Chapter 7 - Troubleshooting.

4, If you suspect a malfunctioning AD516 or AD1012, call SunRize for
instructions.

NOTE

When calling SunRize for technical support, please have the Studio 16 software
version and your serial number handy. The software version is displayed in the About
window, Your serial number is on the first page of this manual.

SunRize Industries Technical Support can be reached at (408) 374-4962. Technical
Support is available Monday through Friday from 9:00 a.m. to 5:00 p.m. PST.

U.S.A. SunRize Industries
2959 Winchester Blvd., 2nd Floor
Campbell, CA 95008 USA
Tel: (408)-374-4962
Fax: (408)-374-4963

European users may contact their local distributer for technical support.

Australia AmiTech
P.O. Box 343

Shop 9/2A Surf Road
Cronella, NSW 2230
Tel: +61 (02) 544-1874
Fax: +61 (012) 544-1873
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Benelux {EE1gium. H{)"and. & I:!:III-&I:' 1 P?‘Ddll(‘:il}nﬁ
Luxernbourg) {n:'mfc?._l.'mdc 167

6413 GD Heerlen 3
The Netherlands
Tel: +31 (045) 22578
Fax: +31 (045) 212263

Brazil Beija-Flor Production Arts
Rue Bambina 134/705 BL-01
Rio De Janeiro, CEP 22251
Tel: +535(21) 246-1992
Fax: +55 (21) 240-9567

Canada North American Software
61848 Kestrel Rd.
Mississauga, ONT L5T 122
Tel: (800) 468-4300
Fax: (416) 795-0844

Denmark & Finland Broadline Oy

Vanha Porvoontie 295
Vantaa, SF 01260

Tel: 358 (940) 8747 900
Fax: +358 (90) 8744 944

Fraﬂ{]{-} Storm Media Productions
%3 Rue du Chemin, Vert
Paris, 75011
Tel: +33 (01)43 57 46 57
Fax: +33(01)48 057553

Ge-rm,;:;‘n'h,.r Advanced Systems & Software
Hamburger Landstralie 412
6000 Frankfurt 50
Tel: +49 (069 5 48 81 30
Fax: +49 ((69) 5 48 18 45

Itaw A Pplied Peripherals & Software
Vio Giovanni XIII, 37
33040 Corono di Rosozzo, Udine
Tel: +39 (0432) 759264
Fax: +39 (0432) 759264
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Mexico

Norway

South Africa

South Korea

Spain

Sweden

Switzerland

Technical Support Appendix A

ALMEX Electronica
Cordoba No. 49, 5 Piso
Col. Roma

06700 Mexico, D.F.
Tel: +52 (5) 208-9292
Fax: +52 (9) 208-9677

FAMO

Kobenhavn GT. 15
0503 Oslo

Tel: +47 (22) 381 205
Fax: +47 (22) 357 797

ML Systems

PO Box 95275
Waterkloof 0145

Tel: 427 (12) 346-1160
Fax: +27 (12) 346-1334

Amea Corporation

140, Sam Heung Office Building
Yeoksan-Dong, Kangmam-Ku
seoul

Tel: +82 (2) 564-4966

Fax: +82 (2) 564-7650

PiXeL SOFT

Felipe I1, 3 BIS

34004 Palencia

Tel: +34 (07971 27 00
Fax: +34 (079) 71 28 28

Karlberg & Karlberg
Flidie Kyrkvig

5-237 91 Bjérred

Tel: +46 (0463 474 50
Fax: 446 (046) 471 20

Octave 2
Bahnhofstrasse 2

2542 Pieterlen

Tel: +41 (032) 872429
Fax: +41 (032) 872482
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Taiwan Vivid Image Center
No. 56 Lane 25 Sung-Teh Rd.
Taipei
Tel: +886 (02) 759-1371
Fax: +886 (02) 727-1235

United ngdﬂm Power Computing Ltd.
Unit 8, Railton Rd.
Woburn Road Industrial Estates
Kempston, Bedford MEK42 7PN
Tel: +44 (0234) 843 3588
Fax: +44 (0234) 840 234

White Knight

PO Box 2395

Waltham Cross, Herts, EN8 THQ
Tel: +44 (0992) 714-539

Fax: +44 (0992) 714-539
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Appendix B

Hardware Specifications

AD516

AD1012

5 tracks with 68000 at 44KHz
8 tracks with 68030 at 44KHz
Simultaneous Record and Playback

Frequency Response 15Hz - 22KHz
(-3dB)

ADSP 2105 sound coprocessor
(rated at 10MIPS, 100ns instruction
execution time

LTC SMPTE time code reader
(24,25,29.97 30 fps, drop and non-drop)

Dual 16 bit delta-sigma A/D converters
with digital anti-aliasing filters

Dual 16 bit delta-sigma D/A converters
with digital anti-aliasing filters

64 times oversampling

14 different sampling rates from 5.5KHz
to 48K Hz

> 85dB Dynamic Range

THD+N < .0095%

Stereo RCA jacks for unbalanced line
level (2 Volt RMS) audio inputs and

outputs

Input resistance S0K

| tracks with 683000 at 44KHz
4 tracks with 68030 at 44KHz
Simultaneous Record and Playback

Frequency response 20Hz - 20KHz
(-3dB)

ADSP 2105 sound coprocessor
(rated at 10 MIPS, 100ns instruction
execution time)

LTC SMPTE time code reader
(24,25,29.97 30 fps, drop and non-drop)

12 bit linear analog-to-digital converter
with sample and hold

12 bit linear digital-to-analog converter

with FIFO buffer
Two eighth order anti-aliasing filters

Adjustable sampling rate up o 48KHz

>70dB Dynamic Range
THD+N < 0.04%

Mono RCA jacks for unbalanced line
level audio input and output

Input resistance 50K
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AD516

AD1012

Cutput resistance < | ohm
Input digital gain levels: 16

256K of fast static RAM

8K of ROM
Zorro I1 AutoConfig card
Dimensions: 13.3 x 4.2 inches

Power supplied by Amiga

List Price $1495

236

Output resistance < 1 ohm
Input digital gain levels: 100

64K of fast static RAM, expandable 10
256K

8K of ROM
Zorro Il AumeConfig card
Dimensions: 13.3 x 4.2

Power supplied by Amiga

List Price $595
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Appendix C

Third Party Sources

This appendix contains a list of third party products that you may find useful when
using Studio 16. SunRize does not recommend any of these suppliers, they are

provided for your convenience only,

SMPTE VITC to LTC
Translator

MIDI to LTC Converter

SMPTE LTC Generator

MIDI Sequencer

Multi-Media Authoring
Software

Horita

VLT-50

P.0O. Box 3993

Mission Viejo, CA 92690
(714) 489-0240

MidiMan

30 N. Raymond
Pasadena, CA 91103
(R18) 449-883%8

SunRize Industries

SMPTE Output

2959 Winchester Blvd., 2nd Fl,
Campbell, CA 95008

(408) 374-4962

The Blue Ribbon SoundWorks, Ltd.
Bars&Pipes Professional

1605 Chantilly Dr., Suite 200

Adtlanta, GA 30324

(4047 315-0212

SCALA, Inc.

MM3I000, Infochannel

2323 Horse Pen Rd., Suite 202
Herndon, VA 22071

(703} 713-0900

237



Appendix C  Third Party Sources

238

Non-Linear Video
Playback

AREXX Sequencing
Software

Video Effects Generator

VHS Deck Modification
Allowing simultaneous access to Hi-Fi
and Linear audio tracks. Decks include
AG-1960,

MIDI Controllers

Audio-for-Video Mixer

Production Music

DPS, Inc.

Personal Ammation Recorder
Il Spiral Drive, Suite 10
Florence, KY 41042

(606) 371-5533

ASDG, Inc,

T-Rexx Professional
025 Stewart Streel
Madison, W1 53713
(608) 273-9240

NewTek Inc.

Video Toaster

1201 SW Executive Dr
Topeka, KS 66615
(B00) 847-6111

Carlson-5trand Company
[52 Calle de las Molonias
San Clemente, CA 92672
(T14) 492-8978

JLCooper
FaderMaster

12500 Beatrice St

Los Angeles, CA 90066
(3100 306-4131

Peavey

PC 1600

7-11 A Street
Mendian, MS 39310
(601} 483-5365

Mackie Designs
MicroSeries 1202

12230 Woodinville Drive
Woodinville, WA 98072
(8000 258-6683

Killer Tracks

6534 Sunset Blvd.
Hollywood, CA 90023
(213) 957-4455

(ROO) B77-0078
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Philadelphia Music Works
P.O. Box 947

Bryn Mawr, PA 19010
(215) B25-5656

(200) 368-0033

Valentino

500 Executive Blvd.
Elmsford, NY 10523
(212) 869-5210
(800) 223-6278

Sound Effects Libraries  Hollywood Edge
Dn CD ?[_:'f'![j E'i'i.'ll]}"ﬂ.'.'ﬂ'l.ld Bl'ﬂ-d #I IEU

Hollywood, CA 90028
(213) 466-6723
(BO0) 292-3755

Sound Ideas

105 West Beaver Creek Rd., Suite #4
Richmond Hill, Ontario L4B 1C6
CANADA

(416) 886-3000

(R00) 387-3030

Removable Media Drives SyQuest Technology
47071 Bayside Parkway
Fremont, CA 94538
(800)-245-2278

Iomega Corporation / Bernoulli
[821 West [omega Way

Roy, UT 84064

(B01) 778-3000

(BO0) 456-5522

Magneto Optical Drives  Ricoh
s P 3001 Orchard Parkway

San Jose, CA 95134
(B01)-955-3453

Panasonic Accessories and Systems
2130 Townline Rd.

Peoria, IL 61615

(RO0)-T742-8086
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Beats per minute.........ooiveeneniicnn 157

Blank audio entries......c.c.coviiernrermvsrnas a0
Blue Ribbon SoundWorks............... 237
BEME i snsmsvssinsisssmmimsnsnanasnismissioss 157
Brackeds ccoinsnnnnniiaisiinmg 6
Butt 6t ...coneisnresssrsnsrsrssssnsesssnsnssss 109

BAYERON - oo iessnissnonsvnsanesniiiesansiess 110

PIORIRA) e ncimnmsinmnniirraiis 4
Can't OpEn eITor ... i 67
Cancel button, Cue List....covrimeemreres 37
LT | B R T R e e N e
Card communication ermors ... a0
Cartoon soundtrack, tutorial ............. 29

Channel buffer

Channels, meters........ovimiiniinnens 188
CHip BAM i sianstessmyaiss 201
Elick 10 Fronk ... .coovmssnsdsmeis 14, 200
Clip indicator, mixer........ e 191
BTt 11 - 15,208
CLRDOtOn s s 192
Cmd fields, AREXX......ccvvernrercenes 13

OlO0 s isinssr it aisssnsssnce 35 190
O RITOT B i i nasssirsnrisives 60
Comment flag ......ccoremeimmmsmsnsssnssinn 120
Common screen elements ... 14
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AR s e 6, 90
getting started .........coumianinininn 14
] Sl e N e eh i A AR 6

CDOTAMBONOER . o i s s v
Constants, ARREX
Control drag......coeeeeessanee
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getting started
SAMPIe: ;. i i

Copy:
ELIOT v cnersnre s ermrnnn 171, 173
entries, Cue List wtorial ............. 43
getting stared oo 18

EFACK ..evvrercvmrnrrrersre s sansnssasesenans
Copy a8, editor ..o
Copy buffer........coeuren
CT0MG i iy i s

BOERAL i
Crossfade: ..ooiviioriisassine 63,935,108, 110

Preferences ..o errersmserennes 158

AT10] 5 11 PO ettt ana e 41

oS TTTL1 17 112
[T R e T 179

AWOMALIC S1Z8 .iveievriiisnisivssisnns 86

defanlts s 101

g7 1 B S cr R e S 139

open, WOTIal ... iinssresin 30

overview

preferences, tutorial ,...oveveenene 31

PrefBrBNeas . siscsssismsnnrs i snseras 154

FETBIENCE oorvrereesrsnerastssramsrsssnansanns B

I DAL s covunnimsinunnssssnpe s aiasissnpes 60

b ]| RRURPU VRO RIS . |
Current rate, resample ... 177
Cut;

] |13 R

gt AP

Decibelccuasmmiaaii
Default;
[T N T 49
QIAWEES ... e vervsernsnrersressrssserasesas 140
BN s s cmip it sarri s e nasin 141
VOIUME L. oo cosnnssonint cocnaiiiinsnins. 197
Delete;
B o S e 5
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ag .. 120
getting started. ..o 19
range, editor......c.coueeinnens 171, 173
TELION wnesrsnsessssrssnssbrsnss srsasasnasss 180
SAMPIE v 214
Depth gadget...........cooniiversnns 14, 200
Deselect all entries .....coveerevinsmnnn 150
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Hours:minutes:seconds ................... 156
ID nUMBET ... ...oiorenmirreisremmsnsssmaasss 194
[FE RSN X i 19,203, 215
Ignore SMPTE Errors.....o.oeee: 163
Input levels, S8t .....coiiiiinmmiens 50
Installation;
RARAWARE ©occveireiee e e e 5
PrOBIEmS o e e s 66
SOFWARE. ....0iiesersoss sinsmismns sensasasssnen 7
RIS e s b s 8
INSERNGE: i T 71
daplieabe:. . i |84
T ] SRt e e e el e 183
= o Lo 183
L 11 1L 184
SHOW e 184
Instant fade.........oocoininnnics 112, 135, 160
INEEITACE . cveiiors st ot btinnssserersrassrenannte 199
IOEEEIBOR. .. .. i cerissnssvismmvssissaioscsssss 199
Interrupts, AMIga....oooocviciereiiisnininns 3]
TIOVBT e vens sermesamsmssenssmpiminisnsssiss soiv 175
] LB o e e e e 194
JUMPEr, SEMHNZ . covveeiriiriemesnrirmeearanenens 6
Keep;
original time.......uweeermnenn 89, 163
521 1 R e et Y 174, 171
Keyboard shoreuts ..ovvesiiennniinnnn 13
LED mBter......cuimarmmimsae 15; 188
o e S 12
Limited cross fade.....cccouecanveinins 93, 109
Linear fade; .........cooevivenns 110, 134, 139
b aal i 42
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Load;

S0 16 s 9,13
1 1.0 L P S 148
LotabE FIAE. .ccismmcaimistimsssasrapiisissns 119
Add. . 99
COMIMBL ..veesmarnnsroreneranssasessenensnes 99
IR s nsavinch s A s en s 119
AN v sssssinisimmsnnnicas snsssaniss 120
IV i siissasinnsesassinauiasa sismnymsnon 120
L1 i 7. PR R S PRt £,

LOCK, TERET ...oimisisnsmrinnmsssiat bassruntnins
Lock-to-prid.......ommmmmsisaosinrnns 99, 107
Laage filbes c.oisiiiiimmvmiisiiatae i ]

Logarithmic fade ............. 111, 135, 159

Loop;editorcaminmimmig 179
Lowpass fIlter.....oooomemmninrcnnsnines 16
ETCSMPTE :ic i ansaimivimm iz 25
Magneto optical drives........ccoivvvnees 239
Make permanent ..o 172
Manually, size Cue List......ccorinennes 87
DRI .o ooy it S 157
% 11 1+ g Rl Y DR B 201
IVIBDIS oo s i nennscenn sinns 13

Merge, Cue Lists ....cociivicinniieieneens 140

MessageMonitor, reference ............. 185
% [T o 3 U PR SR 15, 188, 208
IOV il i i a visstiamida 1588
44 £ 4 =11 | RSt St PN 187
11115 2 e TR ey 50
MACTOPRONE .. snessersnresuans sianensmsassaspssss 46
MIDI;
controller. ... 189, 194, 238
enablE. TR 194
LTC CONVEITEL ..oanivivanesasiinnans 237
Preferences. . o viiimmismnsrsrss 194
SEHBICET . o ovesmsasinsrmisrpmmvars 27,237
GIE COAR conrnrrie v eeesermrnssms e psansss 27
TR s mnosisnison pic s amma i i |89
BULDITIBLE <ovsisnssrnissnivsns sassasnnins sion 192
clip indicator ... 191
EXBETnEL; s 46, 51

(o) SRR P 191
111 | - T oy 194
PRI oo e e 191
TEFEDENOR L iiiasinis s essssiniviasavns 189
scrolling graph ........ccccciennnnns 191
supplisr . ciinniaiinihiiig 238
use Jevels. .. 163
WOIUITIE oo ociamemssisistnsssassarrarisnnss 189
Module;
lanching. . .cosinisii mieisisi 13
load from InStance ... 183
NON-TESIABNE ..o.vivvevarevsvsvarsvassees 183
o [ ] SR e e e 197
oo | SR R b P gl -
IVOMIRON, e i rei e sanaes s ssnanans 15,210
RO o s v o rms bt s 207
VRIUITIE ©ovioinss snmmimissismisamassai s B
Motion pictures ..., 200
MOVE BNUIFIES cvevrereermersrrmersnsnsnres 38, 98
Multimedia authoring..........cccocvanas 237
Multiple;
A B ) RO 123
BAEDTR. .. covivsrismnapssnssins snsnisisgnmins 73
IMERARTES i onisismremsosmismmnivassssinn 197
Multitasking ..., 144
Multitrack recording tutorial............. 46
Music;
applications for SMPTE ............ 27
suppliers......coiviiiiiniins 238
BT £ 1 - T Ao 126
POUGITAL. - coisiisirsnnisions apssiimmsrainsninins 57
Name;
AREXX tracks .....oooiinicinininnanas 125
Audio rACKS ..ovvereiresrssmnerrerasses i3
field, AREXX .....ooooreriiniininninns 138
samples ...ooovreininvernnn 16, 208, 210
Mew;
08 Lish it smmes 139
BT cirmianmnmiimiraiie 170
MIRE i s 193
rate, TESAMPLE ..o e irssisarssares 177
MewTek InC...occcceiiinsiensis i snessnanes 238
245



NOn-destrucliVe: ..o eeersreeesesnseens 1 70

COBY, BAIO.. .ciniinrsnssassmiinionses 171
G I s 171
pAstE SO v i 171
MNon-linear video playback............... 238
Non-resident. ... 183
MNormalize: o miiniani 175
Nyquist tREOrem .....ooovveevermrarnsnsesnssnsens 2
BT button:asmmaiaismniiiniiag 116
Offset;
E0E LSt i nemmavernsipsnenarstneny 150
| 214 ] ] D SR 166
OK button, Cue List ... 136
OK requesiers. ... 13, 180
G Bt i 16
Open;
CUE LI .o nssemesrresmcs s ssrepssnens 139
| 5 1] 170
WELXEE coonsiammemcnsminemssaninanperiny 193
Oiptical drive..ciiinimimniini. 22
Options MENU ..oveeeeerrmrssimseacens e 154
Output volume..........oiiennmesnisiiininns 189
Overlap cOMention; .....ccoveeeersreeeees 112
LTI 71 O UROTOOTPUR. . |
Cverload eror .. mmmmnsiiag 62
i 11| R R Ry R e 179
Cue List; .covereeere e reeerenens 94, 135
tutorial......... crerernnnes 43
b e R M 191, 194
Paste
track.... 148
Editor i it 171, 173
Pause, SMPTEgenerator..........ccocee. 218
Peal MBLer i 188
PEAVEY eeerrreecerernemesrnresmsrssrsc e scenes 194
Perfect Sound ... 3, 203, 215
Performance 1SSUeS ......cviiciiieinine 115
Pitch SHifE voemmmnvntsssion s poss 176
Play;
backwards. ... 175

button, Cue List...o.een.., 103, 136

[ 1T [ U P 94
QEPLAY v e s iiiiinsansniios 3 00
BAitor covinmnmsiinssinni 1 70
BTV i e 153
getting started.......c.cooerrinirisin 17
multiple samples .......... 17,20, 223
i1 R R 169, 170
Sample List: ..ocovieriiemoieassinsns 214
SMPTE Generator ......veeeveveeees 217
SLACL BULLOME coeiei e siens 103
71 1 1 TS 1

T I3 F: | 170
Playback channel, Cue List ............. 122
Port found, AREXX.....cccveevene 96, 126
Position fIAP ..o 119
Preferences reference........cccoennenna, 199
Sy L e 31
Preset time COdes. ..o vimiesrsnssses 218

. 142

Production music supplier............... 238

3 [ 7 SRRSO

Project MENU .....oveo v enrssserssassnsmsnsrses 12

Punely INJOUL, i iiiisrvininiig 9]
PRy iiaiasns davetn anisonve L1 8
ttarralaanannnsaaiis 47
matorial....oiin i 52, 54
COATHEE TR o ovisicsssvpsmisssasenmmy vuranens 157
Quit reference. . i s ivesisns - 203
Quit Stdio 16 s rneseenes 20
RAM, installed on card .......ooeeivmneneins 71
Range;
delele...nnrnrereeerre s rerrsrmne s 171
T e e 166
MATKINE cvvinsansn s renans omsnssasanansns 167
PABLIE ... cossssorisssiemsssnssmmmmssnsssnsss 168
1] T SRREPNRISSRSRI TRRPRPRS - . 5 {1
BB, i s R e RS 178

Rate, sampling.......cccnnivnicciinicinns 209
RAW format.......ccccereeraenriennes 203, 215
Bead, Me fle ... 7
Becord:.....cooinmimiminsissninssansssinrarmnssns 210

Studio 16



User's Manual

button, Cue Lisl....onmmmemnnn.. 102

01 BT TRV a0, 102
BEDIEREL <. couvvsmmimasisrssivivieasiais 51
POrTOER i ciiinamuisissisisivs SIS
getting started v iniissinianries 14
PRNS, TXET ioicaiesiivnniisidassniivads 193
path i G 11,203, 213
SAMPIES ..oviiisesveirinms coinsmsnsmsancaions 207
source, Cue List.....coimninniracs 123
1] {0 T 50, 207
1o RAM ceecveecenenaees 10, 21, 205
track, ttorial .....ooommrmrmmsrinsrares 50
VOIIME, MIXEr e vnes e reesimnssmrransess 193
Recorder reference ..o 207
s e e P e e | 163
REEION; iociiiisciiniiatiniibasdin et i 130
AR i R 180
dedete . i nniGiR e 180
getting started i, 19
name buttons, Cue List.........e. 124
show, Sample List ..o 216
(17114 1 T —— 181
Registration card. ..., 0
Removable media drives ........... 21, 239
Remove,
(111 11| | PSSR 121
e EAst eny dinirnnasamsicn g 95
ERLEY: yuiii i svnban voveansuin amsns st d 152
U e e P pp e 100
INSUARGE iiisimsinisenossnmiisnsvssvsusin 184
51111 | (OO ORI PR 216
B e e e 145
Rename a Sample .....ccovvenienrs 211,214
Replace, Cue List entry ..coivimnnnn 95
| STELT0 ) ———— 176
RegtlettiOn .coiviveiimivisinmsnsnnss i sesnsss 10
Resident.....covevnrmrnimnnseerannnsise 183, 197
BoBlze o innninisi s st sassarp 14
Rasolubion: ..iieecsiiinininisavaviiivasarisnibe g8
PESAMPLE it 176
(LT 1 i Rl S e 88
REEERE s i pre s Ty SRR 175

Rewind;
SMPTE Generalor .....o..oveeacain 218
1 T T 104
Bexebast o iiinntuan 95
S1OChan VOl i issrsnsniens 75
L 17 [ TR L 76
i Lt T T A R R ey e PR 76
BIBEIIEL woviimssicamsi o sns savsmanpiinanins 76
0 i 1| P AN oD 77
L 5] R — T7
S160penRecord.......ccoviivvivnnininniivns T8
S160penWithAutoClose ... 78
SO R i iiviiviimis i e 78
B L S 79
S16QuerySmpteTime......cmamesnnrnn 79
SIBRALE......orreersrsrrississ sonssanssurassnsssesns 80
S1OSMPIESEL. ....ovvinrssmsvsinsivsrrissasnes 80
S16SMPESATL. .. cccrernsmsrerasasiiarssamases 79
RF TRl (] TP —— 80
S516S5topAllPlayback ... 81
S16TORACK ..o cveeerrerrrevarevarerassrass sass vans 81
S IETOETONE (v ovvsrrissressnnsinisnms sumeansiiens 81
SIOTHRERET coviicinsiusrssarirsissssanasasamimes 81
S IEVETEION. i rressunsesysssinsssmsisnspsssnsinsens 52
SIEWRIEGPE st 82
S16WaillTimeCode....c.ovvvrnsinisiesasens 82
Same start time contention ............. 114
Sample field, Cue List........cccooneeans 133
Sample LISt ..coummmincanssivmmnssassons 213
convert SAMPlE ...oorvrrrmsrerissnssens 214
BElbe . it s 214
getting started..coninennn 17
L | R s H e A S R 214
refarence i 213
(1111 111 |- S SR AR 214
SHOW TEEIONS .ovovererararsririnsssins 216
Sample size Bullon ........ccomvvmenmnns 124
Samplers......cciiiimnn i 46
Samples provided..........cooeceiiians 30
247
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Sampling Rate; ...o.oooooieiriinnninnnnnn 209

definition of ..o ]

IOWEEING. ....ccovrmrrirenrermmesnensnsessines 63

selecting.......... 16, 22, 61, 209, 210

AL s st e 3

Save As;
8 LiSE..ooossviinnressrssins bnsesssnrares 141
Lt T ST 193
Save;

[ T A L T 140
defanlt s 141
tutorial.. i 35,49

T e B e s 193

] [ e At A 20

EEACK e rerreesrmsrsne s ne s e sesns s |49

OB o s 167, 176
Scroll Bar, Cue Lisl...cocceceiiceane 88, 131
Scrolling graph, Mixer......cccooninnnne 191
Select;

NS s i S i 150

EFBCKS vicvsssnsnintsnivsstnmstimssens sinenes 128
ATTTS] oY SRR 50

SendW Ermor.....cooiiin i 60
Serial numMber .......oocvviereierererrirenrees 23]
Set;

display offset ...........ccoevininins 17

BT SPACINE 1ovvemivaiisnemnsnsissanssnns 161

PR i i s i 178

sample parms.....c..ccvivnireianiiens 178

Shell command, reference ............... 221
Shortcuts, keyboard........ccoeveinniininns 13
Show;

All e s 169

buttom ........... PR ||

Instance ...... . .. 184

FARPR G s iinspsssmsmniss s 169

regions, Sample List......... 180, 216

Signal-to-noise ratio .......coe. 2, 20, 209
Silence;
s ] OOV | o |
SEDELAE ..o covnrnarnprpaspss sopsnmassss 177
SimpleTitleBar.........cccciiininnn 200

SINE WAVE.....ovririisnersssisssserensesseinesens L TR
Size, Coe List:smunananiiai 87
T NT s 1] 62,202
Shider control.....ooiciiieassavssses 189
Smooth runtime scroll ..o 155
SMPTE; .ivvinmissinssssiss icisisansioass 25,156
CAPIINS ..oiiiinsimiirpisim e 220
CONRBCLIONS i isninnnrsisssisssisiins 6,7
BLTOLS i 219
ignore ....... 163
{375 1 - | e 25

Generator;
FEfErBNCe v s rmnercrreerans
SUPPLIBL....oveeeiesrec e

2 TE (] O

IPOAUCHON. . onsrms i mssisisissminiie, 2o

Monitor, reference .........oeeverees
music applications.......ueiviieens

Output module ........ccoiviieirinminn 26
o R e AR E L 217
PLOS s ieismmmrmmassssisisissenss 29, 156
rate verenmnrerenens 20, 101, 200
T IT ] T 7,200
time code errr...oeienne, 219
time code JUmp.......cnenmmveensnee. 220
HME UL BITOT ..cooe cvesernsarssnrsnnesos 219
VALICEY tBSL. corinvavivomsssisimsmmmanesis 219

video applications .........ccoiee. 26

VITC it i

window dub.........c.ceciiiiinrinrens 2
Snapshot..enn.
Software installation
Solo;
button
track, twtorial......ooeeereineesienens 57
Sound;
DUOT i vesuivisissssinsssiissiin: B 15 12D
BHRCIS o s 20
LB rares. o 239
provided ..o i 30
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Speaker button..........ooeriiiens 57,126

Rt H ol ansssatimn i 117
tborial ... i s 33, 4T

b 11 B A1 1 LU 3l
[ T1T 1001 EP SRR 124
COMPERION . cvuin s coiismneimssnssnnnessn 114
COELaEE . mmsismimroogly 138
field, Cue List..ooiieencrnoree 134

Status display ... 166

b ] 1] 1 TR S TR 179
POCODAINE oo ivvmespesiindssustinbassniiinnrs 15
Sample List.....cmminmmin 214

Stop;
button, Editor ...coccooeiecvvnennns 169
button, Cue List...ccoreerirsnsearens 104
BOilOr. cimiensssmmssmipessinmensmn e 170
1] EAT BT —— 153,214
POCOIT T, o o i s suiimcnsa 210
Sample List.....cocnsivisiimsmarisines: 214
SMPTE Generator.....couviveeesins 218
(4119, 5T | e e SR SR L e A R A 1

Striping time code s 26

Studio 16;
file format......iinnimniin 203,215
BRI o A 12
file SITUCIUTE ... oiicisninsivnsivnarini inrs 12
Vo iR s 9
Shell Command .......ooveeeivscinenns 221

SUdIOCIOSE ..o vermerrmssemssenssssnsssmrunains DEL

SWAIOOPEO o ciivcsii viesass brrmsms rasiasens 222

StudioPIAY ..ooosrsmianssirenssssmssnsasarasass 222

ST Ted o000 = R e i 223

SIUAIOSIOP .. ccveceeiie s snnes 223

StUdiOWRIL.....cooiviriss i ibssnass 223

Y NChPONIZALION, evives vesemssnmnrmsassrisssnnss 61l
LB . ssyes semissssetistkhbis s Fires 161

SYMIHESIZRIS s sucn vt svsvassas sanis 46

SYQUESE .o et 235,21

1) TR TR 107

Technical SUPPOTL ..covvrveenirarsimiainns 231

TEMPO coreeisnsssrsrerssnsnsmssnsmssmssnrsrarsres 157

Test commands, AREXX ....ooeveveveees 08
Test Cmd Button, AREXX ............. 13
Text area, U List....cciemssisienionss I 16

Third party SOUTCES ......corneriurssssaions 237
This track BUtton ......coveveerereniinsees 124

Time;
code;
71 [+ RPN RRREr, 89, 97, 151
TECAH o 218
field, AREXX ....oorvivnnesiionses 138
opHonSs Sissiiiadamitanamai 156
BIENBIIIE ... i cviidibisisaniianasesans 157
P EHEIIGE Lovsvernsrsiinrisnsrsnnerins asa 225
PESAMPE . iisnisrnsrenrarssssssnsisassssss 177
Tiny Mixer;
AAVANIAZES . ..vis it ristananmassiens 227
PEfErENCE \iviiiiinninsssisninsisnss SET
Toaster Handler..........ocoieioimmnisrssnnes 144
Track;
B s s 143
D e BT M R 147
CUL s s e e 146
QUPlICATE. (ocoierrimcss riemsure amms ey 146
oad i i 148
F1TERA] 11111 1) AR 34, 143
(151 =1 | 1 R e e St e i 142
o] 1|1 - A A 121
name Change ..o 96
on highlight......coniminiinannn, 155
OTEANITE cvveereverereresarerarssriseennes 147
DEEDE . nsavsscosi i v spengs 148
PR . cocisveaivisnir b 145
BRIV oo bcahans s s s iy 149
SE1ECt BULEOM v civanressmasss nnsans 128
select highlight.......ininninnns 155
Transport BUtONS ....oeeererei e ccenns 101
Trigger;
Cue LISt mimmimaiimm 100
O B AES s s 120
Troubleshooting ..., 59
Tutorial;
cartoon soundtrack ........ceeeeinnn 29
249
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I s A 162
all,editor ..o 171,172
Vevals cciminnisinaitiium 157

Ungroup:..
Units in samples .....ooooviviiiminimn |80
Units in SMPTE..........ccconmmsmeninrsnsans |80
Unlimited crossfade.......cccoooveeecinnne 109
Update;
1511 TR 216
EERNE sonsmrasnsissnsmissmmcesvinyssssirnernn 181
Use extended memory ... 64, 201
Use mixer levels; ............... 94, 163, 179
31101 ] o 7. | 56
L [T L A T e R ¥ o e g 12
Utility reference......ccoevmmreermssmirees 229
Vertical interval time code ............ 7,25
Vertical only drag;.....ccccvvvevereenn. 99, 107
O] e 41

VHS deck modification........cceveveees 238

Video effects generator.........ccoeoeeve. 238

Video TOaBter . ...ccommrrmsisesac oo 144, 238
D e e R A A 7,25
GO RV T . veosvasscibinannnnnsnsns 237
Volume;
[ L R—— | T |
TOHA]: i 45
INPUL S QUEPLE . cocoviiiiimsesisnssssass |89
T F { -t e R e R SN |89, 194
VS s e s 208
VU meter.....
WavelOrmy i aiimi ioiramis
WorkBench screen, Studio 16 on.... 221

XLER connectors. ..o nsianssassins 0

XLR-t0-RCA adapter ..........ccoviiiaiinas 6
L P 176
SMPTE,. ... ccosmsnsicinsiicsisnsmmnsipsn 210

ZIPPET NOISE i wisivirmrsiviessasmsasmnssansesisas
Zoom;

arrows, Cue List.....covvvneinninnes 130
buttons;
Cue LIS cosianncinaons 87
B, i i 170

7 e R e e o 87, 130
A o 1 [ R 5
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